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Preface

Expand your business communication capabilities with Internet mail on Lotus
Domino for AS/400. Now your mail users can contact and connect with an entire
world of people who are eager to communicate with them.

This IBM Redbook explains how to set up your Lotus Domino for AS/400 server to
exchange mail with other SMTP servers, including those within the Internet. It
explains a broad spectrum of Lotus Domino for AS/400 and SMTP mail topics,
such as POP3, IMAP, and MIME. It demonstrates several approaches for
registering both Notes and POP3 users, and takes you through the steps to
ensure consistent user settings through user setup profiles. Plus, it introduces the
new feature that now allows you to bind OS/400 to a specific IP address to
support both Domino SMTP and OS/400 SMTP at the same time.

You'll also learn about:

* Directory catalogs

* Directory assistance

e Using a User Auxiliary Storage Pool (ASP) to store Domino data
e Much more

This redbook targets Lotus Domino for AS/400 administrators who configure their
organization's servers for Internet mail. If you've been given the task to take your
Domino Mail to a new level, this is the book for you.

Note: This redbook reflects the IBM @server iSeries 400 server name.
Throughout this redbook, we use the shortened version “iSeries” to refer to both
AS/400e and iSeries 400 servers. Although all scenarios in this redbook were
conducted using the AS/400e Model 170 server, they should work the same way
on iSeries servers with the release of Domino used in this book (R5.0.4a).

The team that wrote this redbook

© Copyright IBM Corp. 2000

This redbook was produced by a team of specialists from around the world
working at the International Technical Support Organization Rochester Center.

Justine Middleton is a Senior AS/400 Specialist at the International Technical
Support Organization, Rochester Center. She writes extensively and teaches IBM
classes worldwide on Domino for AS/400 and Client Access/400. Before joining
the ITSO in 1998, Justine worked for IBM Australia as a Senior IT Specialist in
the Business Server team. Justine holds an MBA from the University of Western
Australia and is a Certified Lotus Professional R5 Domino System Administrator.

Jana Jamsek is an IT Specialist in the International Technical Support Center for
Central Europe, Middle East and Africa, located in Ljubljana, Slovenia. She has
22 years of experience in IBM S/390 and AS/400 technical sales support. She
holds a degree in mathematics from Ljubljana University and a masters degree in
Operational Research from Ljubljana University. Her areas of expertise include
teaching Domino for AS/400 classes and on-site support for complex customers
projects in Domino for AS/400. She has written about Domino for AS/400.

Some of the material for this redbook originated as a workshop entitled “You
Have New Mail, or Do You?”. To reach a broader audience with the material, we
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decided to produce this redbook and add some topics, such as binding to specific
IP addresses and directory catalogs. The production of the original workshop was
led by Justine Middleton and the residents were:

Boyd Gerber, IBM Rochester

David Lee, IBM Australia

Birgit Roehm, IBM Germany

Katina YK Chan, IBM China/Hong Kong

Thanks to the following people for their invaluable contributions to this project:

Robert Boutault
Susan Powers
International Technical Support Organization, Rochester Center

Edith Cinco
Terrence Forrest
George Romano
Steve Sparrow
IBM Rochester

Walter Scanlan
John Weiser
IBM/Lotus Domino for AS/400 Support, Rochester

George Weaver
PartnerWorld for Development, Rochester

Wilfried Blankertz
IBM Germany

Christine Fasth
IBM Sweden

Keith Attenborough
Matt Chant
Lotus Corporation

Comments welcome
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Your comments are important to us!
We want our Redbooks to be as helpful as possible. Please send us your
comments about this or other Redbooks in one of the following ways:

* Fax the evaluation form found in “IBM Redbooks review” on page 231 to the
fax number shown on the form.

¢ Use the online evaluation form found at ibm.com/redbooks

e Send your comments in an Internet note to0 redbookeus . ibm. com
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http://www.redbooks.ibm.com/
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Chapter 1. Introduction

—— Note

This redbook reflects the IBM @server iSeries 400 server name. Throughout
this redbook, we use the shortened version “iSeries” to refer to both AS/400e
and iSeries 400 servers. Although all scenarios in this redbook were conducted
using the AS/400e Model 170 server, they should work the same way on
iSeries servers with the release of Domino used in this book (R5.0.4a).

Lotus Domino for AS/400 Release 5 (R5) contains numerous new features and
enhancements to its predecessor, Domino R4.6. One of these is the R5 built-in
support for Simple Mail Transfer Protocol (SMTP) — the standard Internet e-mail
protocol. Unlike R4.6, R5 doesn’t require a Mail Transfer Agent (MTA) to convert
Domino mail to an Internet (SMTP) mail format. R5 performs any required
conversion automatically. It also supports Multipurpose Internet Mail Extension
(MIME) attachments, which let you include such files as graphics, audio, and
video in e-mail messages.

Because of these new features, setting up R5 for SMTP e-mail can sometimes be
mystifying. Even if you’ve already configured the iSeries server to run Domino
and clients for Internet e-mail, you might want to modify configuration settings, or
at least, understand why you enter certain values in certain fields. This redbook
provides tips that clear up confusing parts of the Domino SMTP mail setup
process. Much of this information is generic and can apply to Domino on other
platforms. It focuses on some areas that are the source of most confusion.

Note: Our recommendations and explanations apply to OS/400 V4R4 and Lotus
Domino for AS/400 R5.0.4a. Subsequent code changes may alter the way
messages are handled. We strongly recommend that you use OS/400 V4R4 or a
later release, especially if you are using AnyMail Integration.

This redbook also provides an overview of other Domino server topics. If you
decide that you want to learn more about them, you can obtain more information
from the standard Lotus documentation. Think of this redbook as a sampling
menu to help you appreciate options and services that the Lotus and IBM “chefs”
provide with your Domino for AS/400 server.

1.1 Options for configuring your server for SMTP mail

© Copyright IBM Corp. 2000

Domino for AS/400 R5 gives you two options for configuring your server for
SMTP mail. You can use AnyMail Integration (that is, Mail Server Framework),
which uses OS/400 SMTP services. Alternatively, you can use Domino’s built-in
SMTP support. Even if you use the Domino SMTP, Domino’s Internet mail
requires iSeries TCP/IP services, such as host name resolution (that is,
translating a host name to an IP address).

You may need AnyMail Integration if you have to integrate Domino mail with

OfficeVision/400, if you have applications using the QtimmSendMail API, or if your
iSeries server has Post Office Protocol Version 3 (POP3) users. Domino can also
be a POPS3 server, so you can move those users to the Domino server. Although



both implementations support basic SMTP mail exchange, only Domino’s SMTP
supports certain advanced SMTP configuration services, such as the ability to
control transmission of e-mail messages by destination domain, and inbound and
outbound message-size controls. Also, AnyMail Integration doesn’t currently
provide extended SMTP support (a standard defined in Request for Comments
(RFC) 1869). You can see information about these differences in the Release
Notes (READAS4.NSF).

If you don’t really need AnyMail Integration, we suggest you move to Domino
SMTP. You’'ll have more options for e-mail setup, and problem resolution may be
simpler. If you want to move away from using AnyMail Integration, but have
OfficeVision applications that need migrating to Domino, refer to How to Replace
OfficeVision/400 in Your Applications: Looking at Domino for AS/400 and AS/400
Alternatives, SG24-5406.

New PTFs for dual support of Domino, 0S/400 SMTP

Recently, Program Temporary Fixes (PTFs) were made available that allow you to
support both Domino and OS/400 SMTP on one iSeries server. Detailed
information about this ability to bind OS/400 SMTP to a specific IP address can
be found in Chapter 5, “One iSeries server and two SMTPs” on page 35.

Before you start, make sure that you have any iSeries PTFs that are required. To
see the current recommendations, go to:
http://www.as400.ibm.com/domino/support

You may not realize it, but since late last year, Domino Quarterly Maintenance
Updates (QMUs) are included in iSeries cumulative PTF tapes. QMUs provide
fixes rather than functional enhancements to Domino servers. Lotus also may
issue hot fixes that are particular fixes provided to individual customers to solve
specific problems.

Note

We use the terms AnyMail Integration, *MSF, MSF, MSF/400, Mail Server
Framework to refer to the implementation of Lotus Domino for AS/400, which
relies on OS/400 for SMTP services.

1.2 Notes client

There are three different types of Lotus Notes clients that can be installed on a
workstation:

¢ Notes client: For end users
* Domino Designer client: For developers
e Domino Administrator client: For the Domino administrator

When you install either the Designer or the Administrator client, you also
automatically install the Notes client. You even have the choice to install all three.

Figure 1 may help you identify the parts of the Notes client. You can obtain more
information from the help function within Notes. Go to the Getting Started section.

2 Lotus Domino for AS/400 Internet Mail and More
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Figure 1. Notes client

1.3 Operations Navigator

Operations Navigator provides graphical access to many iSeries functions.
Although it is installed as part of Client Access Express (5769-XE1), you only
need a license to use the 5250 emulation or data transfer. The program that the
license is associated with is the Client Access Windows family (5769-XW1). For
more information about licensing, installing, and using Client Access Express
(including an overview of Operations Navigator), see AS/400 Client Access
Express for Windows: Implementing V4R4MO0, SG24-5191. For information
specifically about Operations Navigator, refer to Managing AS/400 V4R4 with
Operations Navigator, SG24-5646.

Operations Navigator can be used for alternative graphical access to the green
screens we use in 2.2, “TCP/IP” on page 12.
To configure TCP/IP from Operations Navigator, follow these steps:

1. Open Operations Navigator and select the iSeries server with which you are
working. Select Network->Protocols. Then right-click TCP/IP. The display
shown in Figure 2 on page 4 appears.

Chapter 1. Introduction 3



3 AS /7400 Dperations Mavigator
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+-u2 File Spstems

]-- Backup

]@ Application Development

Figure 2. TCP/IP menu options

2. From the pop-up menu that appears, you can choose one of these options:
» Select Interfaces to allow you to work with TCP/IP interfaces.

* Select Utilities to give you access to the PING command from an iSeries
server.

» Select Properties to see the multi-tabbed display shown in Figure 3.

In this example, we chose Properties. The resulting display is shown in Figure
3.

TCP/IP Properties - As26 EHE

Hast Domain Information | Host Tablel Settingsl Port Hestrictionsl Servers to Startl SOCKS I

Host name: Ias28
Dromain name: Iitsoroch.ibm.com
TCRAP status: Started

Up ta three domain name servers:

10123 Add

Search order:
€ Search host table first

& Search name server first

Advanced |

QK Cancel Help

Figure 3. TCP/IP Properties

The TCP/IP Properties display shown in Figure 3 is equivalent to selecting
option 12 from the CFGTCP menu. From the display shown here, you have
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access to the iSeries Host table (option 10 of CFGTCP) and several other

displays.

Operations Navigator also supports plug-ins. Plug-ins extend the capability of the

base Operations Navigator product. A plug-in is available for Lotus Domino for

AS/400. This plug-in allows you to start, stop, define, change properties
(equivalent to using the Change Domino Server (CHGDOMSVR) command), and
edit the NOTES.INI file from Operations Navigator. Figure 4 shows a sample

display.

3 AS 7400 Dperations Mavigator

File Edit “iew Options Help
%] ple] =] 2lge Orites i
| Environment: My A5 /400 Connections | As26: Doming
EI} Management Central [4:26) 1| Server Name | Statuzs |
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! As23 az2Bfaxdom/ABC Stopped
! Ased custzery foust] Stopped
E-H isgg custzerv2oust? Stopped
E! %; B asic Onerati Lstzery3/oust Stopped
asie Lperations custzervd/oustd Stopped
E5 Job Management =
. N . custzervyB/ousth Stopped
gﬁ Configuration and Service — _
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E-b g Network =
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) IP' Security =
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*HTTPSETUR | Start
Client Access fullzerver/acme Stop
Draming dommailedorge Stop Immediately
@ HuickPlsce domrails/orgs Server Adminiztration
B Intemet |
----- IBM Metwork Stations Add Application
-8 Security
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- Database =l Properties
[1-17 of 17 object(z] [ i

Figure 4. Domino plug-in

For information on installing and using the plug-in, refer to Lotus Domino for
AS/400 R5: Implementation, SG24-5592.

1.4 Domino Administrator

Throughout this redbook, we implement SMTP mail solutions by editing Domino
documents. To do this, you can either use the Notes client and open the Domino
Directory (NAMES.NSF) directly, or you can use the Domino Administrator. Some
options may not be available to you if you open the Domino Directory from your

Notes client. The Domino Administrator is the official tool for editing the Domino
Directory.

Note

Rather than repeat in each section how to access the documents, we show you
how in this section. Refer back to this section later if you need assistance.

When you install your Notes client code on your administration workstation, you
need to explicitly install the Domino Administrator client or install all clients. Once
you have done this, access Domino Administrator by clicking the icon from your

Chapter 1. Introduction 5



Notes client as shown in Figure 5. Note that, if you selected Domino
Administrator rather than All Clients, when you installed your Notes client, you will
not see the Domino Designer icon under the Domino Administrator icon (shown in
Figure 5). You do not need Domino Designer for any steps in this redbook.

™ Welcome - Lotus Notes =] 3
File Edit Wiew Create Actions Test Help @ 9 \@ Q C‘)\ G

) Welcome Wirkspace notes
LR

8 .-pofes [ =]

F Mail
| [ '\ﬂ Mew Mema

= Mew to Motes?
Take the tour.

)
Dramino &dministrator
@ . Calendar
g ] Mew Entry Experienced?
lew Entry £
See what's new in R5.
‘_f')_] X \ Address Book Meed a teamn space or instant meetings?
Q_] 7% Bl N Try Lotus Quickplace or Sametime.
i 2 ] Mew Contact
f] ~ Want to change this page?
ﬁ-] . {v Show mail. calendars. AOL or Lycos news...
To Do List
It
*f] NewTolDo

g Mewfo Seal‘ch INotes Database Catalog j far Search |

Figure 5. Starting Domino Administrator

You can also start the Domino Administrator directly from an icon that you set up
to run admin.exe, or from the Start menu. If you do not know your way around the
Domino Administrator, click the tutorial option on the Welcome page of the
Domino Administrator, and follow the tutorial. Figure 6 shows you the main
Domino Administrator display with the different parts labelled. You see the server
pane when you click the Domain icon as shown in Figure 6.

6 Lotus Domino for AS/400 Internet Mail and More



E3 Administration - Domino Administrator

g Administration
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23 Deny Access Groups Bright , Peter
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Henderson , Harry
Results
IMAP |, User Pane

i i
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Smith , Jehn
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test . Internst
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Figure 6. Domino Administrator

1.4.1 Server, Configuration, and Domain documents
Figure 7 on page 8 shows you the Configuration tab of the Domino Administrator.
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Fg‘ Administration - Domino Administrator
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Figure 7. Domino Administrator - Configuration tab

Organizational Unit...
Organization...

Internet Certifier...

The main Domino Directory documents that we use in this redbook are the
Server, Configuration, and Domain documents.

You can access these documents by selecting the Configuration tab. If you select
All Server Documents and then select the particular Server document you want to
access, Domino Administrator displays more information on the screen at once

than if you directly select the Current Server Document.

Configuration documents can be accessed from either the Server twistie or the

Messaging twistie. Domain documents can be accessed from the Messaging
twistie.

Note: A twistie is the little triangle that expands to show additional options.

1.4.2 Person and Group documents

8

You can access Person and Group documents by selecting the People & Groups
tab as shown in Figure 8.
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Fg‘ Administration - Domino Administrator
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|:: % Groups
Smith, Ann
Smith , John
Smith , Tom

Figure 8. Domino Administrator - People & Groups tab

1.5 Backup and recovery

We take this opportunity to highlight the existence of online backup for Domino.
Domino for AS/400 Release 5.0.2a supports true online backup capability with
Backup, Recovery, and Media Services for AS/400 (BRMS/400, 5769-BR1).
Online backup means that Domino server databases on the iSeries can be saved
while they are in use, with no save while active synchronization points. This is
true online backup support. This function is supported in BRMS/400 V4R4 and
later releases. You can direct your online backups to a tape device, an automated
tape library device, save files, or a Tivoli Storage Manager server.

It is critical that you do not try to replace your complete system backup with only
online Lotus Domino server backups. The online Lotus Domino server backups
only back up databases. There is other important Lotus Domino server data,
including libraries and non-Domino server system data, that should be backed up
on a regular basis, for example QUSRSYS, QGPL, and so on.

For more information about backup considerations for Domino, see Lotus Domino
for AS/400 R5: Implementation, SG24-5592. This book was written before the
online capabilities became available. However, it contains alternative backup
methods and information about backing up non-Domino database files. You can
also refer to 0OS/400 Backup and Recovery, SC41-5304, for general OS/400
backup considerations. For more information about BRMS, see Backup,
Recovery, and Media Services for AS/400, SC41-5345. For information
specifically about Domino support in BRMS, see:
http://www.as400.1ibm.com/service/brms/domino.htm

Chapter 1. Introduction 9
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Chapter 2. Preparation

Before you configure your Domino for AS/400 server, you have to do some
planning and preparation. Throughout this book, we use IP addresses similar to
a.b.c.d or 10.6.n.n to represent our routable |IP addresses even though a “10”
address cannot really be routed. Make sure you use the appropriate addresses
for your installation.

2.1 Domino for AS/400

© Copyright IBM Corp. 2000

First, check whether the required software is installed. To do so, complete the
following steps:

1. Sign on to an iSeries 5250 session.

2. Type the Display Software Resources (pspsrwrsc) command on a command
line, and press Enter.

3. Page down to the Resource ID of 5769LNT, and verify that the prerequisite
components are installed. You see a display similar to the example in Figure 9.
Note that only *BASE and option 1 have a language feature which, in this
case, is 2924.

4 Display Software Resources B
System: AS26
Resource
D Option Feature Description
5769JS1 *BASE 2924 Jdb Scheduler for AS/400
5769JV1 *BASE 5050 AS/400 Developer Kit for Java
5769JV1 *BASE 2924 AS/400 Developer Kit for Java
5769LNT *BASE 5050 Lotus Domino For AS/400
5769LNT *BASE 2924 Lotus Domino For AS/400
5769LNT 1 5050 AS/400 Integration
5769LNT 1 2924 AS/400 Integration
5769LNT 3 5050 C API
5769LNT 4 5050 C++ API
5769INT 5 5050 LotusScript Extension ToolKit
5769LNT 6 5050 HiTest C API
5769ILNT 7 5050 Advanced Services
5769MG1  *BASE 5050 Managed System Services for AS/400
5769MG1  *BASE 2924 Managed System Services for AS/400
More. ..
Press Enter to continue.
F3=Exit Fll=Display libraries/releases Fl2=Cancel
F19=Display trademarks
k J

Figure 9. Display Software Resources

4. Press F11 (Display libraries/releases) to see the Domino release installed on
the iSeries server.

5. Press F3 to exit from this display.

Starting with V4R4 and later releases, you also see Domino displayed when you

view licensed program products from the GO LICPGM menu. For information

about installing or upgrading Lotus Domino for AS/400 code, see Lotus Domino
for AS/400 R5: Implementation, SG24-5592.
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2.2 TCP/IP

You need to define and activate a TCP/IP interface for the Domino server’s IP
address. If you define only one Domino server and use the IP address of the
iSeries server for it, you may have already done this. Otherwise, select option 1
from the CFGTCP menu, or use the Add TCP/IP Interface (ADDTCPIFC)
command. Remember to enable the interface with option 9 (Start) as shown in
Figure 10.

4 ] N\
Work with TCP/IP Interfaces

System: AS26
Type options, press Enter.
1=Add 2=Change 4=Remove b5=Digplay 9=Start 10=End

Internet Subnet Line Line
Opt Address Mask Description Type
. a.b.c.d 255.255.255.128 TRNLINE *TRLAN
. a.b.g.h 255.255.255.128 TRNLINE *TRLAN
__ abg.j 255.255.255.128 TRNLINE *TRLAN
o 10.70.21.1 255.255.0.0 TRNLINE *TRLAN
o 10.70.21.2 255.255.0.0 TRNLINE *TRLAN
. 127.0.0.1 255.0.0.0 *LOOPBACK *NONE
. 192.168.3.1 255.255.255.0 NTSVR100 *TRLAN

Bottom
F3=Exit F5=Refresh F6=Print list Fll=Display interface status
g Fl2=Cancel F17=Top F18=Bottom )

Figure 10. Work with TCP/IP Interfaces

2.3 Domain names

When you configure a Domino server for e-mail support, one of the parameters
you specify is the domain name. The R5 Domino Directory was called the Public
Address Book (PAB) or Name and Address Book (NAB) in R4.6 and earlier
versions. Users in the same Domino domain are registered in the same Domino
Directory. When you send traditional Notes mail, your address appears in the
format John Doe/Acme @ Acme. Note that the organization name (the first Acme)
doesn’t have to be the same as the domain name (the second Acme). Often
companies define them as the same. For Internet mail, you also need an SMTP
domain. Your Internet address is in the format jdoe @ ourcompany.com, where
ourcompany.com is your company’s registered SMTP domain name.

You can use the Domino domain name as the basis for your SMTP domain name,
but the two names are unrelated. For example, in the example with acme as the
Domino domain, we could have registered acme.com as our SMTP domain
name.

Defining the SMTP domain is discussed in more detail in Chapter 3, “Configuring
Domino for SMTP” on page 15.
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2.4 Domain Name Service

Sending and receiving Internet e-mail requires a Domain Name System (DNS)
server or host tables to resolve host names (domain names) into IP addresses.
Using a DNS server (or servers) is preferable to setting up host tables on each
server and PC in your network.

You can use the iSeries server as your DNS server. To specify one or more DNS
servers, enter the Configure TCP/IP (creTcp) command, and select option 12, as
shown in Figure 11. You can specify up to three DNS servers. However, if the first
listed one is accessible, it will be the only one of the three that is used, unless the
first server is explicitly set up to forward to one of the other two.

4 N
Change TCP/IP Domain (CHGTCPDMN)
Type choices, press Enter.
Host name . . . . . . . . . . . 'as26'
Domain name . . . . . . . . . . 'itsoroch.ibm.com'
Host name search priority . . . *REMOTE *REMOTE, *LOCAL, *SAME
Domain name server:
Intermet address . . . . . . . 'a.b.c.d'
Bottom
F3=Exit F4=Prompt F5=Refresh Fl0=Additional parameters Fl2=Cancel
F13=How to use this display F24=More keys
- J

Figure 11. DNS servers

Assuming that you’ve defined your hosts in only one place (on the DNS server or
in the host table) or with consistent addresses, it doesn’t matter whether you
specify *LOCAL (meaning host table) or “TREMOTE (meaning DNS) for the search
order. We recommend that you use *REMOTE if you have a DNS server.

In your DNS, you must also set up primary domains for your SMTP domain, host
(A) records for each Domino server, and possibly a Mail Exchanger (MX) record
for your mail server. This may be your Domino server, another server in your
organization, or your firewall. Appendix A, “Setting up a DNS” on page 209,
shows how we set up the DNS for one of our examples.

You can read more about setting up your iSeries server as a DNS server in
AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support, SG24-5147. You
can also refer to the iSeries 400 Information Center (look under TCP/IP) at:
http://www.iseries.ibm.com/infocenter

Chapter 2. Preparaton 13



2.41
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iSeries host table

If you’re configuring multiple Domino servers in one Domino domain on an iSeries
server, and your Domino server TCP/IP domain name differs from your iSeries
domain name, you must enter the short name (that is, the Domino server name
without the domain name) of your servers in the iSeries host table. You do this so
that, when you configure an additional server, the iSeries server can find the first
server and obtain from it a copy of the Domino Directory (NAMES.NSF). Then,
Domino can replicate between the servers.

For example, in our case, our AS/400e server TCP/IP name is
AS26.ITSOROCH.IBM.COM and our Domino server TCP/IP name is
dommail1.janal.com (with a Domino domain of abc1). If we want to configure an
additional Domino server on AS26 with the same Domino domain as dommaili,
we need to ensure that dommail1 and its IP address is added to the host table.
This is because the AS/400e server will append its own TCP/IP domain of
ITSOROCH.IBM.COM to the name dommail1 when configuring the additional
server. It will look for the Domino server dommaili.itsoroch.ibm.com to obtain the
NAMES.NSF file, but this server does not exist. If the Domino server's TCP/IP
name is dommaili.itsoroch.ibm.com, this step is not necessary.

To ensure delivery of inbound mail, if you are using the AnyMail Integration
configuration, you need to place the SMTP domain name in the host table to
ensure incoming mail is identified as local mail. If you are using Domino SMTP
and use a DNS server, you don’t have to enter the SMTP domain name (for
example, ourcompany.com) in the iSeries host table. The DNS server will resolve
it and deliver the mail to the Domino server. The Domino server will recognize
that the mail is for itself. We discuss how this is done in 4.3, “Global Domain
document” on page 24.
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Chapter 3. Configuring Domino for SMTP

© Copyright IBM Corp. 2000

If you are using the Configure Domino Server (CFGDOMSVR) command to
configure your server, select the type of SMTP mail you require on the second
page of the command screen. To select Domino SMTP, select *SMTP for the
Internet mail package and *DOMINO for SMTP services as shown in Figure 12.

4 N
Configure Domino Server (CFGDOMSVR)

Type choices, press Enter.

Administrator:

Last name Doe

First name . . . . John

Middle initial . . Character value

Password . . . . . . . .

Minimum password length . . . 8 0-31

Internet password *NONE
Time zone e e e . CST GMT, EST,CST,MST, PST,CET ...
Daylight savings time . . *YES *YES, *NO
Web browsers . . . *NONE Name, *NONE, *ALL, *HITP...
Internet mail packages . . . . . *SMTP *NONE, *ALL, *IMAP, *POP3 ...

+ for more values
SMTP services *DOMINO *DOMINO, *MSF
More. ..
F3=Exit F4=Prompt F5=Refresh Fl0=Additional parameters Fl2=Cancel
F13=How to use this display F24=More keys
N J

Figure 12. Configuring Domino SMTP

To select AnyMail Integration, select *SMTP for the Internet mail package and
*MSF for the SMTP services.

SMTP is automatically configured in the last step of configuring the Domino
server. When using the CFGDOMSVR command, you are first prompted to “Press
ENTER to end terminal session”. Then you see a “Configuring SMTP...” message.

If you are configuring with a Web interface, select Internet Mail Packages and
SMTP Services on the Server Audience page as shown in Figure 13 on page 16.
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Figure 13. Web configuration

If you configured your server without SMTP, you can go back later and include it
by using the Change Domino Server (CHGDOMSVR) command. Or you can use
the Lotus Domino plug-in for Operations Navigator, which lets you manage
Domino servers from a graphical interface (Operations Navigator). See the
redbook Lotus Domino for AS/400 R5: Implementation, SG24-5592, for more
information about obtaining and configuring the plug-in.

If you migrated to Domino R5 but are still using AnyMail Integration, or if you
configured for AnyMail Integration and now want to change to Domino SMTP, you
can also use the CHGDOMSVR command. In either case, select *SMTP for the
Internet mail package and *DOMINO as the SMTP service as before. Stop and
restart your Domino server for this change to take effect.

As a result of configuring SMTP, documents are created in the Domino Directory.
You may be able to use the documents as they are after the configuration, or you
may need to tailor them. Each of the document types is discussed in Chapter 4,

“Directory documents for SMTP” on page 21.

3.1 SMTP mail delivery and the Domino console

Particularly in a test environment, it can be useful to use the Domino console to
check whether mail is being sent and received by the Domino servers instead of
having to switch user IDs back and forth. You can do this in a number of ways,
such as using the Domino Administrator to access the console or using the Work
with Domino Servers (WRKDOMSVR) command from an OS/400 command line.
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The following sections show examples of the information you see in the console
for Domino SMTP and AnyMail Integration.

3.1.1 Domino SMTP
For outbound Domino SMTP mail, you see:

09/02/2000 08:07:13 AM Router: Transferring mail to domain ITSOROCH.IBM.COM
(host as26.itsoroch.ibm.com [10.6.9.47]) via SMIP

09/02/2000 08:07:14 AM Router: Transferred 1 messages to ITSOROCH.IBM.COM
(host as26.itsoroch.ibm.com) via SMTP

09/02/2000 08:07:18 AM Router: Message 0048105E transferred to
as26.itsoroch.ibm.com for user4@itsoroch.ibm.com via SMTP

For inbound Domino SMTP mail, you see:

09/02/2000 08:06:42 AM SMTP Server: 10.6.9.47 connected

09/02/2000 08:06:42 AM SMIP Server: Message D3042920 received
09/02/2000 08:06:42 AM SMTP Server: 10.6.9.47 disconnected. 1 message[s]
received

09/02/2000 08:06:43 AM Router: Message 00480693 delivered to user3/abc3

3.1.2 AnyMail Integration
A Domino server configured for AnyMail Integration does not show anything in
the console for outbound SMTP mail. AnyMail picks up the mail and manages it.
Inbound SMTP mail appears in the console as shown here:
09/02/2000 08:07:18 AM Router: Message 00481471 delivered to user4/abc4

You don’t see SMTP Server messages as you do in the Domino SMTP situation
because OS/400 SMTP is handling the mail.

3.2 Tips for monitoring mail

Chapter 9, “Troubleshooting e-mail delivery” on page 97, goes into great detail on
troubleshooting tools and techniques. This section gives you several quick ideas
of what to look at when monitoring mail:

* First you should look in the Domino console as discussed in the previous
section. You will see an indication here of possible problems with the DNS or
contact with the SMTP servers.

* Inbound and outbound mail goes into a database called MAIL.BOX. If you are
using Domino SMTP and the mail is sitting in MAIL.BOX, it is often an
indication of incorrect DNS resolution or a failure to connect with an SMTP
server.

e Sometimes mail is not delivered for some unknown reason. It seems to be
held up behind other failing mail. Stopping and restarting the router with the
tell router quit and tell router start Domino commands often helps. It is
possible that, if you wait a bit longer, the router may reach an automatic retry
period.

* Don’t forget that in addition to your Domino server having a log file
(LOG.NSF), you also have one on your client. It is also called LOG.NSF and
can be a useful source of information.

Chapter 3. Configuring Domino for SMTP 17



18

If you are working with multiple servers, the following steps may be useful:

1. From the Administration pull-down menu, select Add server to favorites as
shown in Figure 14.

2 A

File Edit “iew Create Actions SEflnit

Fg‘ Administration - Domino Adminiztrator

Ll Feople  Help File Edt Wiew Create Actions Admi
[a] : .
CGEA B D O v Eoometbows CEA D SO
B Admiristration | 22K Welcom éewe[ » £ Admiristration | 22k Welcome to D

-

@ Peaple & Groups I Files I Serve  Messaging figuration @ @IGTUUDS I Files I Server I e

Replication o
LCanfiguration @ Server: dommaili/abe

Fiefrezh Server List 3

v Q@ Domino Directories
v Q@ abc1's Address Book

v Q@ Domino Directories
v Q@ abc1's Address Book

& &

ﬁ% Groups Admini ﬁ% Groups

< Mailin Databases & Res < Mailin Databases & Res
Setup Profiles Assist . Dir -

[z] Certificates

b 2= T

Figure 14. Add Server to Favorites

2. Enter the server name that you are adding to your favorites. The server that
was being accessed when you set up your client will already be in the
drop-down list.

3. You can now switch between servers. If your required server is not the current
server (that is, if you don’t see it next to the word Server as circled in Figure
14), click the Favorites icon (the top one in the bookmarks). Then select the
server.

Some Domino Administrator options with which you may not be familiar are
presented in the following list:
1. Click the Messaging tab. Look at the Mail Routing Status graphs as shown in

Figure 15. This provides a visual representation of dead mail. The options you
see on the left-hand side will vary depending upon your configuration.

Fg‘ Administration - Domino Administrator

File  Edit Administration Mail Help

CEA B OO KR

g Adminiztration 4 ‘Welcome bo Doming Administrator RS

@ People & Groups I Filez I Server I Messaging I Fieplication I Configuration

M ail ITracking Center l
Server: dommaili/abe

ﬁ% Mail Uszers . o
v 9 Fiouting Mailboxes 50 Ivlail Domain is 4BC1 50
@ dommaill Mailbax [mail box 40 ) 60 40 , [31]
& dommaill Mailbas (mail2. box Ay S gy,
@ Shared Mal 30 \\\\\ f"////l 70 30 \\\\\ f"////l 70
)| Mail Routing Statug :3‘ /// :3‘ ///
Mail Routing Events 20 = —. 80 20.= —. 80
# 4% Mai Routing Topology = = = =
$% By Connections 10 ‘:/: S a0 10 E :“E: a0
w25 By Mamed Metworks //// \\C\:: //// \\:,?
o WAIL Dead 100 o MIAIL Waiting 100
Last updated: Fri Sep 15 12:20:22 CDT 2000 {dormaill fabel )

Figure 15. Mail Routing Status
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Select the mail routing events view, and open the last entry. This shows
information about recent mail that you sent and received. This is a subset of
the Domino log. Press Esc to leave this display.

Click the Server tab. It may take a little while to retrieve the tasks.

Click the Console Icon and then Live. You see a display like the example in
Figure 16. You can enter commands in the field at the bottom and press Enter.
Click Stop when you finish with the live console to reduce the load on the
system.

rsi Adminiztration - Domino Administrator

File

Edit  Administration

Server

Help

CEA DD SO R

3

5& Adminiztration

24 Welcome o Doming Administrator RS

administrato
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Statuz IAnaIysis IMonitoring IStatistics l

{@ﬁ Server: dommail{/abe
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Stop Tasks

>
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Jaiting Tasks:

ransactional Logging:
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Server
Server
Server
Server
Server
Server
Server
Server

Server
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Datab.
Datab.
Datahase
Datahase
Datab.
Datab.
Datab.
Datab.
Datab.
Datahase
Datahase
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Databhase Server
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SMIP Server

SMIP Server

IMAP Server

IMAP Server

Event Monitor
Calendar Connector
Schedule Manager
Agent Manager
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[]
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Load Monitor is idle

Database Directory Manager Cache Refresher
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Perform Database Cache maintenance
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Idle task

Idle task

Idle task

Idle task
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Idle task

Recovery Manager Checkpoint Thread
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Server for Adminlrsabcl on TCPIP

Idle
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Control task
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Control task
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Figure 16. Remote console

5. Click Tasks to close the console display.
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Chapter 4. Directory documents for SMTP

This chapter looks at the documents that are changed by the configuration of
SMTP. It concentrates on changes made for Domino SMTP. The end of this
chapter covers additional information about AnyMail Integration.

There are three documents in the Domino Directory that are particularly important
for SMTP mail: Server, Configuration, and Domain documents. All three
documents are found under the Configuration tab. The Domain document is
located under the Messaging subtab.

4.1

Server document

Once you configure your server for SMTP, look at the Server document (Figure
17). The automatic configuration process has placed the iSeries host and domain
names, AS26 and ITSOROCH.IBM.COM (from CFGTCP option 12), into the Fully
qualified Internet host name field. If you haven’t configured Domino for SMTP, this
field may be empty.

Fg‘ Server: dommaill /abc1 - Domino Administrator

File

&

g Adminiztration 4 ‘Welcome to Doming Administrator RS | _] Server dommaill /abcl ﬂ administrator

Edit Miew Create Actions Text Help + » 1% G

'FE! Save and Close 9 Web...

SERVER: dommaili/abct P ‘,
£

Basics l Security l Ports l Server Tasks l Internet Protocals l MTés l Mizcellaneous | Transactional Logging l Adminiztration r:

Server name: T dommail1/abe 1 Server build number: Release 5.0.4
Server title: ) Administrators: T Adminlfabcl 4=
Comain name: Tabcl Routing tasks: ™ Mail Routing, SMTP Mail Routing =1
Fully qualified Internet host © AS26.TSOROCH.IBM.COM SMTP listener task: T Enabled ;=]
name:

Cluster name: Server's phone number(s): © 4

Directory Assistance ™a CPU count: 1

database name:

Directory Catalog database ™ Operating system: IBM OS/400

name on this server:

Optimize HTTP " Advanced (Custom Settings) ;=] Is this a Sametime server?: * No | =|
performance based on the

following primary activity:

Server Location Information
Prefix for outside line: g Callingcard access g
number:
International prefix: ) Calling card number: )
Country code at this ™ g Dialing Rulss |
lecation:
Long distance prefix: ™1 5
Area code at this location: © Network Dialup idle T minutes
timeoLt: _I
The name of the Directory Assistance database on this server. It should be relative to the data directory.
| | | el - | e ]

Figure 17. Server document

Remember that a Domino server name does not need to be the same as the
iSeries server name, nor does it need to use the iSeries IP address. You can
define a separate IP address for your Domino server; your server and mail will
work just fine.
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You may be thinking: if | set up partitioned servers, won’t they all have the same
value in the Fully qualified Internet host name field? The answer is “yes”, but this
doesn’t matter. The mail will be delivered. An iSeries communications trace may
show the iSeries server name being used rather than the Domino server name.
However, the DNS service will find the correct IP address for the Domino server
based on the SMTP domain and will initiate SMTP communications based on that
address. Section 9.3.6, “Communications trace of a line” on page 132, shows you
how to run an iSeries communications trace.

When you configure Domino for SMTP mail, SMTP Mail Routing is automatically
added to the list of routing tasks in the Server document. When you configure
SMTP, Domino also automatically changes some Server document fields to
reflect the type of SMTP mail you’re using. In particular, Domino enables the
SMTP listener task when you use Domino SMTP mail and disables it when you
use AnyMail Integration.

Note

The NOTES.INI file has an entry of SMTP_VERSION=0 for Domino SMTP and
SMTP_VERSION=1 for AnyMail Integration.

When the Domino server starts, the router task starts. If the SMTP listener task is
enabled, the SMTP task will also automatically start.

4.2 Configuration document

22

The Configuration document also includes some SMTP mail-configuration
properties, which you can modify via the document’s Router/SMTP subtab
(Figure 18).
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Fg‘ Configuration for DOMMAIL1/ABC1 - Domino Administrator

File

P

Edit  “iew Create Actions Text Help \# y‘ \w); Q \')\ @
g Administration ﬂ ‘welcome to Domino Administrator RS | _] Configuration for DOMMAILT ABCT ﬂ administrator
'FE! Save and Close

CONFIGURATION SETTINGS: DQM_!}M!’L

Basics | Router/SMTP | MIME | NOTES.INI Setiings | Admiristiation |

Basics l Restrictions and Controls l Meszage Tracking l Advanced l

1 yiop ool
ao1OTe

Number of mailboxes: ar

SMTP used when sending T Enabled ;=]
messages outside of the local

internet domain:

SMTP allowed withinthe local " Disabled ;=]
internet domain:

Servers withinthe local Notes " Always /=

domain are reachable via SMTP
over TCPIP:

Address lookup:

T Fullname then Local Part =]

Exhaustive lookup:

T Disabled =]

Relay host for messages leaving
the local internet domain:

T

Lecal Internet domain smart host:

"

Smart host is used for all local
internet domain recipients:

T Disabled =]

Host name lookup:

" Dynamic then local 4 =]

|

=2 dommail %"

Figure 18. Configuration document

One property that needs more explanation is the Relay host for messages leaving
the local Internet domain field. When you address a mail item to
jsmith@yourcompany.com, and you’ve configured the Server document as
previously described, Domino identifies the mail as SMTP mail because the
domain to the right of the at (@) sign has a period. Therefore, it isn’t a recognized
Notes domain. Once Domino determines that the mail isn’t for the local Internet
domain, it checks the Configuration document under the Router/SMTP subtab for
an entry in the Relay host... field. The value in this field should be the name of
the host where your SMTP relay (for example, server or service that relays SMTP
mail) is running and may be your firewall or Internet Service Provider (ISP).

Note

In an internal testing environment, your local DNS should take care of name
resolution.

Also under the Router/SMTP subtab, you should leave the value of Host name
lookup as “Dynamic then local”. The iSeries server will take care of your DNS
requirements.

Click the Ports tab. Then click the Internet Ports tab, and then the Mail tab.
Refer to Figure 19 on page 24.
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Fg‘ Server: dommaill /abc1 - Domino Administrator

File Edit Wiew Create Actions Test Help \# 5} “;5 “1‘3\
CEABDeg @B 7 Pzt R CAER
5 Admiristration 22k Welcome to Domino Admiristrator RS | _J5erver: dommailt /abc ﬂ administrato

@ FgSaveandCIose @Web...
SERVER: dommaili/abet

B i
Basics l Security l Ports l Server Tasks l Internet Protocals l MTés l Miscellaneous | Transactional Logging l Adminiztration r:

Motes Metwork Ports l Internet Ports l Prosies l

SSL key file name: " keyfile kyr
SSL protocol version (for  * Negotiated =]
use with all protocols

except HTTP):

Accept SSL site C Yes ® No
certificates:

Accept expired S5L ® Yes U No
certificates:

web | Diectory | News | mail | 110F |

TCPP port number: NEER 110, ™25 25,
TCPP port status: T Enabled ;=] T Enabled ;=] T Enabled ;=] T Enabled ;=]
Authentic ation options:
MName & password: Yes Yes T No =] MNA
Anony mous: NA NA TYes qx] NA
SSL port number: Tee3 Toe5 TAB5 TAB5
SSL port status: T Disabled =] T Disabled =] T Disabled =] T Disabled =]
Authentic ation options:
Client certificate: T No =] T No =] NA NA
Name & password: TYes qx] TYes qx] T No =] NA
Anonymous: NA NA TYes qx] NA

Figure 19. Internet Ports and Mail tabs

You can see the port assignments being used for the different mail options. Also
notice that there are two SMTP ports: inbound and outbound. What does this do
for you? The answer is, quite a bit. In 6.8, “Advanced configuration options” on
page 66, you will see examples of using SMTP filtering rules to selectively allow
or disallow inbound and outbound mail. You can also prevent unauthorized users
from using your SMTP server as a springboard for spamming. You certainly don’t
want your SMTP server to be an open SMTP mail relay that anyone can use.

If you change your Domino SMTP configuration selection using the
CHGDOMSVR command, you may find that you have two identical Configuration
documents. You can delete one.

4.3 Global Domain document

Another document used in Domino Internet mail configuration is the Global
Domain document (Figure 20). You must create this document if your Domino
server handles multiple domains.
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Fg‘ Global Domain - Domino Administrator M= E3

File

3

Edit Miew Create Actions Test Help + P Y \J)\ G
ﬁ Adminiztration 4 ‘Welcome bo Doming Administrator RS _] Global Domain % administrator
'FE! Save and Close

DOMAIN: OURDOMAIN S

Basicsl Hestrictionsl Conversions | Administration

il

Address format: "ddress only ;= Outbourd mail restriction:  Restrict to global domain =]
Local primary Internet "janal.com 4 Country name: T g

domain:

Alternate Internet domain = ADMD name: ™ g

aliases:

Internet address lookup: " Disabled ;=1 PRMD name: ™ g

If disabled or no match,

corvert as follows:

Lecal part formed from:

T Full name ;=] Notes domain attribute: T Nore =]

Motes domain(s) included:

Al =

MNotes domain(s) position:

"Leftof @'z

MNotes domain separator:

Tog -

percent sign =1

Address example:

JMDredom 1 %dom 2¥edom 3@ ac me.com

NOTE: The following settings are not used in RS, They only apply to Rd.x SMTP MTAs

Outbourd mail restriction: ™ Unrestricted =]

Figure 20. Global Domain document

Even if you only have a single domain now, we strongly recommend that you use
a Global Domain document to manage incoming mail, in case you add domains in
the future. To create a Global Domain document, follow these steps:

1. Click the Configuration tab, then the Messaging twistie, and then the
Domains view. Click Add Domain.

2. Name the document any name you want.

We named ours OURDOMAIN. Its role is R5 Internet Domain (the value in the
Global domain role field under the Basics tab).

3. Click the Conversions tab, and enter your domain name in the Local primary
Internet domain field (janal1.com in our example).

If you want, you can add alternative domain names in the Alternate Internet
domain aliases field. Entering one or more names in this field tells the Domino
server to handle mail sent to any of the domains listed in the primary and aliases
fields. With no Global Domain document defined, your Domino server will accept
mail sent to the domain listed in the Server document’s Fully qualified server
name field. This means that, if you have only one SMTP domain, you could
change that field and not create a Domain document. However, once you have a
Domain document, Domino uses the SMTP domain names listed in it rather than
the domain name in the Server document’s Fully qualified server name field.

Note: The results that we received in our testing (cited in the following paragraph)
may change in future releases.

In our situation, if we create no Global Domain document and leave our Server
document as shown in Figure 17 on page 21, our Domino server will accept mail
for AS26.ITSOROCH.IBM.COM and ITSOROCH.IBM.COM. If we create the
Global Domain document shown in Figure 20, then mail will be accepted only for
janal.com. To have mail accepted for ITSOROCH.IBM.COM as well, we need to
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add it in to the Global Domain document as an alias. To have mail accepted for
AS26.ITSOROCH.IBM.COM, we need to add it to the Global Domain document
as an alias. If we only want mail for jana1.com, we can edit the Server document
by entering either janal.com, or dommail1.janal.com and not create a Global
Domain document at all.

4.4 SMTP implementations
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As mentioned earlier, you can use the Global Domain document to enable your
Domino server to accept mail for multiple SMTP domains. But what if you have
two partitioned Domino servers with one SMTP domain? You have several
choices for configuring SMTP mail for multiple Domino partitions. Figure 21
shows two methods.

iSeries  gMmTP iSeries SMTP
NOTES NOTES SMTP
RPC RPC :
ourserverb ourserverb
Option A Option B

Internet mail is sent by the individual

All Internet mail is sent and -
servers and received through ourservera

received through ourservera

Figure 21. Options for routing to the Internet

The easiest method (Option A) is the traditional Domino configuration where all
mail goes out through a mail hub. Ourserverb forwards mail to ourservera using
Notes, and ourservera sends it out via SMTP. Incoming mail comes via the ISP to
ourservera. Ourservera checks the recipient's SMTP domain against the
information in the Global Domain document. If the domains match, ourservera
locates the recipient’s mail server (ourserverb) in the Domino Directory and
forwards the message to ourserverb using Notes Remote Procedure Call
(NRPC).

You can tell whether mail is forwarded using Notes or SMTP by looking at the
Domino log or console. The following example shows the console of a Domino
server sending SMTP mail. “a.b.c.d” represents the IP address of the receiving
SMTP server.

09/30/2000 09:13:00 AM Router: Transferring mail to domain OURCOMPANY.COM host
ourservera.ourcompany.com [a.b.c.d]) via SMTP

09/30/2000 09:13:00 AM Router: Transferred 1 messages to OURCOMPANY.COM (host
ourservera.ourcompany.com) via SMTP

09/30/2000 09:13:05 AM Router: Message 005390CC transferred to
ourservera.ourcompany.com for jdoe@ourcompany.com via SMTP
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The following example shows the console of the Domino server receiving and
delivering SMTP mail locally. “f.g.h.i” represents the TCP/IP address of the
sending SMTP server.

09/30/2000 09:09:48 AM SMTP Server: f.g.h.i connected

09/30/2000 09:09:48 AM SMTP Server: Message 9A003780 received

09/30/2000 09:09:48 AM SMTP Server: f.g.h.i disconnected. 1 message [s]
received

09/30/2000 09:09:49 AM Router: Message 00534B87 delivered to John Doe/acme

The following example shows the console of the same Domino server receiving
mail destined for a user on ourserverb. The mail is transferred using Notes rather
than SMTP.

09/30/2000 09:08:49 AM SMTP Server: f.g.h.i connected

09/30/2000 09:08:49 AM SMTP Server: Message 9A003780 received

09/30/2000 09:08:49 AM SMTP Server: f.g.h.i disconnected. 1 message [s]
received

09/30/2000 09:08:50 AM Router: Transferring mail to OURSERVERB/ACME via Notes
09/30/2000 09:08:50 AM Router: Transferred 1 messages to OURSERVERB/ACME via
Notes

09/30/2000 09:08:55 AM Router: Message 0053349E transferred to OURSERVERB/ACME
for Susan Red/acme@acme via Notes

Another way to configure multiple Domino partitions for Internet e-mail is to allow
each partitioned Domino server to send mail out to the Internet, therefore easing
the burden on the first server (Option B in Figure 21). You implement this simply
by changing the forwarding location on ourserverb to point to the firewall or ISP.
Incoming mail comes to ourservera as before. Depending on your firewall or ISP,
you may be able to route half of the incoming mail through one Domino server
and half through the other server. However, doing so may actually place more of
a load on your systems. Assuming your users are divided evenly between the two
servers, routing all mail through ourservera means that 50 percent of the mail will
have to be forwarded. Dividing it randomly between the two servers means that,
in a worst-case scenario, 100 percent of the mail will arrive at the wrong server
and have to be forwarded.

4.5 Person documents

The Person document also includes some Internet mail-related information.
When you register a Domino user via Domino Administrator (in the Server
document), you can select the Advanced box and enter the Internet address at
registration time (Figure 22 on page 28).
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Register Person -- Mew Entry HE

IV Advanced Fiegistration Server, .. I dommaill/abc1

@ 4 First name Ml Last name Short name
Beses IHoger I_ IBIack IHBIack
Paszswaord Paszword Quality Scale
I Wieak B —— J— Strong
I~ Setintermet password Acceptable user password (8]
Internet address Internet Domain

Irblack@iana‘l .com Iiana‘l .com Faormat... I

The Internet address [above] iz created uzsing the person's name [above),
the internet domain and internet address format components. You can also
edit the internet address directly. [t must be unique in the address book.

Other Add person I Impart Text file... | Migrate people... |

Fiegistration queue:

A| User Name A| |Fbgistration Status A| Date

KN 2
Hegi§{e.‘.¢l\lli Eearster I Welete Optiong... Done I

Figure 22. Register Person

By default, the Internet Domain value displayed is the same as the value that is
specified in the TCP/IP configuration on the PC from which you're registering the
user. You can over type this value. Or, you can change the default value used by
selecting File->Preferences->Administration Preferences from the menu bar
and clicking Registration. See Figure 23.

Administration Preferences HE

Fiegistration domain: i abcl ;I

BEeqistration Server... I dommaill /abcl
Lertifier 1D... I C:\dommaill\cert.id
Mail Options... I Mail spstern:  Lotus Motes

Mail server: dommaill/abc
Mail template:  mail50. ntf

1D File Settings... I Perzon 1D c:hlotushhoteshdatatids\people

Server [Ds: c:hlotushnoteshdatabidshservers
Certifier [Ds: cihlotushnoteshdatatidshcerts

Internet domain User zetup profile
Iiana‘l .conl MobileDircatProfile ;I

Fiegiztration

Figure 23. Registration preferences

Make sure you change the value for the correct Registration domain. You can
also change how the name is formatted, for example: First Name followed by Last
Name or First Initial followed by Last Name.

It's also important that you complete the Internet address field to ensure that
Domino has the correct address. For example, if someone includes your Notes
name as a copied recipient in a message sent to an Internet mail user, your name
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must be converted to an SMTP address for the main recipient to include you in a
reply. If there’s no entry in the Internet address field, Domino automatically
constructs an SMTP address. However, the constructed name may not be in the
format you want. To avoid this problem, enter the address in the Mail subtab of
the Person document as shown in Figure 24.

Fg‘ Person record for: Adminl/abcl - Domino Administrator

File Edit Wiew Create Actions Test Help

g Adminiztration 4 ‘Welcome bo Doming Administrator RS | _] Perzon recaord for: Admind /abcl ﬂ

@I T Save and Close  |¥] Examine Internet Certificate(s) F8] Examine Notes Certficate(s)

PERSON:

min’ mintiabe1 @ abcl
Basics l I ail l whork/Home l Other l Miscellaneous l Certificates l Adminiztration l
Mail system: " Notes =1
Domain: Tabcl
Mail server: "dommaill/abe1
Mail file: "mailladmint
Forwarding address: *
Internet address: " admin1@janal.com
Format preference for * Prefers Notes Rich Text ;=]

incoming mail:

Encryptincoming " No =]
mail:

Figure 24. Person document - Mail subtab

Domino is flexible in how it tries to resolve incoming mail addresses. For
example, even if someone addresses mail to you as lastname @jana1.com, which
isn’t your real address, and you’re the only person with that last name, Domino
will deliver the message to you. Domino does this for the short name as well.
However, we recommend that you make sure all users have Internet address
entries in their Person documents to avoid possible confusion. If you want to
complete this field for all existing users, rather than manually enter addresses
one by one, use the Set Internet Address tool. You can access this tool in Domino
Administrator. Click the People & Groups tab and then the People view.

The Person document includes one more Internet mail-related field (under the
Mail subtab), which is the Format preference for incoming mail field. This
determines the format of Internet mail delivered to you. You can specify Domino
to convert the mail to MIME or Notes Rich Text, or select no preference. This may
affect the appearance of some mail you receive.

In 4.3, “Global Domain document” on page 24, we pointed out that you can have
alias SMTP domains. Suppose that your Domino server supports two SMTP
domains: janal.com and itsoroch.ibm.com. Your Person document could show
your Internet Mail address to be fred@janal.com. However, if you are the only
Fred in your organization, mail addressed to fred @itsoroch.ibm.com will also be
delivered to you.

4.6 Location documents

The Location document contains useful information for Domino SMTP
configuration. You can work with Location documents either via your Personal
Name and Address book or by selecting File->Mobile->Locations from the menu
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bar. You can also edit the current Location document directly from the status bar.
We strongly recommend you enter a user’s Internet address in the Location
document’s Internet mail address field (Figure 25) to ensure consistent
addressing.

Fg‘ Settings for location: Office [Network] - Domino Administrator

File Edit Wiew Create Actions Test Help * );' ’aé,% f; \.Q\ @
gAdministration | _] Settings for location: Office [Metwork) ﬂ administrator
@ & Save and Close @& Connection Configuration Wizard
LOCATION: Office (Network) ol 5 =
Basics l Servers l Ports l (G EL l Internet Browser l Fieplication l Advanced l Adminizgtration
Location type: " Lecal Area Network x| Prompt far r'\Ing
time/date/phone:
Location name: T Office (Network) Pray: ¥
Lz
Internet mail " admin1@janal.com 4 Default display " Display primary names =]
acdress: name:

Figure 25. Location document

Domino uses the address in the Location document when sending mail to
complete the sender’s address and provide a return address. Including a user’s
Internet mail address here allows a Notes client to create mail with a valid SMTP
sending address even when a user is working offline.

It's best if you enter here the same address that’s in the Person document. If
there’s no address, Domino constructs a cumbersome name that looks something
like John_Doe/acme%ACME @ AS26.ITSOROCH.IBM.COM. If you've changed
the Fully qualified host name in the Server document,
AS26.ITSOROCH.IBM.COM is replaced by what you have in that field. Again, we
advise that you complete the Location document’s Internet mail address field
rather than rely on Domino’s automatic address generation.

You can define multiple Location documents to test your environments. Under a
Location document’s Advanced tab, you can specify a particular user ID file to be
associated with a particular location. Make sure each location has an appropriate
Internet mail address entry, or you may find an incorrect entry placed in this field
for one or more of your locations. You can also specify that mail sent to Internet
addresses be in MIME format rather than Notes Rich Text Format (RTF). To do
this, click the Location document’s Internet Browser tab, and enter the
information in the appropriate field (Figure 25). We provide step-by-step
instructions in 8.2, “Notes client: Additional clients” on page 86.

Domino R5 handles the conversion between MIME and Notes native format. If
you’re sending a lot of SMTP mail, you can minimize the amount of conversion.
To do this, click the Location document’s Mail tab, and select MIME as the format
for messages sent to Internet addresses.

If you use Domino within your organization, but you also use a POP3 or IMAP
server somewhere else, you can use a Notes client as a POP3 or IMAP client. To
do so, you need to set up an alternate Location document and specify the second
server and appropriate mail type. See 8.3, “POP3 client: Notes” on page 88, or
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the Administration Help database (help\help5_admin.nsf) for more information
about doing this.

4.7 AnyMail Integration

—— Note

If you reply to SMTP mail received from a user on a Domino server using
AnyMail Integration, and their Reply To address looks like a Notes address
(john doe/abc1) rather than an SMTP address (johndoe @ janal.com), contact
Lotus Support for a fix.

When you configure a Domino server for AnyMail Integration, the Server
document created will look similar to the example in Figure 26.

Fg‘ Server: dommaild/abc4 - Domino Administrator

File Edit Wiew Create Actions Test Help @ 9 \@QC’)\ G

g Adminiztration _] Global Diomain | _] Server dommaild/abcd ﬂ administrator
FE! Save and Cloze 9 ‘weh...
SERVER: dommail4fabe4

y 1 00100 TAL TS
o 10 To1TaH

: ¥
Basics l Security l Ports l Server Tasks l Internet Protocals l MTés l Mizcellaneous | Transactional Logging l Adminizgtration F

B

Server name: rdommailél.-"abcéu Server build number: Felease 5.0.4
Server title: T Administrators: " admintabcd =]
Dromain name: Tabcd Routing tasks: " Mail Fiouting, SMTP Mail Fouting ;=]
Fully qualified Internet host  * as26.itsoroch.ibm,. cam SMTP listener task: T Disabled 1=
name:

Cluster name: Server's phone number(sl. 4

Directory Aszistance Py CPU count: 1

database name:

Directory Catalog database T 4 Operating system: IEM D5/400

hame on this server

Optimize HTTP perfarmance * Advanced [Custom Seftings] ;=] Is this & Sametime server? " Mo =]

bazed on the following
primary activity:

Server Location Information

Prefix for outside line: ™ g Calling card access number: ™
International prefix: T Calling card number: T
Country code at this location: © il |
Long distance prefis: 5 4
Area code at this location: ™ a Metwark Dialup idle imeout: © ] Minutes LI
The name of the Directory Assistance database on this server. It should be relative to the data directary.
| i B &l |=2adming I

Figure 26. Server document - AnyMail Integration

The main difference between this document and the one created for Domino
SMTP is that the SMTP listener is not enabled. This is because OS/400 SMTP
listens on Port 25, not Domino SMTP.

The Configuration document will look the same as the one created for Domino
SMTP. The relay host parameter in the Configuration document will not be used
to point to the firewall or ISP router. If you are configuring AnyMail Integration to
send mail to the Internet, use the Change SMTP Attributes (CHGSMTPA)
command to define the router name using the MAILROUTER parameter.
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The following information is important and not self-evident. When you start SMTP
and have a MAILROUTER parameter configured, the client (sending task)
immediately performs the gethostbyname function on this name to resolve the IP
address. If the gethostbyname function fails, any mail sent to the Internet fails
and the message is returned to the sender. It can fail if the router has not yet
been set up in the DNS, even though it will have a valid address the next day. It
will continue to fail even after the DNS is set up. It will not work until SMTP is
restarted with a successful gethostbyname function. The only time the
gethostbyname is run is when SMTP is started on the iSeries server.

With Domino SMTP, no Global Domain document is created by default. However,
you may manually choose to create one to handle your inbound SMTP domains
as discussed in 4.3, “Global Domain document” on page 24. With AnyMail
Integration, a Global Domain document called MTAGlobal is created and looks
similar to the example in Figure 27. You may want to edit it to change the names
of your supported SMTP domains.

Fg‘ Global Domain - Domino Administrator M= E3
File Edt Yiew Create Actions Text Help + E 1% G
£ Administration _]GlobaIDomain X administrator
FE! Save and Cloze
e - = -
DOMAIN: MTAGIobal e T :|
Basicsl Hestrictionsl Conversions | Administration 3 '\< _?ﬁ _':;_:-

=55 25| =8 (%5

Address format:

Plddress only =]

Outbound mail restriction:

Local primary Internet T as2F.itzoroch.ibm. cam Country name: ™ g

domain:

Alternate Internet domain Titzorach.ibm.com ADMD name: ™ g

aliazes:

Internet address lookup: T Enabled ;=] FRMD name: ™ g
# st or o el covieed g Al

Local part formed fram:

" Common harne =]

Motes domain attribute:

T None =]

Motes domain(z] included: ™ None =]
MNotes domainz] position: T Left of '@ =]
Motes domain separator: T - period 1 =]
Address example: JMD Eacme. com

MOTE: The following settings are not used in B5. They only apply to Bd.x SMTP MTAz

Outbound mail restriction:

T Unrestricted 1 =]

Figure 27. Global Domain document - AnyMail Integration

4.7.1 MTAGIlobal Global Domain document
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As you have seen, when AnyMail Integration is configured, a Global Domain
document called MTAGlobal is created. It has the primary Internet domain set to
be the fully qualified iSeries server name, such as AS26.ITSOROCH.IBM.COM.
As discussed in 4.3, “Global Domain document” on page 24, if there is a Global
Domain document with a value in the domain, only that (or any aliases listed) will
be accepted as a local SMTP domain. This means that only mail for SMTP
names, such as user@AS26.ITSOROCH.IBM.COM will be accepted. If you want
mail to be accepted for user@ITSOROCH.IBM.COM, you need to perform three
tasks:

1. Add ITSOROCH.IBM.COM as an Internet domain alias (or replace the primary
domain).
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2. Add ITSOROCH.IBM.COM in the host table on the iSeries server so that it
(the iSeries server) recognizes the mail as local (as being somewhere within
the server, either iSeries or Domino) when it is delivered.

3. Ensure that the DNS servers (either yours or your ISPs) have appropriate Mail
Exchanger information for ITSOROCH.IBM.COM to deliver it to the iSeries
server AS26.

4.8 Mail delivery

When you send mail to a user, such as jsmith@ someothercompany.com, how is
the mail routed? First, the router determines that the mail is not for a user in the
local Domino Directory. Then the Domino server sends a request to the 0S/400
resolver.

The configuration will determine how the OS/400 resolver behaves. Assuming
that the Domino server configuration is left at the default of “Dynamic then Local”
(which is our recommendation), the resolution order depends on the iSeries
TCP/IP setting. If it is set to *LOCAL, the resolver first looks in the iSeries host
table and then in any DNS listed. If it is set to *FREMOTE, it looks first at the DNS
server for resolution. If it fails to find any entry, for *“MSF, mail will be forwarded to
the location given in the Mail Router parameter of the SMTP attributes (if it
exists). If there is no Mail Router parameter, the mail delivery will fail. For
Domino, the Domino forwarder setting will be used to forward the mail to an ISP.

If an address resolution is successful, an SMTP connection is made between the
SMTP client and the server, and the mail is transferred.

In reality, in most cases, DNS resolution would be done on the Internet using a
DNS at an ISP and other Internet DNS services. When someone from outside
your organization sends mail to you, the same process is done from their end.
Eventually a DNS server will return either an IP address for your server, or the
name of the server managing the mail for your environment (an MX record) and
an SMTP conversation is initiated.

When the mail is delivered to your Domino server, the Domino server looks for a
match with an SMTP domain (primary or alias) in the Global Domain document, if
it exists, or in the Server document if it does not. It then finds the person’s name
in the Domino Directory. Either the user is local, or information is provided about
where to send the mail next.

If you are using AnyMail Integration, for MSF to consider that the mail is local, the
SMTP domain name must be in the local host table. Once that happens, the
iSeries server looks for a match in the system distribution directory. If it finds a
match, the mail is delivered to the local OfficeVision/400 or POP3 user. If it
doesn’t, or if the match is a Notes user, the mail is forwarded to the Domino
server, where there should be a match in the Domino Directory. If there is not, the
mail is forwarded back to the iSeries server. This can result in mail going around
in a loop if addressing is not correct.

4.8.1 AS26.ITSOROCH.IBM.COM or ITSOROCH.IBM.COM

You may have seen documentation that shows OS/400 SMTP users as having
SMTP names, such as pbrown@ as26.itsoroch.ibm.com. If you are only
exchanging mail internally or between Domino and iSeries users on the same
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iSeries server, this may be acceptable. However, we suggest that you use a more
natural name, such as pbrown @itsoroch.ibm.com. It is not standard to see a host
name in a person’s SMTP name. Because of the way in which the Global Domain
document for AnyMail Integration is automatically created, you have to make a
change to have the Domino server accept mail for pbrown @itsoroch.ibm.com.
We explain how to do this in 4.7.1, “MTAGlobal Global Domain document” on
page 32.

If you want to use the full name (including a host name), and you require the use
of a host table, you have to make some adjustments to the example shown in
Appendix A, “Setting up a DNS” on page 209.

In particular, you create a primary domain AS26.ITSOROCH.IBM.COM, rather
than ITSOROCH.IBM.COM with a mail exchanger of
AS26.ITSOROCH.IBM.COM. When you define the host (AS26)
AS26.ITSOROCH.IBM.COM, you need to type a period at the end of the name
AS26.ITSOROCH.IBM.COM, so that the DNS does not append the domain name
to the end.

Note: In the original setup, you enter the host name of AS26, and it appends the
ITSOROCH.IBM.COM for you.
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Chapter 5. One iSeries server and two SMTPs
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When Domino for AS/400 was released, a single iSeries server could only
support a Domino server using either 0S/400 SMTP or Domino SMTP, but not
both. If there was a need for SMTP on the iSeries server because of something
other than Domino (such as OfficeVision/400), Domino servers would also have
to use the OS/400 SMTP.

For information about configuring SMTP support for Domino, see Chapter 3,
“Configuring Domino for SMTP” on page 15.

PTFs are now available to allow the coexistence of the two SMTP stacks. The
function is known as bind to specific IP address. It means that both SMTP stacks
(iSeries and Domino) are supported at the same time. This is achieved by new
functionality that allows the OS/400 SMTP server and OS/400 SMTP client to
each bind to a specific TCP/IP address based on data from specific data areas. A
diagram of this support is shown in Figure 28.

iSeries

iSeries
MSF
SMTP

DOMINO
SMTP

\ iSeries TCP/IP \

i

IP ADDRESS A.B.C.D
PORT 25

=

With bind to specific IP address support, Domino for AS/400 with Native SMTP
support can coexist with OS/400 SMTP. OS/400 SMTP can be used by both
OfficeVision/400 users and Domino for AS/400 users with AnyMail/400 (on a
single Domino server on any given iSeries server). This means that you can have
multiple Domino servers with Domino SMTP as well as one Domino server
configured with AnyMail Integration support on the same iSeries server at the
same time.

IP ADDRESS w.x.y.z
PORT 25

Figure 28. Bind to specific IP address

Bind to specific IP address functionality is implemented on iSeries servers at
V4R2MO or later with PTF support. The specific PTF numbers are shown in Table
1.

Table 1. PTFs needed for bind to specific IP address support

iSeries release Server PTF number Client PTF number

V4R2MO SF55697 SF55704

V4R3MO SF58661 SF59663
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iSeries release Server PTF number Client PTF number

V4R4MO SF60787 SF60764

V4R5M0 SF60827 SF61136

Load, apply, and configure both PTFs for your release. In an SMTP conversation
between your SMTP host and another one, your host may be a client or a server,
depending upon which end originates the request.

5.1 Configuring bind to specific IP address

To configure for bind to specific IP address, perform the following steps:

1. Determine which of your defined and active iSeries TCP/IP interfaces is to be
used by OS/400 SMTP.

2. Create the data area QUSRSYS/QTMSSBNDIP by typing the following
command on any iSeries command line:

CRTDTAARA DTAARA (QUSRSYS/QTMSSBNDIP) TYPE (*CHAR) LEN(16) VALUE( ‘i.j.k.1’ )+
AUT (*USE)

Here, i.j.k.I stands for the IP address of the desired local TCP/IP interface on
the iSeries server.

This makes the SMTP server use a specific IP address.

3. Create the QUSRSYS/QTMSCBNDIP data area by typing the following
command on the iSeries command line:

CRTDTAARA DTAARA (QUSRSYS/QTMSCBNDIP) TYPE (*CHAR) LEN(16) VALUE( ‘i.j.k.1’ )+
AUT (*USE)

Here, i.j.k.I stands for the IP address of the desired local TCP/IP interface on
the iSeries server.

This makes the SMTP client use a specific IP address.
4. Stop and restart SMTP with the following iSeries commands:

ENDTCPSVR *SMTP
STRTCPSVR *SMTP

5.2 Using bind to specific IP address

36

Note: To use bind to specific IP address functionality, any Domino server using
Domino SMTP on an iSeries server has to use its own IP address, and not the
address by which the iSeries server is generally known.

For information about how to configure Domino for OS/400 SMTP to use its own
IP address, see Lotus Domino for AS/400 R5: Implementation, SG24-5592.

In the following examples, we use two different SMTP domains on the one iSeries
server: one for the iSeries SMTP (itsoroch.ibm.com) and the other for Domino
SMTP (jana3.com). The iSeries has a TCP/IP name of AS26, and the Domino
server has a TCP/IP name of dommail3. In Chapter 12, “Single SMTP domain
with bind to specific IP address” on page 183, you will see the circumstances
under which it is possible to use bind to specific IP address with the same SMTP
domain for an iSeries server and Domino. In summary, our scenario consists of:
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iSeries host name: AS26

iSeries TCP/IP domain: itsoroch.ibm.com

iSeries fully qualified TCP/IP name: AS26.itsoroch.ibm.com
0S/400 SMTP domain: itsoroch.ibm.com

Domino server name: dommail3

Domino SMTP name: jana3.com

Sample AS/400 user: ovuser@itosoroch.ibm.com

Sample Domino user: peter@jana3.com

5.2.1 Exchanging mail between Domino and OfficeVision/400

With bind to specific IP address support, it is possible for Domino Native SMTP to
exchange mail with OfficeVision/400 on the same iSeries server. To achieve this,
perform the following steps:

1. Set up bind to specific IP address support on the iSeries server, as described
in 5.1, “Configuring bind to specific IP address” on page 36.

2. Configure Domino on the iSeries server to use Domino SMTP. Refer to Figure
12 on page 15 to see the values to use when configuring Domino SMTP. If you
already configured a Domino server to use MSF and you want to change to
use Domino SMTP, use the Change Domino Server (CHGDOMSVR)
command to do this.

3. Start the Domino server, and set up the Domino Administrator. You can find
information about how to start Domino server and set up the administrator
workstation in Lotus Domino for AS/400 R5: Implementation, SG24-5592.

4. In the Domino Server document, change the fully qualified Internet host name
to reflect the Domino SMTP domain. To achieve this, complete these tasks:

. Start the Domino Administrator.

. Click the Administration active task button.

. Expand the Server section.

a

b

c. Click the Configuration tab.

d

e. Double-click All Server Documents.
f.

Highlight the Server document for your Domino server, and click the Edit
Server button.

g. Click the Basics tab.

h. For the fully qualified Internet host name, insert the Domino name followed
by the SMTP domain name used by Domino (for example,
dommail3.jana3.com) as shown in Figure 29 on page 38. Refer to 4.3,
“Global Domain document” on page 24, for more information about an
alternative approach. This allows you is to use a Global Domain document
rather than changing the Server document to support the domain
jana3.com. You can decide which approach you want to take.

i. Restart the Domino server.

For more information about administering the Domino system, refer to the
Lotus book Domino Release 5: Administering the Domino System, CT6T7NA
(also available as the online Administration Help database
help\help5_admin.nsf).
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[E3 Server: dommail3/abc3 - Domino Administrator

Fle Edi Yiew Creae Actions Tewt  Help & o 0o O
2 Administiation 22 Weleame to Demine Administralor R | _ Server. dommail3/abe3 X dministrat
(%] Fysaveandtiose 53 web.
SERVER: dommal3/abes “’r ‘ 00
= .

Eas\:sl Secuily | Poits | Server Tasks | Intemet Frotocols | MTas | Miscellaneous | Transactional Logging | Adminisration [* L8

Server name. " dommail3/abe3 Server build number Release 5.0.3 (Int]

Server litls: "3 Adrinistratars: " admin/abc3_ =y

Domain name: Tabcd Routing tasks " Mail Routing, SMTF Mail Routing ;=]

Fully qualfied Intemet host* dommai.anad. com 1 SMTF fistener task: T Enabled 1 =i

Cluster name: Servers phone numberlsl. 7

Directory Assistance T2 TFU count 7

dalabase name:

Directory Catalog database © 4 Operating system: TBM 057400

name o this server

Dptiize HTTF performance 7 Advanced (Custom Setings) ) =] Ts this a Gamelime server® 7 No =i

based on the following
primary activity:

Server Location Information

o

Prefis for outside line: a Caling card access number.

e

Intemational prefis 7 Caling card number. 7
—
Country code at this location: ™ Dialing Rules. .
Long distance prefix 5
Area code at this location: © Network Dialup idle fmeaut: ™ minutes
Local tims zone: ST (Central Standard Time ) =4 Mail server " darnmail3/abc3
Daylight savings fime: " Obaerved here ) = Passthiu server T

InteiNotes server: Mo

J |
Distinguished name of Maotes server.
| T =l A=3adming |

Figure 29. Specifying the Fully qualified Internet host name in the Domino Server document

5. In your Domain Name Server (DNS), verify the following points:

* Both the Domino and OS/400 SMTP domains are configured as Primary
domains.

e The iSeries host name and IP address are added to the iSeries SMTP
domain.

¢ The Domino server name and IP address are added to the Domino SMTP
domain.

* Each Primary domain is configured with its correct Mail Exchanger host
name.

Appendix A, “Setting up a DNS” on page 209, takes you through the steps to
set up a DNS for this scenario.

— Note

You can use the PC tool CyberKit to check whether the domains are
correctly configured in DNS. For more information about CyberKit, see
9.4.4, “CyberKit” on page 144, or refer to the Web page at:
http://www.cyberkit .net

More information about how to configure the iSeries Domino Name Server can
be found in AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support,
SG24-5147, and AS/400 Mail: Multiple SMTP Domains Behind a Firewall,
SG24-5643.

6. Add or edit the iSeries system distribution directory entries for
OfficeVision/400 users who will exchange mail with Domino users. Refer to
Figure 30 to see the values to specify for Mail Service level and Preferred
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address (these are the defaults). Press F19 (Add name for SMTP), specify a
name for the SMTP user ID, and specify the iSeries SMTP domain. Refer to
Figure 31. The SMTP user ID can be the same as the iSeries user ID as
shown in Figure 31.

4 ) N
Add Directory Entry
Type choices, press Enter.
Mail service level . . 1 1=User index
2=System message store
4=Lotus Domino
9=Other mail service
For choice 9=Other mail service:
Field name . . . . F4 for list
Preferred address . . . 1 1=User ID/Address
2=0/R name
3=SMIP name
9=Other preferred address
Address type . . . . F4 for list
For choice 9=Other preferred address:
Field name . . . . F4 for list
More. ..
F3=Exit F4=Prompt F5=Refresh Fl12=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields )
Figure 30. The values for Mail service level and Preferred address
4 N
Add Name for SMTP
System: AS26
User ID/Address . . . . . : OVUSER 2AS26
Type choices, press Enter.
SMIP user ID . . . . . . ovuser
SMIP domain . . . . . . . ITSOROCH.IBM.COM
SMIP route
F3=Exit Fl2=Cancel
(C) COPYRIGHT IBM CORP. 1987, 1999. y

Figure 31. Adding an OV/400 user for SMTP use

7.

We recommend that you use Internet addressing on the iSeries server to
enable OfficeVision users to type names, such as myuser@jana3.com and
another@therealinternet.com, rather than require all recipients to be
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pre-defined in the system distribution directory. Figure 40 on page 45 shows
you the Reply to Mail display when using Internet addressing. The Send Note
display looks similar. To activate Internet addressing on the iSeries server,
perform the following steps:

a. Add a directory entry for routing to SMTP with the following specifications:

User ID/Address: INTERNET SMTPRTE
Preferred address: 9 (other preferred addresses)
Address type: ATCONTXT

Field name: NETUSRID

e Product ID: *IBM

Use the Add Directory Entry (ADDDIRE) or Work with Directory Entries
(WRKDIRE) command, and select option 1.

These specifications are shown in Figure 32 and Figure 33. The actual
User ID/Address used doesn’t matter. We chose to use INTERNET
SMTPRTE. Scroll down several pages to enter the mail preferences as
shown in Figure 34.

Add Directory Entry B
Type choices, press Enter.
User ID/Address . . . . INTERNET SMTPRTE
Description . . . . . . User Id to route Internet addresses
System name/Group . . .  INTERNET F4 for list
User profile . . . . . *NONE F4 for list
Network user ID . . . . *USRID
Name :
Last . . . . . . . .
First . . . . . . . .
Middle . . . . . . .
Preferred . . . . . .
Full . . . . . . ..
Department . . . . . . F4 for list
Job title . . . . . . .
Company . . . . . . . .
More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields )

Figure 32. Adding a directory entry as a route to SMTP gateway
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Add Directory Entry
Type choices, press Enter.

Mail service level . . 1 1=User index
2=System message store
4=Lotus Domino
9=Other mail service
For choice 9=Other mail service:

Field name . . . . F4 for list
Preferred address . . . 9 1=User ID/Address
2=0/R name
3=SMIP name
9=Other preferred address
Address type . . . .  ATCONIXT F4 for list
For choice 9=Other preferred address:
Field name . . . . NETUSRID *IBM F4 for list

More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields

Figure 33. Adding a directory entry as a route to SMTP gateway

b. Change the distribution attributes to configure a route to the SMTP
gateway. To achieve this, type cuepsTa on an iSeries command line, press
F4, and insert the values as shown in Figure 34.

4 N
Change Distribution Attributes (CHGDSTA)
Type choices, press Enter.
Keep recipients . . . . . . . . *BCC *SAME, *BCC, *ALL, *NONE
Use MSF for local . . . . . . . *NO *SAME, *NO, *YES
Route to SMIP gateway:
User ID . . . . . . « . « . . internet Character value, *SAME, *NONE
Address . . . . . . . .. .. smtprte Character value
Bottom
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F13=How to use this display
F24=More keys

- J

Figure 34. Changing distribution attributes

c. Enable each OfficeVision/400 user to send Internet mail. To do this, type
cHcorCENR and press F4. Type the user ID, press Enter. Scroll down two
pages. For Allow Internet addressing, specify *vEs, as shown in Figure 35
on page 42.
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Change Office Enrollment (CHGOFCENR)
Type choices, press Enter.
Allow jobs or procedures . . . . *NO *SAME, *NO, *YES
Display week number . . . . . . *NO *SAME, *NO, *YES
New Mail Indicator . . . . . . . *NEW *SAME, *NEW, *UNOPENED
Allow internet addressing . . . *YES *SAME, *NO, *YES

Bottom

F3=Exit F4=Prompt F5=Refresh Fl0=Additional parameters Fl2=Cancel
F13=How to use this display F24=More keys )

Figure 35. Changing office enrollment

You can find more information on how to activate Internet addressing on the
iSeries server in AS/400 Electronic-Mail capabilities, SG24-4703.

8. Start the Notes client. Send mail to the OfficeVision/400 user. Specify their
SMTP user ID and domain name as the address. Refer to Figure 36.

(™ New Memo - Lotus Notes

File Edit Wiew Create Actions Test Help

@ ‘Wwelcome ‘Workspace @ uzerd - Sent _2 Hello _] Mew Memo X

userd  [ovuser@itzoroch.ibm. com

Subject: Hella

From Domino native SMTP to O%/400 onthe same machine,  using Dual Stack|

Figure 36. Sending mail from Domino Native SMTP to OV/400

9. Sign on as your OfficeVision/400 user, and select option 2 (Mail from the
OfficeVision menu). You will see a display like the example in Figure 37.
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) ] )
Work with Mail
Working with mail for . . . . . : OVUSER AS26
Type options, press Enter.
2=Revise a copy 4=Delete 5=View 6=Print 8=Work with details
9=Print options 1l0=Forward 1l=Reply 12=File remote 13=File local
14=Authority 15=Fill form
——————— From------- Date
Opt Status User ID Address Description Received
OPENED USER3 Uus test 12 06/20/00
OPENED ABRAKADA DOMICIIN aa 06/20/00
OPENED USER3 JANA3 Hello 06/19/00
Bottom
F3=Exit F5=Refresh F6=Work with outgoing mail status
F9=Work with action items Fl0=Display new mail Fl2=Cancel F24=More keys
J

Figure 37. Work with Mail

In the address field, you find the sender’s user name truncated to eight
characters. The sender’s domain name is truncated at the first dot or at eight
characters. There will be no truncation if each field is less than eight
characters. You can’t tell whether there is truncation from this screen.
However, if you open the mail, you will see it. For the mail in Figure 37, the
SMTP names of the three pieces of mail that you see here are
user3@us.ibm.com, abrakadabra@domicilnal.domena, and
user3@jana3d.com. Figure 38 on page 44 shows the content of one of the mail
items. You can see the full name of the sender displayed.
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MATL P:12 VIEW Instruction Pg:1 In:1
B3 R B e O U DR | S R R A S DU S B
*
To: ovuser@itsoroch.ibm.com
From: abrakadabra@domicilnal.domena
Date: Tue, 20 Jun 2000 08:17:42 -0500
Subject: aa
Hello
F3=Exit F7=Window Fl2=Cancel Fl6=File remote
F4=Find char F8=Reset F13=Edit option Fl7=Function
F5=Goto Fl0=Forward Fl4=Delete mail F19=Print
F6=Find Fll=Reply F15=File local F21=Nondisplay keys
N J

Figure 38. Sample mail

10.Having displayed, for example, the third item, press F11 (Reply). Your display
will look similar to the example in Figure 39 with the names still truncated.
Notice the message at the bottom User USER3 USER3 not found in directory
Unless the sender is registered in the iSeries system distribution directory, you
have to type the user’s Internet mail address in the address field, as shown in
Figure 40.

Reply to Mail
Mail description . . . . . . : Hello

Type mailing information, press F6 to type note.
Subject . . . .. ... .. Hello

Reference

Type distribution list and/or addressees, press F10 to send.

Distribution list . . . . . F4 for list
—————————————————————————————————— Addressees------=——--=——==———=———————————————
Type nickname, user ID address, or internet address. One per line.

USER3 JANA3

More. ..
F3=Exit F6=Type note F9=Attach memo slip F10=Send F1ll=Change details
Fl12=Cancel Fl13=Change send instructions Fl4=Specify list F24=More keys
User USER3 USER3 not found in directory.

N
Figure 39. Replying to Notes mail from OV/400 (Part 1 of 2)
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] N
Reply to Mail
Mail description . . . . . . : Hello
Type mailing information, press F6 to type note.
Subject . . . . . . .. L. Hello
Reference . . . . . . . ..
Type distribution list and/or addressees, press F10 to send.

Distribution list . . . . . F4 for list
—————————————————————————————————— Addressees----------=------------------—————
Type nickname, user ID address, or internet address. One per line.

USER3@JANA3 . com

More. ..
F3=Exit F6=Type note F9=Attach memo slip F1l0=Send F1ll=Change details
Fl2=Cancel F13=Change send instructions Fl4=Specify list F24=More keys
User USER3 USER3 not found in directory. )

Figure 40. Replying to Notes mail from OV/400 (Part 2 of 2)

5.2.2 Exchanging mail between Domino and iSeries POP3 clients

With bind to specific IP address support, it is possible for Domino Native SMTP to
exchange mail with POP3 clients who are using the OS/400 SMTP server on the
same iSeries server. To achieve this, perform the following steps:

1.

Set up bind to specific IP address support on the iSeries server, as explained
in 5.1, “Configuring bind to specific IP address” on page 36.

Configure Domino on the iSeries server for using Native SMTP. Refer to
Figure 12 on page 15 to see which values to use when configuring Domino for
Native SMTP.

Start the Domino server, and set up the Domino Administrator. You can find
information about how to start the Domino server and set up the administrator
workstation in Lotus Domino for AS/400 R5: Implementation, SG24-5592.

In the Domino Server document, change the Fully qualified Internet host name
to reflect the Domino SMTP domain, as described in 5.2.1, “Exchanging mail
between Domino and OfficeVision/400” on page 37.

In your Domain Name Server, verify the following points:

* Both the Domino and OS/400 SMTP domains are configured as Primary
domains.

¢ The iSeries host name and IP address are added to the OS/400 SMTP
domain.

e The Domino server name and IP address are added to the Domino SMTP
domain.

* Each Primary domain is configured with its correct Mail Exchanger host
name.
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Appendix A, “Setting up a DNS” on page 209, takes you through the steps to
set up a DNS for this scenario.

Note

You can use the PC tool CyberKit to check whether the domains are
correctly configured in DNS. For more information about CyberKit, see
9.4.4, “CyberKit” on page 144, or refer to the Web page at:
http://www.cyberkit .net

You can find information on configuring the iSeries Domino Name Server in
AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support, SG24-5147, and
AS/400 Mail: Multiple SMTP Domains Behind a Firewall, SG24-5643.

6. On the iSeries server, create a user profile for a POPS3 client. You may specify
Initial menu *s1GNOFF to prevent anyone from signing on to the iSeries server
as this user.

7. Add the user ID for the POP3 client to the system distribution directory. Refer
to Figure 41 to see which values to specify for Mail service level and Preferred
address. Press F19 (Add name for SMTP), and specify the SMTP user ID and
the OS/400 SMTP domain (refer to Figure 42). The SMTP user ID can be the
same as the iSeries user ID for the POP3 client, as shown in Figure 42.

Add Directory Entry
User ID/Address . . . . : ASPOPCLI AS26
Type changes, press Enter.

Mail service level . . 2 1=User index
2=System message store
4=Lotus Domino
9=Other mail service
For choice 9=Other mail service:

Field name . . . . F4 for list
Preferred address . . . 3 1=User ID/Address
2=0/R name
3=SMIP name
9=Other preferred address
Address type . . . . F4 for list
For choice 9=Other preferred address:
Field name . . . . F4 for list

More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details
L F19=Change name for SMIP F20=Specify user-defined fields F24=More keys

Figure 41. Adding an iSeries system directory entry for the POP3 client
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Add Name for SMIP A

System: AS26
User ID/Address . . . . . : ASPOPCLI AS26

Type choices, press Enter.

SMIP user ID . . . . . . aspopcli
SMIP domain . . . . . . . AS26 . ITSOROCH. IBM. COM
SMTP route

F3=Exit Fl2=Cancel
(C) COPYRIGHT IBM CORP. 1987, 1999.

-

Figure 42. Adding an SMTP name for POP3 client in the iSeries system directory

8. Configure Outlook Express (for example) as the POPS3 client to the iSeries
server by performing the following steps:

a. Start Outlook Express, and select Tools->Accounts from the pull-down
menu. Select the Mail tab, click Add, and select Mail.

b. In the Outlook Express Internet Connection Wizard, type the name of
POPS client, as shown in Figure 43.

Internet Connection Wizard E

Your HName

‘wihen vou send e-mail, your name will appear in the From field of the outgoing message.
Type your name az you would like it to appear.

Dizplay name:

For example: John Smith

< Back I Mest » I Cancel |

Figure 43. Configuring Outlook Express as the POPS3 client to the iSeries server (Part 1 of 4)

c. Forthe Internet e-mail address, enter the SMTP user ID and domain for the
POP3 client, as specified in the system distribution directory. Refer to
Figure 44 on page 48.
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Internet Connection Wizard

Internet E-mail Address

azpopclii@itzoroch. ibm. com

Figure 44. Configuring Outlook Express as the POP3 client to the iSeries server (Part 2 of 4)

d. On the E-mail Server Names display, specify the iSeries server name and
SMTP domain for both the incoming mail server and the outgoing mail
server, as shown in Figure 45.

Internet Connection Wizard

E-mail Server Names

as26.itsoroch.ibrm. com

a32F,itzoroch.ibm. com|

Figure 45. Configuring Outlook Express as the POP3 client to the iSeries server (Part 3 of 4)

e. On the Internet Mail logon display, type the iSeries user profile and
password for the POP3 client, as shown in Figure 46.
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Internet Connection Wizard E

Internet Mail Logon

Type the account name and password your Internet service provider has given you.

Account name: Iaspopcli

Password: I *****
¥ Remember password
If your Internet service provider requires you to uge Secure Pazsword Authentication

[5P4)] to access your mail account, select the 'Log On Using Secure Pazsword
Authentication [SPA]' check box.

™ Log on using Secure Password Authentication [SPA)

< Back I Mest » I Cancel |

Figure 46. Configuring Outlook Express as the POPS3 client to the iSeries server (Part 4 of 4)

Other mail clients, such as Netscape Messenger can also be configured to be
POP3 clients. See 8.3, “POP3 client: Notes” on page 88, and 8.4, “POP3
client: Netscape Messenger” on page 91, for instructions on how to set up the
Notes client and Netscape Messenger as POP3 clients.

9. Start the Notes client. Send mail to the AS/400 POP3 client specifying the
SMTP user ID and domain name of the POPS3 client as the address, as shown
in Figure 47.

(™ New Memo - Lotus Notes

File Edit Wiew Create Actions Test Help

g ‘Welcome ‘Workspace ;} uzerd - Inbox _] Mew Memo X
g 9 Send @ Send and File "& raf !
userd To: |FEPopcli@itsarach.ibm.com
09/03/00 10:52 &M -
(3158
bec:
Subject: Hella

&

a
&
e
i
2
L

Figure 47. Sending mail from the Notes client to the iSeries POP3 client

From Domino Native SMTP on AS2E to A5/400 POF3 client. Using bind to specific IP address.|

10.In Outlook Express, display the received mail, and click Reply. Note that the
address contains the Notes user ID and domain name, as shown in Figure 48
on page 50. Send the reply to the Notes user.
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To: |user3@'an33.com
(Ciez |
Subject: |F|e: Hella

Thiz 15 a reply from ASM00 POP3E clent to Domine SWTT user, using bind to specific IP address.
————— Criginal Message -----
From: <user3@jana3.com>

To: <aspopcli@itsoroch.ibm. com>
Sent: Sunday, September 03, 2000 10:53 AW
Zubject: Hello

> From Domine Mative SWTT on AS26 to AZMO0POP3 client. Tsing bind to
> gpectfic IP address.
=3

Figure 48. Sending a reply from the POP3 client to Domino

5.2.3 Exchanging mail between Domino *SMTP and Domino *MSF

50

With bind to specific IP address support, it is possible for two Domino servers,
one configured for Native Domino SMTP support and the other configured for
0S/400 SMTP Support with AnyMail/400 MSF, to function simultaneously on the
same iSeries server.

This can be achieved by performing the following steps:

Note: We refer to the Domino server using Native SMTP support as Domino
*SMTP server. We refer to the Domino server using OS/400 SMTP with
AnyMail/400 MSF as Domino *MSF server.

1. Set up bind to specific IP address support on the iSeries server, as explained
in 5.1, “Configuring bind to specific IP address” on page 36.

2. Configure Domino *SMTP server. Refer to Figure 49 to see the values to enter
when configuring the Domino *SMTP server.
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Configure Domino Server (CFGDOMSVR)

Type choices, press Enter.
Administrator:

last name . . . . . . . . . . admin3

First name . e e e e

Middle initial . . . . . . . . Character value

Password . . . . . . . . . . . lotus

Minimum password length . . . 4 0-31

Internet password . . . . . . *NONE
Time zone . . . . . . . . . . . cst GMT, EST, CST,MST, PST, CET ...
Daylight savings time . . . . . *YES *YES, *NO
Web browsers . . . . . . . . . . *NONE Name, *NONE, *ALL, *HTTP...
Internet mail packages . . . . . *smtp *NONE, *ALL, *IMAP, *POP3 ...

+ for more values
SMIP services . . . . . . . . . *DOMINO *DOMINO, *MSF
More. ..
F3=Exit F4=Prompt F5=Refresh Fl0=Additional parameters Fl2=Cancel
F13=How to use this display F24=More keys
- J

Figure 49. Configuring the Domino server for native SMTP use

3. Configure another Domino server for 0S/400 SMTP MSF support. Refer to
Figure 50 on page 52 to see the values to enter when configuring a Domino
*MSF server. This server is called dommail4. A Global Domain document
called MTAGlIobal will be created and is, by default, defined to accept mail for
SMTP domain as26.itsoroch.ibm.com. Modify this document to accept mail for
itsoroch.ibmcom. See 4.7, “AnyMail Integration” on page 31, for more
information on the documents created for an *MSF server. Ensure that
itsoroch.ibm.com is in your iSeries host table.

You can find information about configuring for Domino for AS/400 in Lotus
Domino for AS/400 R5: Implementation, SG24-5592.
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4 N
Configure Domino Server (CFGDOMSVR)
Type choices, press Enter.
Administrator:
last name . . . . . . . . . . admin4
First name . . . . . . . . . .
Middle initial . . . . . . . . Character value
Password . . . . . . . . . . . lotus
Minimum password length . . . 4 0-31
Intermet password . . . . . . *NONE
Time zone . . . . . . . . . . . cst @GMT, EST,CST,MST, PST,CET ...
Daylight savings time . . . . . *YES *YES, *NO
Web browsers . . . . . . . . . . *NONE Name, *NONE, *ALL, *HITP...
Internet mail packages . . . . . *smtp *NONE, *ALL, *IMAP, *POP3 ...
+ for more values
SMIP services . . . . . . . . . *msf *DOMINO, *MSF
More. ..
F3=Exit F4=Prompt F5=Refresh Fl0=Additional parameters Fl2=Cancel
L F13=How to use this display F24=More keys y

Figure 50. Configuring Domino for OS/400 SMTP MSF use

4. In the Domino *SMTP server, change the Fully qualified Internet host name to
reflect the Domino SMTP domain. To do this, complete these tasks:

a
b
c.
d
e
f.

. Start the Domino Administrator.

. Click the Administration active task button.
Click the Configuration tab.

. Expand the Server section.

. Double-click All Server Documents.

Highlight the Server document of your Domino server, and click the Edit
Server button.

. Click the Basics tab.

For the fully qualified Internet host name, insert the Domino name followed
by the SMTP domain name used by Domino (for example,
dommail3.jana3.com). Refer to Figure 29 on page 38. Either jana3.com or
dommail3.jana3.com works in this field.

Restart the Domino server.

For more information about administering the Domino system, refer to the
Lotus book Domino Release 5: Administering the Domino System (also
available as the online Administration Help database help\help5_admin.nsf).

5. In your Domain Name Server, verify the following points:

e Both Domino and OS/400 SMTP domains are configured as primary
domains.

e Domino *SMTP server name and IP address are added to the Domino
SMTP domain.

e Domino *MSF server name and IP address are added to the OS/400 SMTP
domain.
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» Each Primary domain is configured with its correct Mail Exchanger host
name.

Note

You can use the PC tool CyberKit to check if the domains are correctly
configured in DNS. For more information about CyberKit, see 9.4.4,
“CyberKit” on page 144, or refer to the Web page at:
http://www.cyberkit .net

You can find information on configuring the iSeries Domino Name Server in
AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support, SG24-5147, and
AS/400 Mail: Multiple SMTP Domains Behind a Firewall, SG24-5643.

6. Start the Notes client for the Domino *SMTP server. Send mail to the Notes
client of the Domino *MSF server using their Internet address, which consists
of the user name and the OS/400 SMTP domain name such as
user4 @itsoroch.ibm.com.

7. Start the Notes client for the Domino *“MSF server. Open the received mail in
your inbox, and click Reply or select Reply from the pull-down menu. Note
that the address is automatically completed with the Internet address of the
Domino *SMTP user, such as user3@jana3.com. Send the reply to the
Domino *SMTP user.

For a brief discussion about using as26.itsoroch.ibm.com, itsoroch.ibm.com, or

other names like these for the AnyMail Integration (*MSF) SMTP domain, see
4.7.1, “MTAGIobal Global Domain document” on page 32.
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Chapter 6. Server topics

This chapter discusses topics related to servers. For basic information about
setting up a Domino server, see Lotus Domino for AS/400 R5: Implementation,
SG24-5592. Many of the concepts described here have been defined and
discussed in Request for Comments (RFCs) that you can access at:
http://www.rfc-editor.org/rfc.html

You can also go directly to an RFC by using the address:
http://info.internet.isi.edu/in-notes/rfc/files/rfennmn. txt

Here, substitute the document number for nnnn.

6.1 SMTP

© Copyright IBM Corp. 2000

Simple Mail Transfer Protocol (SMTP) is a TCP/IP protocol used in sending and
receiving e-mail. Since it's limited in its ability to queue messages at the receiving
end, it's usually used with one of two other protocols, POP3 or IMAP, that let the
user save messages in a server mailbox and download them periodically from the
server. SMTP is defined in a number of RFCs, in particular RFC 822 and RFC
1123.

SMTP consists of a sequence of commands. Here is an example of a
conversation that an SMTP client has with an SMTP server. If you duplicate this
conversation with a Domino or iSeries server with SMTP enabled, and you use a
valid address for the recipient, the data you enter will be delivered.

— Note

If you follow the commands as they are entered below on your own system,
you need to enter the commands without typing errors. We could not find a way
to successfully erase characters. If you are using an MS-DOS window, select
Terminal->Preferences, and ensure that Local Echo is turned on.

In the following example, the bold text indicates what is entered by the user.

telnet dammaill 25

220 dommaill.janal.com ESMIP Service (Lotus Domino Release 5.0.4) ready at Fri,
25 Aug 2000 08:29:03 -0500

helo justine middleton

250 dommaill.janal.com Hello justine middleton ([10.3.31.241]), pleased to meet
you

mail from: jmiddle@test.com

250 jmiddle@test.com... Sender OK

rcpt to:adminl@janal.com

250 adminl@janal.com... Recipient OK

data

354 Enter message, end with "." on a line by itself

How Now Brown Cow

I will sign off now

250 Message accepted for delivery

quit
221 dommaill.janal.com SMTP Service closing transmission channel
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Each of the numbers at the beginning of the reply indicates the status of the
previous command. For example, 250 indicates that the command was accepted,
and 354 indicates the start of mail input. The first digit of the code is an indication
of the nature of the reply:

* 1 = Positive preliminary reply

» 2 = Positive completion reply

3 = Positive intermediate reply

* 4 = Transient negative completion reply

* 5 = Permanent negative completion reply

Here is a similar dialog to an OS/400 SMTP server:

220 AS26.ITSOROCH.IBM.COM running IBM OS/400 SMTP V04R04M0O on Fri, 25 Aug 2000
12:36:35 -0600.

helo justine

250 AS26.ITSOROCH.IBM.COM.

mail from:<jmiddle@test.com>

250 OK.

rcpt to:<auser@itsoroch.com>

250 OK.

data

354 Enter mail body. End mail with a '.' in column 1 on a line by itself.
Here is my message to you.

Please read it carefully.

250 OK.

You can see slight differences between the two dialogs. The iSeries server
requires you to enclose values in angle brackets (<>). These are optional when
using SMTP to a Domino server.

To initiate a similar conversation from an iSeries display, use the PORT
parameter as follows:

TELNET RMTSYS (DOMMAIL1) PORT(25) .

There is more information about using SMTP in Chapter 9, “Troubleshooting
e-mail delivery” on page 97.

The previous dialog was entered from an MS-DOS window. You can also do this
from an iSeries display. If you don’t receive a positive response by typing helo, try
ehlo, the extended SMTP command.

Domino R5 also supports extensions to SMTP (ESMTP). These include
functions, such as the ability to use ETRN to request mail delivery from an ISP
and the ability to pipeline. Pipeline means that client SMTP may elect to transmit
groups of SMTP commands in batches without waiting for a response to each
individual command. Refer to RFC 1869 and RFC 1854 for information about
ESMTP and Command Pipelining. We cover ETRN in more detail in 6.6,
“Extended Turn (ETRN)” on page 64. You can see from the first line of each of the
previous SMTP dialogs that Domino supports ESMTP, and the OS/400 SMTP
does not.

Some standard Domino SMTP functions and the extensions are enabled by
editing the Configuration document (Router/SMTP->Advanced) as shown in
Figure 51. The changed values will be effective automatically after a period of
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time, but we were not able to determine what this is. You can also stop and restart
SMTP to ensure that the changes take effect.

2 Administiaion | _] Configuration for DOMMAIL14ECT X ad

'FE! Save and Close
CONFIGURATION SETTINGS: DOM'_!}M!'[ BC

0010010

Basics l Fouter/SMTP l MIME l MOTES.INI Settings l Adminiztration }

Baszics l Restrictions and Contrals l Meszage Tracking l Advanced l

Commands and Extensions l Controls l

SIZE extension: " Enabled ;=] SIZE extension: " Enabled ;=]
Piplining extension: " Enabled ;=1 Pipelining extension: " Enabled ;=1
DSN extension: T Disabled =] DSN extension: T Disabled =]
8 bit MIME extension: T Disabled =] 8 bit MIME extension: T Disabled =]
HELP command: T Enabled ;=]

WVRFY command: T Disabled =]

EXPN command: T Disabled =]

ETRM command: T Enabled ;=]

SSL negotiated over T Disabled =]

TCPIIP port:

Figure 51. SMTP commands and extensions

When an SMTP client contacts an SMTP server, the client can indicate that it
supports ESMTP by issuing the EHLO command rather than the HELO
command. The server then responds with the particular extensions it supports so
that the client knows what options it has to use. This is shown in the following
dialog:

220 dommaill.janal.com ESMIP Service (Lotus Domino Release 5.0.4) ready at Fri,
25 Aug 2000 11:03:31 -0500

ehlo justine

250-dommaill.janal.com Hello justine ([9.10.62.241]), pleased to meet you
250-HELP

250-VRFY

250-EXPN

250-ETRN

250-STIZE

250 PIPELINING

vrfy adminl

250 "Adminl/abcl" <adminl@janal.com>

vrfy smith

553-Ambiguous; Possibilities are

553-"Tom Smith/abcl" <TomSmithe@itsoroch.ibm.com>

553-"John Smith/abcl" <JohnSmith@janal.com>

553 "Ann Smith/abcl" <AnnSmitheitsoroch.ibm.com>

expn accounting

250-"Tom Smith/abcl" <TomSmithe@itsoroch.ibm.com>

250 "Jane Ldap/abcl" <Janeldap@janal.com>

You can see that the services the server supports are listed and include ETRN
and pipelining. We then issue a Verify (VRFY) command for a user name
(admin1) to which the server responds with the identified mailbox. If we request
an ambiguous user (smith), the server responds with the possibilities. Expand
(EXPN) expands mailing lists, which for Domino is a group. Accounting is a
Person group specified in the Domino Directory.

Chapter 6. Server topics 57



6.1.1 Domino SMTP

To start SMTP on a Domino server, at the Domino console, type:

LOAD SMTP

In most cases, SMTP on a Domino server will start automatically with the server
as discussed in 4.1, “Server document” on page 21.

To end SMTP on a Domino server, at the Domino console, type:

TELL SMTP QUIT

You should be aware that the Domino router is “SMTP aware”. SMTP mail will

continue to be sent out even if SMTP is ended, although inbound SMTP mail
won’t be delivered.

6.1.2 OS/400 SMTP

Use the Start TCP/IP Server (STRTCPSVR) command to start SMTP on the
iSeries server. On any command line, type:

STRTCPSVR *SMTP
SMTP can be initiated automatically when the iSeries server is IPLed by using
the Change SMTP Attributes (CHGSMPTA) command and entering:

CHGSMTPA AUTOSTART (*YES)

You can also change this setting by using Operations Navigator. Select
Network->TCP/IP. Then right-click SMTP, and select Properties.

On the iSeries server, SMTP is implemented as four batch jobs and a minimum of
two prestart jobs. The batch jobs that you see when you enter the WRKACTJOB
SBS(QSYSWRK) command are:

* QTSMTPBRCL (SMTP bridge client)

* QTSMTPBRSR (SMTP bridge server)
* QTSMTPCLTD (SMTP client daemon)
* QTSMTPSRVD (SMTP server daemon)

There are also at least two prestart jobs: QTSMTPSRVP and QTSMTPCLTP. To
see all jobs, including the prestart jobs, press F14.

To end SMTP on the iSeries server, use the End TCP/IP Server (ENDTCPSVR)
command. On any command line, type:

ENDTCPSVR *SMTP

6.2 POP3

The POPS3 server is a simple store-and-forward mail system and is defined in
RFC 1725.

Post Office Protocol 3 (POP3) is the most recent version of a standard protocol
for receiving e-mail. POP3 is a client/server protocol in which e-mail is received
and held for you by your Internet server. Periodically, you (or your client e-mail
receiver) check your mailbox on the server and download any mail.
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POPS, as well as IMAP, deal with receiving e-mail and is not to be confused with
the Simple Mail Transfer Protocol (SMTP), a protocol for transferring e-mail
across the Internet. You send e-mail with SMTP, and a mail handler receives it on
your recipient's behalf. Then the mail is read using POP (or IMAP).

Users with POP3 clients, such as Eudora, Netscape, or Outlook Express, can use
the POP3 protocol to read and manage mail, use SMTP to send mail, and use
LDAP to access the Domino Directory. POP3 users can download their Lotus
Notes mail to a local mail file and interact with it there. They can also leave a
copy of their mail on the Domino server, but they cannot interact with their mail
file on the server. POP3 users must authenticate with the Domino server before
they can access their mail files. The Domino server supports basic
name-and-password authentication, Secure Sockets Layer (SSL) authentication,
and SSL encryption.

Both iSeries and Domino can be POP3 servers. However, since, by default,
POPS3 servers both listen on Port 110, only one can be active at any one time.

The following dialogs show the results of using Telnet to Port 110 of the Domino
POP3 server and the iSeries POP3 server from an MS-DOS Window. In reality,
you would use the Telnet command to check that a POP3 server is listening at the
address you are using, and that the server that is listening is the one you expect
to be listening. The user and pass commands let you check the validity of the
user and password you are using. Refer to RFC 1725 for additional commands
you can use to view messages.

Domino

+OK Lotus Notes POP3 server version X2.0 ready on dommaill/abcl.
user puserl

+OK puserl, your papers please.

pass lotus

+OK puserl has 0 messages.

iSeries

+0OK POP3 server ready
user labxx

+0OK POP3 server ready
pass lab4us

+OK start sending message

Information about configuring POPS3 clients can be found in Chapter 8, “Client
topics” on page 81.

6.2.1 Domino POP3

On the Domino server, mail databases are used for POP3 mailboxes. Mail can be
accessed by a POP3 client or by a Notes client. However a POPS3 client may be
set up to download mail from the server, so that it can no longer be accessed by a
Notes client, once it has been downloaded.

To start a POP3 server on a Domino server, at the Domino console type:

load pop3

An additional task is now active on the Domino server. If you want this server to
be started each time the Domino server is started, you should add POP3 in the
server tasks line of the NOTES.INI file.
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To end a POP3 server on a Domino server, at the console type:

tell pop3 quit

6.2.2 iSeries POP3

POP3 on the iSeries server provides electronic mailboxes on iSeries from which
clients can retrieve mail. It uses the AnyMail/400 mail server framework and the
system distribution directory to process and distribute e-mail. It uses SMTP to
forward mail.

You will find the mailboxes in the integrated file system under /QTCPTMM/MAIL.
A mailbox will be created for a user the first time they receive POP3 mail. Unless
the mail is secured by encryption, you can read the mail in the mailbox if you
have access to the directory.

To start a POPS3 server on the iSeries server, on any command line, type:
strtcpsvr *pop

If you look at the jobs in QSYSWRK, you will see several jobs with names such
as QTPOP00052. These are the POP3 servers. The number of servers that are
initially started can be defined by using the Change POP Attribute (CHGPOPA)
command. You can also use this command to specify that you want POP3 to start
when TCP/IP starts on the iSeries server.

To end a POP3 server on the iSeries server, on any command line, type:

endtcpsvr *pop

6.3 IMAP

Internet Message Access Protocol (IMAP) is a standard protocol for accessing
e-mail from your local server. IMAP (the latest version is IMAP4) is a client/server
protocol in which e-mail is received and held for you by your Internet server. You
(or rather your e-mail client) can view just the headers of the mail item and then
decide whether to download the mail. You can also create and manipulate folders
or mail boxes on the server, delete messages, or search for certain parts or an
entire note.

Similar to POP, IMAP deals only with receiving e-mail from your local server. You
send e-mail with SMTP and a mail handler receives it on your recipient's behalf.
Then the mail is read using IMAP (or POP).

R5 IMAP supports two environments: offline and online. When you create an
IMAP account with Notes R5, you will see both options. Offline is similar to
replication based Notes mail in that you periodically query the server to download
new mail and send outgoing mail. In this situation, you must define an account for
receiving your mail. This defines the server, authentication, local mail file, and
any secure sockets implementation for extra security. To send mail, you must also
define an SMTP account, which can be Domino R5 or OS/400 SMTP support.
You can choose if you want to download them to your Notes mail database or to
replicate them to a separate Notes database. To actually send and receive
“Internet mail”, use Notes replication. This is similar to standard Notes mail via
replication, because you can access your mail in disconnected mode via a local
mail or database file.
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R5 also supports IMAP in what is termed online mode, which is similar to Notes
mail in a live, non-replicated environment. For receiving mail, replication is not
used to download your mail to a local file. Instead, a local proxy is used that
downloads the message headers from the server when you connect. Then
choose which messages to read, and they are downloaded as well. The proxy
database only stores them temporarily. Notes deletes them when you terminate
the session with the IMAP server. To actually send mail, it is essentially the same
as the offline mode. You define an SMTP account to your Domino R5 or iSeries
server and use replication to actually send Internet mail.

The Notes R5 client can support multiple mailboxes simultaneously: Notes mail
from Domino, POP3 mail from Internet portal sites, IMAP mail from common
support or help desk applications, and so on. You essentially can set up one or
more accounts to represent these e-mail infrastructures and use a Notes R5
client to integrate it all into one environment. It is important to note that multiple
accounts pertain to inbound mail. For outbound mail, the premise is one
account—your standard mail represented by userid @ smtpserver. We describe
examples of this set up in 8.3, “POPS3 client: Notes” on page 88.

Defining an environment for an IMAP user is similar to defining one for POP3,
with one exception. You need to enable the mail file for IMAP access by running a
convert utility on the mail file. Refer to Administering the Domino System
(help\help5_admin.nsf) for more information.

6.4 MIME

Multi-Purpose Internet Mail Extensions (MIME) is an extension of the original
Internet e-mail protocol (SMTP). It lets people use SMTP to exchange different
kinds of data files on the Internet, such as audio, video, images, application
programs, other kinds of data and, of course, ASCII (which is the only kind of
data supported by the “original” SMTP).

In 1991, the proposal was made that SMTP be extended so that Internet (but
mainly Web) clients and servers could recognize and handle data other than
ASCII text. As a result, new file types were added to “mail” as supported Internet
Protocol file types.

Servers insert the MIME header at the beginning of any Web transmission.
Clients use this header to select an appropriate “player” application for the type of
data the header indicates. Some of these players are built into the Web client or
browser. For example, all browsers come with GIF and JPEG image players as
well as the ability to handle HTML files. Other players may need to be
downloaded.

Base64 is an algorithm that forms part of the MIME protocol. It is a mechanism
that turns any bit stream into printable ASCII characters. It is described in

RFC 1521. The objective of Base64 is not to mask data, but to provide a method
to send binary data through a mail gateway that can only handle character data.

MIME is specified in detail in Internet RFCs 1521 (Update: RFC 2045) and 1522
(Update: RFC 2046), which amend the original mail protocol specification, RFC
821 (the Simple Mail Transport Protocol) and the ASCII messaging header, RFC
822.
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6.5 Multiple MAIL.BOX databases

62

Each Domino mail server uses a MAIL.BOX database to hold messages that are
in transit. Users and servers use both SMTP and Notes protocols to deposit
messages into MAIL.BOX. The router on the server reads the messages and
either delivers them to a mail file on that server or transfers them to the
MAIL.BOX database on another server.

In previous releases of Domino, the router used only a single MAIL.BOX
database. In Release 5, you can continue to use a single MAIL.BOX database or
improve performance significantly by creating multiple MAIL.BOX databases.
Under a heavy load, several server threads may try to deposit mail into
MAIL.BOX, while the router attempts to read and update mail. Any process trying
to write to MAIL.BOX (including the server threads and router) needs exclusive
access to the database. In addition, when the router reads new messages from
MAIL.BOX, other processes trying to write to the database must wait. Long wait
times occur when there is a large amount of new mail, such as on a busy system
with heavy mail traffic.

Using multiple MAIL.BOX databases, Domino uses multiple concurrent
processes. While reading one MAIL.BOX, the router marks the database “in use”
so other server threads trying to deposit mail move to the next MAIL.BOX. This
improves performance.

Platform independent documentation may suggest spreading user mail files
across multiple disks to ensure that all mail files and MAIL.BOX databases are
not on the same disk. This does not apply to the iSeries server that handles disk
allocation and spread automatically.

If you add only one additional MAIL.BOX database, you see large performance
improvements. You gain additional benefits with each additional MAIL.BOX
database, although the marginal benefits decrease with each additional mailbox.

Note: You specify the number of MAIL.BOX databases in the Configuration
Settings document. If you use the same Configuration document for multiple
servers, Domino creates the number of mailboxes (MAIL.BOX databases) you set
in that document on each server using that document.

To create multiple MAIL.BOX databases, edit the Configuration document
(Router/SMTP->Basic) as shown in Figure 52. Then, enter the number of
mailboxes you need.
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2 dministialion | _] Configuration for DOMMAIL14ECT X

'FE! Save and Close

CONFIGURATION SETTINGS: DOMMAIL1/ABC1

Basics | Router/SMTP | MIME | NOTES.INI Setiings | Admiristation |

Basics l Restrictions and Controls l

Meszage Tracking l Advanced l

MNumber of mailboxes: e,

SMTP used when sending TEnabled | =1
messages outside of the local

internet domain:

SMTP allowed withinthe local " Disabled ;=]
internet domain:

Servers withinthe local Notes " Always /=

domain are reachable via SMTP
over TCPIP:

Address lookup:

T Fullname then Local Part =]

Exhaustive lookup:

T Disabled =]

Relay host for messages leaving
the local internet domain:

T

Lecal Internet domain smart host:

"

Smart host is used for all local
internet domain recipients:

T Disabled =]

Host name lookup:

" Dynamic then local 4 =]

o 1001

Figure 52. Multiple MAIL.BOX databases

Once you close and save the document and restart the server, you will find
additional files. In our case, the original mail.box was called MAIL.BOX, and there
are now two additional files called MAIL1.BOX and MAIL2.BOX. MAIL.BOX is no

If you manually open MAIL.BOX from a Notes client with File->Database Open

onger used.

(or press Ctrl+0), you will find that you alternately open MAIL1.BOX and

MAIL2.BOX. If you go to the Mail tab under Messaging, you will see a display
similar to the example in Figure 53 where you can see two routing mailboxes
listed on the left side of the display.

Fg‘ Administration - Domino Administrator

File  Edit Administration Mail Help

g Adminizgtration ﬂ ‘Welcome to Domina Administrator RS administrator
@ People & Groups I Filez I Server I Messaging I Fieplication I Configuration
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v @ Flouting Mailboxes g
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& dormaill Mailbox (mail2.box © 0%0408:20AM  "Client ONESMTP" <aspopu@its  aspopu@ITSOROGH.IBM.OOM Route Mail...
Pop Pop
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Figure 53. Routing mailboxes
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6.6 Extended Turn (ETRN)

64

The iSeries server, since V4R3, has supported Dial-on-Demand. This means that,
if an application requires communication between two hosts, and the
configuration has been defined appropriately, the server will initiate dial-up to the
second server.

Domino supports a similar concept of using Connection documents and the X.PC
protocol or Remote LAN Services to enable timed dial-up replication between
servers.

Lotus Domino for AS/400 does not support X.PC and is unable to take advantage
of the iSeries support for Dial-on-Demand. For timed replication between dial-up
services, another method needs to be used to initiate the dial-up prior to the
scheduled replication. This way, when the replication time is reached, the servers
are considered to be LAN connected, and the replication can take place. Some
people have found ways around this limitation by using routers that can initiate
the dial-up. An alternative approach is to use a small Windows server sitting
between the iSeries server and the dial-up network that can initiate the
connection.

One particular reason people want this type of support is for dial-up to Internet
Service Providers (ISPs) to send and receive Internet mail on a periodic basis
rather than being permanently connected.

Domino Release 5 supports a standard known as Extended Simple Mail Transfer
Protocol (ESMTP). One of the options in ESMTP is Extended Turn (ETRN). This
means that, if a server can connect to an ISP, an ETRN smtpdomain command can

be issued. This command requests that all mail being held for that SMTP domain
be released.

Lotus Domino for AS/400 supports ETRN. However, as we have mentioned, there
is no support for the use of Dial-on-Demand from the iSeries server.

If you want to see how this command works, you can simulate the environment by
following this process:

1. Set up two SMTP servers in different domains. In our example, we used an
AS/400e server with SMTP support as a POP3 server and a Lotus Domino for
AS/400 server. Ensure that your DNS and servers are set up so that users on
both systems can exchange SMTP mail.

2. Edit the Configuration document for the server simulating the ISP (the Domino
server in our case). Ensure that ETRN is enabled as shown in Figure 51 on
page 57.

3. Stop SMTP on the iSeries server by using the ExpTcpsvr *smre command. If
you are doing this with a Domino server, you have to stop the mail router
because the router is SMTP aware. SMTP mail will continue to flow even if the
SMTP task is stopped.

4. Send mail from the Domino server. Look at the Domino console, and you will
see that the mail is not sent because the other SMTP server is not responding.
The mail is held, and the connection will be tried again later.

5. Start SMTP on the iSeries server by using the sTrRTcPsVR *smMTP command. The
mail won’t be sent yet. That’s because the elapsed time has not been reached
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that is required before the SMTP client on the Domino server will try to resend
the mail.

6. From an MS-DOS window or from an iSeries display, connect to the server
that is pretending to be the ISP by typing telnet dommaill 25 Or telnet dommaill
port (25) if it is an iSeries display. Our Domino server is dommaili.

7. If you are using an MS-DOS window, select Terminal->Preferences. Ensure
that Local Echo is turned on. Type helo yourname. You will see the services
supported by the Domino server

8. Type etrn itsoroch.ibm.com. ITSOROCH.IBM.COM is the iSeries SMTP
domain. You will see a message that mail for that domain has been initiated
and the mail will be delivered. You can check the subdirectory in
/qtcptmm/mail for your user to see that the mail has now been delivered.

6.7 Transaction logging

Starting in Domino R5, Domino supports transaction logging to improve recovery
times. Transaction logging is configured by editing the Server document and
selecting the Transactional logging tab (Figure 54).

Fg‘ Server: dommaill /abc1 - Domino Administrator

File Edit Wiew Create Actions Test Help 4

g Adminiztration 4 ‘Welcome bo Doming Administrator RS | _] Server dommaill /abcl ﬂ
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SERVER: dommaili/abet

o0 100]
A 3 o 10101
i ) 10 B

L;gging l Adminiztration r: m

=

Basicsl Securityl Portsl ServerTasksl Internet Protocolsl MTAS] Miscellaneous | Tranzactional

Transactional logging: " Enabled ;=]

Log path: T justine 4

Use all available spaceon () ves @ Mo
log device:

Maximum log space: 3004 MB
Automatic fixup of corrupt  * Enabled 4 =]
databases:

Runtime/Restart T Stardard ;=]
performance:

Logging style: T Circular 5=

Figure 54. Transaction logging

On other platforms, published articles suggest that you place the transaction log
on a different disk arm to improve performance. This is not necessary for the
iSeries server, which automatically distributes data across arms to optimize
performance.

The size of the transaction log defaults to 192 MB in a subdirectory LOGDIR of
your data directory.

Transaction logging keeps a sequential record of every operation that occurs to
data. If a database becomes corrupted, you can “roll back” the database to a
point before it was corrupted and replay the changes from the transaction log. A
single transaction is a series of changes made to a database on a server. For
example, a transaction may include opening a new document, adding text, and
saving the document.
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In most situations, you no longer need to run the Fixup task to recover databases
following a system failure. Excluding Fixup results in quicker server restarts.
Fixup must check every document in each database, while transaction log
recovery applies or undoes only those transactions not written to disk at the time
of the system failure.

A transaction log is a binary file where transactions are written. The transactional
log has a .TXN file extension. These .TXN files should never be deleted. The
maximum size of each log extent (.TXN file) is 64 MB. You can have several .TXN
logs based on the size specified in the Server document. The maximum total of
.TXN files is 4 GB. In our example, where we specified a log file of 300 MB, the
following stream files were found in the directory after the server was restarted:

nlogctrl.lfh
S0000000.TXN
S0000001.TXN
S0000002.TXN
S0000003.TXN

This is a control file and four transaction log files. A new task LOGASIO is also
running in the Domino subsystem.

Once transaction logging is set up, on a normal start of the system, you see the
following information in the Domino console:

Lotus Domino (r) Server, Release 5.0.4, June 8, 2000
Lotus Domino (r) Server, 5.0.4a, 07/24/2000
Copyright (c) 1985-2000, Lotus Development Corporation, All Rights Reserved

Restart Analysis (0 MB): 100%
09/02/2000 11:34:38 AM Recovery Manager: Restart Recovery complete. (0/0
databases needed full/partial recovery)

After an abnormal termination of the server, messages were seen in the Domino
console upon restart as follows:

Restart Analysis (2 MB): 10% 20% 40% 70% 80% 90% 100%

Recovery Manager: Recovery being performed for DB /domino/dommaill/log.nsf
Recovery Manager: Recovery being performed for DB /domino/dommaill/names.nsf
Recovery Manager: Recovery being performed for DB /domino/dommaill/maill.box
Recovery Manager: Recovery being performed for DB /domino/dommaill/mail2.box
Recovery Manager: Recovery being performed for DB /domino/dommaill/billing.nsf

Restart Replay (2 MB): 10% 30% 40% 70% 80% 90% 100%
08/28/2000 10:18:07 PM Recovery Manager: Restart Recovery complete. (22/0
databases needed full/partial recovery)

6.8 Advanced configuration options

66

We’ve discussed basic Domino SMTP mail configuration. Certain options in the
Configuration document let you exercise even more control over Internet mail.
For example, you can specify restrictions on inbound and outbound SMTP mail,
such as restricting mail being sent to and from particular domains and the
maximum size of inbound and outbound messages.
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SMTP, as defined in RFC 821 and associated MIME content RFCs, is quite open
and flexible. It can also be a potential security and management problem, for
example:

* “Spammers” using your SMTP server as a relay for sending junk mail that
appears to come from a reputable source. You don’t want your server to be an
open SMTP relay that can be used by anyone for mail relay.

* Large or frequent e-mails sent from unauthorized sources bogging down the
server or consuming other resources.

* Someone masquerading as a trusted or anonymous user.

This section shows how you define settings that may keep the Domino SMTP
server from being a playground for hackers and spammers. We set up the
following scenario on one iSeries server using the bind to specific IP address
support. It may be a more realistic demonstration if we set this up on two iSeries
servers or one iSeries server and another POP3 server, but we wanted to make it
simple for you to duplicate.

Our iSeries AS26 has two Domino servers, dommaill and dommail3. Both use
Domino SMTP. The full TCP/IP name of one server is dommail1.janal.com, and
the name of the other server is dommail3.jana3.com. Sample users on the
servers are user1 @janal.com and user3@jana3.com. Each server is in its own
Domino domain.

The iSeries server supports a POP3 user using OS/400 SMTP.

Follow this process to define some controls:

1. From the Domino Administrator, connect to dommail1, and select the
Configuration document. Remember that this is the Configuration document,
not the Configuration tab.

2. Select the Router/SMTP tab and then the Restrictions and Controls subtab.
Click the SMTP Inbound Controls tab. Enter the values as shown in Figure
55 on page 68.
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Figure 55. Inbound SMTP controls

In Figure 55, a.b.c.d represents the IP address of dommail3.

We use the inbound relay controls to prevent other hosts (including POP3 or
IMAP clients, other servers, etc.) from using our SMTP server to send mail. In this
example, we only allow users on the other Domino server (dommail3/abc3) to use
our SMTP server as a relay for sending intranet/Internet mail. We do not want
POPS clients, for example, indiscriminately sending mail directly to the Internet.

We added further protection with the inbound connection controls. In this
example, we only accept mail from the other Domino server. Again, we do not
want to receive mail from unauthorized hosts, only from the trusted server in this
example. Note that IP addresses can be specified here if you place them inside
square brackets.

In most of our examples, all SMTP mail has been Domino server to Domino
server. Generally, Notes clients go through the Domino server as opposed to
using their own SMTP outbound mailer. The inbound relay and connection
controls are based on the host machine making the request independently of any
actual e-mail addresses. Now, let’s further refine our filtering to focus on mail
from legitimate SMTP addresses.
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In our situation, we only want to receive Internet mail from users with a valid
e-mail address on the second Domino server. We do not want to allow mail from
other hosts, nor do we want mail from hosts using dommail1’s SMTP server as a
relay. As an added precaution, we do not want our server to receive mail destined
for the postmaster account. Figure 55 shows how to do this.

We only allow mail from users whose e-mail address is from the second iSeries
server. Note that we included the two SMTP domain names, plus the IP address.
This means that the “mail from:” component of the SMTP datastream must
contain one of these entries. For example, mail from user3ejana3.comis allowed.
Mail from joenoevacationvillage.comis not allowed and will be rejected.

Similarly, the postmaster mailbox is part of SMTP. We do not want outside users
filling up our server with useless information by sending mail to the postmaster
ID. It may not be a good idea to implement this in reality because you may need
the postmaster to be notified of events. This gives you an idea of the capabilities.

1. From the POP3 client on the iSeries server, send an e-mail to
postmaster@janal.com. You will eventually receive a non-delivery message.
If you look at the Domino console of the server emaill, you will see
information similar to this example:

09/03/2000 11:29:43 AM SMTP Server: 10.6.9.43 connected

09/03/2000 11:29:43 AM SMTP Server [042868:00737:00006-00000017] Attempt to
relay mail to postmaster@janal.com rejected for policy reasons. Relay to
recipient's address denied by your configuration.

09/03/2000 11:29:43 AM SMTP Server: 10.6.92.43 disconnected. 0 message[s]
received

2. Change the outbound SMTP server on your POP3 client to that of the
dommaili/abc1 Domino server running SMTP (select
Edit->Preferences)—dommail1.janal.com. Essentially, you are using AS26
as your mail repository but are sending your mail from the Domino server
dommail1. Send mail to user1 @janal.com. You receive a return message
similar to the example shown in Figure 56.

Metscape E

An error occurred while zending mail.
The mail server responded:
Mail from aspopcli@itzoroch.ibm.com rejected for policy reasons.

Flease verify that your email address iz conrect
in your Mail preferences and try again.

Figure 56. Not allowed to send mail through dommail1

The server console or mail routing log will show information similar to this
example:

09/03/2000 11:38:15 AM SMTP Server [042868:00737:00006-00000017] Connection
from [10.6.52.87] rejected for policy reasons. Connecting host is denied in
your configuration.

09/03/2000 11:38:15 AM SMTP Server: 10.6.52.87 connected

09/03/2000 11:38:15 AM SMTP Server: 10.6.52.87 disconnected. 0 message[s]
received

3. Change the outbound SMTP server on your POP3 client back to the outbound
server of the iSeries server (select Edit->Preferences).
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6.9 Secure mail

Domino has historically used its own digital certificate support for Notes client
and Domino server authentication tasks. The Domino server has seen its X.509
digital certificate support expand from SSL 2 for the HTTP server in R4.5x,
through SSL 3 and Internet protocols (LDAP, IMAP and so on) to now enabling it
to be a Certificate Authority for Notes R5 and browser users. Secure mail
exchange using Secure MIME (S/MIME) is supported between Notes and
non-Notes users. Secure HTTP, IMAP, LDAP, SMTP, NNTP, IIOP, and POP3 over
SSL is also supported.

Notes user IDs can have Internet X.509 digital certificates added to them. You
can examine your certificates by selecting File->Tools->User ID from the Notes
client.

It is beyond the scope of this redbook to discuss this topic further. You can find
more information in Lotus Notes and Domino R5.0 Security Infrastructure
Revealed, SG24-5341. Although this referenced redbook is not written
specifically for Domino for AS/400, the information is relevant.
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Chapter 7. User registration and setup

This chapter discusses topics related to defining users. For information about
setting up a Domino server, see Lotus Domino for AS/400 R5: Implementation,

SG24-5592.

7.1 Registering Notes users
To register Notes users, complete these steps:

1. Click the Administrator icon (Figure 57). If this is the first time you have used
the Administrator, it will take a short while to initialize.

¢ Welcome - Lotus Notes
File Edit ¥iew Create Actions Text Help

W}Zo}?_
Mail
\ '\|£'_"| MNew Memo
E@) Dormino Administrator
@ Calendar
l |£'_'| Mesw Enitry

Figure 57. Domino Administrator icon
2. Press Esc to exit the Welcome flash (or click the check box next to the
Welcome to Domino Administrator R5 open task to close it).

3. If you have several servers, select File->Open Server from the pull-down
menu, and select the appropriate one.

4. Click the People & Groups tab in the Tasks pane. Click People in the Tasks
view. Your display should look like the example in Figure 58 on page 72.
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Figure 58. Register user
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Select the People view (it may already be selected), and open the People

tools from the Tools pane. Click Register...

. You are prompted for the password for the last cert.id used. If you are working

with multiple Domino domains, and this is the incorrect cert.id, click Cancel.
Then you can select the correct cert.id. Type the password for the cert.id.

If you receive a message about recovery of IDs, click No. This relates to
setting up the ability to recover ID files and passwords. You see a display

similar to the example in Figure 59 on page 74.



—— Note

Before users can recover their ID files, set up a centralized mail or mail-in
database to store encrypted backups of ID files. Specify information about
which administrators are allowed to recover IDs and how many have to
authorize the recovery. Designate several administrators who will act as a
group to recover IDs and passwords. Although you can designate a single
administrator to manage ID and password recovery, you should require that
at least three administrators work together to recover ID files.

Users must accept the recovery information into their ID file, or the ID file
must be created with a certifier ID that contains recovery information. After
accepting the recovery information or registering a new user, Notes
automatically mails an encrypted backup copy of the ID files to a designated
centralized database. ID files that do not contain recovery information
cannot be recovered.

Domino stores ID recovery information in the certifier ID file. The
information stored includes the names of administrators who are allowed to
recover IDs, the address of the mail or mail-in database where users send
an encrypted backup copy of their ID files, and the number of administrators
required to unlock an ID file. The mail or mail-in database contains
documents that store attachments of the encrypted backup ID files. These
files are encrypted using a random key and cannot be used with Notes until
they are recovered. For more information, see the Lotus book Domino
Release 5: Administering the Domino System (also available as the online
Administration Help database help\help5_admin.nsf).

An encrypted backup copy of the ID file is required to recover a lost or
corrupted ID file. Recovering an ID file for which the password has been
forgotten is a bit easier. If the original ID file contains recovery information,
administrators can recover the ID file, even if an encrypted backup ID file
doesn't exist.
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Figure 59. Register Person dialog box

8. Select the Advanced checkbox if you are going to allow this user to use

Internet mail.

9. Ensure that the registration server is correct.

10.Type the first name and the last name of your user. Type the password for your

user in the Password field. Ensure that you use a password of appropriate
length.

11.Select the Set internet password box if you are going to allow this user Web

access to the Domino server. This will make the Internet password the same
as the Domino password. You can change this in the Person document if you
want.

12.The default Internet Domain you see is taken from your PC TCP/IP settings.

You should type over it if it is not the correct address for your user. Notice that
the Internet address changes as you type the Internet Domain. You can
change the default by selecting File->Preferences->Administration
Preferences from the pull-down menu, and select Registration. The default
format of the Internet address is the first name and last name without a
character in between. Notice that the Format button allows you to change this.

13.Click the Mail button. Ensure that the mail server shown is correct and that

you are using the R5 mail template. The mail system is Lotus Notes. The
preference for incoming mail can be specified here as MIME or Notes Rich
Text. Domino R5 automatically provides mail in the desired format for the user
and, if necessary, converts mail when sending. However you should be aware
that, if you are sending mail between Notes users, you can maintain full Notes
client features, such as twisties, by selecting Note Rich Text. MIME does not
support twisties, so any Notes mail converted to MIME by Internet routing will
no longer display the twisties. The section of the document will be
permanently expanded. The preference can be changed later by editing the
Person document.
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14.Click the Groups button. If you previously defined groups, select the required
group, and click Add to add your user to the group.

15.Click the Add Person button below the first list box. Your user should now be
displayed in the Registration Queue list box at the bottom of the dialog box.
The Registration Queue holds all the users that you have created until you are
ready to register them (see Figure 59).

16.1f you need to make changes to a user that you already created, you can
select them from the Registration queue and select the button (Basics, Malil,
and so on) you need to change.

17.Confirm that your registration server and mail server are correct. When you
are certain that everything is correct, click Register to register the user. A
progress bar pops up and gives you the progress of the registration of users in
the Domino Directory. It usually takes one to three minutes to register a user
on the server. If everything is successful, you see a window indicating that the
user was registered and the log for additional information.

18.1f your registration was not successful, click Options from the Register Person
display. Then select Try to register queued people with error status as
shown in Figure 60. Change the fields in error and reselect to register the
user.

Advanced Person Registration Options EHE

I~ Do not continue on registration erars

I Eeep successfully registered people in the queus
v Iy to register queued people with emor status Eaneel |

[ Allow registration of previously registered people

[~ Dor't prompt for a duplicate person:
| I~
[~ Don't prompt far a duplicate mail file:

| [

Figure 60. Registration options

19.Click Done to close the Register Person window.
20.Refresh the results (F9) to see the new user.
21.Find your user, and edit the entry.

22.Select the Basics tab. Ensure the Internet password field is not blank. Click
the Edit Person Action button to verify that there is encrypted data here.

23.Select the Mail tab, and ensure that the mail system and server are correct.
Note the Internet address and that the preference for incoming mail is not
specified.

24.If you desire, change this preference to Prefers MIME content.

25.Perform the following tasks to detach the user ID file to your workstation, LAN,
or diskette drive:

a. At the bottom of the Basics tab in the person document, you see an ID file
icon. Right-click the icon. Then select Detach. Save it in the desired
location, and click Detach.

b. Click Save and Close.
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Note

You can upgrade your users to a stronger HTTP password format. Select
the Person documents in the Domino Directory. Then select
Actions->Upgrade to More Secure Internet Password Format from the
pull-down menu.

7.2 Registering users from a text file

You can also set up users in a text file and use this information as the basis for
registration. The following example is from a text file that can be used to register
the four users. For information about each field represented by the space
between two semi-colons, see Administering the Domino System or the Help
database (help\help5_admin.nsf).

In the following file, TwoO1 is Last Name, Sue is First Name, password is lotus,
and the Internet address is stwo01 @janal.com.

Two01l;Sue;;;lotus;;;;:::::::stwo0l@janal.com;
Two02;Sue; ; ;lotus;;; ;i1 :Stwo02@janal.com;
Two03;Sue; ; ;lotus;;;;:::::::Stwo03@janal.com;
Two04 ;Sue; ; ;lotus;;; ;i1 :Stwo04@janal.com;

To register users from such a text file, complete the following steps:
1. Open the Domino Administrator. Select the People & Groups tab.

2. From the menu, select People->People->Register from File. Make sure you
use the correct cert.id and registration server.

3. You can make any overriding values you want from the standard Registration
display that you receive. Also, not all person values are available for entry
from the file, for example, any group you want to add the user to and when you
want the mail file created.

7.3 Registering users using a setup profile
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Before registering users, you can create a User Setup Profile to define some
settings that appear by default on user workstations and in Location documents.
The defaults you specify can include Internet and passthru server settings, as
well as a set of specific databases that appear on each user's workspace. User
Setup Profiles make registering users easy and ensure a level of consistency in
user settings. In addition, when you assign settings such as default connections
to remote servers (which creates Connection documents), you make user setup
tasks easier.

When you register users, you associate them with a specific profile so they
receive a specific group of settings. You may want to create multiple profiles in
your organization, each one tailored to a particular group of users. For example,
you can create profiles to use when registering people in the marketing
department or people who work in a particular location.

You can see the User Setup Profiles from the People & Groups tab in the
Domino Administrator as shown in Figure 61.
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Figure 61. User Setup Profiles

Figure 62 shows the display that is used when you create or edit a User Setup
Profile.

_] Setup Profile; Ourprofile
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Figure 62. Defining a User Setup Profile

Select File->Preferences->Administration Preferences from the pull-down
menu. Then select Registration Options to specify the Setup User Profile to be
used for the next users to be registered as shown in Figure 63 on page 78.
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Administration Preferences

BEeqistration Server... | doi

Monitaring 1D File Settings... Pei

Fiegistration domain: I abcl j

Lertifier 1D... | C:\mailidstdommaill eert.id
Mail Options... | Mail spstern:  Lotus Motes

Mail server: dommaill/abc

Ei;'i Mail template:  mail50. ntf

mmaill/abc

rzon [Ds: chlotughnoteshdatahidshpeople

Server [Ds: c:hlotushnoteshdatabidshservers
Certifier [Ds: cihlotushnoteshdatatidshcerts
Internet domain User zetup profile
Iiana‘l .com Ourprofile j

(] 8 I Cancel |

Figure 63. Administration Preferences

You can also specify the SMTP domain to be used by default for new registered
users. The display in Figure 64 for a new user shows the Setup profile (ourprofile)

being used for this user.

Register Person -- Mew Entry

Fiegistration Server, .. |

dommaill/abc

First name Ml Last name Short name
Pazsword
Groups
Mail server dommaill/abc
Mail file namne
Setup profile Ourprofile

Fiegistration status

additional registration zetti

Provide name and pazsword information for the new person. To view or edit

hgs, check the ‘Advanced' checkbox above. ‘

Add person |

Import Text file... | Migrate people... |

Figure 64. New User - User setup profile

Figure 65 shows that the Internet (SMTP) Domain specified in the Administration
Preferences is now the default for the new user. If you don’t specify this value, the

default will be the same
Administrator.
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Register Person -- Mew Entry HE

1D [rf

@-LQP I Iiana‘l .com Format... I

The Internet address [above] iz created uzsing the person's name [above),
Groups the intermet domain and intermet address farmat components. You can alsa

Other Add|persat I Impart Text file... Migrate people... |

Fiegistration Server, .. I dommaill /abcl

First name Ml Last name Short name

/ [ /

Paszswaord Paszword Quality Scale

I Weak '_J— Strong

I~ Setintermet password Acceptable user password (8]

Internet address Internet Domain

edit the internet address directly. [t must be unique in the address book.

Figure 65. New User - Internet domain

7.4 Registering POP3 users

In 6.2, “POP3” on page 58, we describe how to set up each iSeries and Domino
server as a POP3 server. Here we describe how to register a Domino user to be a
POP3 user. For information about defining an iSeries user as a POP3 user, see

5.2.2, “Exchanging mail between Domino and iSeries POPS3 clients” on page 45.

The registration is similar to the process for a Notes client. However, in this case,
you need to select POP to be the Mail system. Follow these steps:

1.
2.

Start the Domino Administrator client if it is not active.

Select the People & Groups tab. Ensure that you are using the correct server
and not Local.

Select the People view (on the left-hand side), and open the People tools
from the Tools pane on the right-hand side of the display. Click Register...

Make sure that, if the prompt for the password for the certifier is for the wrong
domain, you click Cancel, and select the correct certifier.

5. If you receive a message about recovery of IDs, click No.
6. Check the Advanced box.

Enter the user name and password. Change the Internet domain as required,
and enter the Internet address.

Select the Mail button, and POP as the Mail system.

9. Click the Basics button again. Can you see what has happened to the field

Internet password? A POP user uses an Internet password to access their
mail.

10.Select Add Person to add this user to the registration queue, and then click

Register.

11.Note that you can also define a POP user on a Domino server by creating a

Person document, and then manually creating a suitable mail file rather than
registering a Domino user. A strictly POP3 user may not need the ID file that
the registration process creates.
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Note

You can upgrade your users to a stronger HTTP password format. Select
the Person documents in the Domino Directory, and then select Actions->

Upgrade to More Secure Internet Password Format from the pull-down
menu.
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Chapter 8. Client topics

This chapter discusses topics related to client issues. It shows you how to set up
a Notes client for one or more users and how to use it for POP3 mail. It also
describes how to set up Netscape as a POP3 client as an alternative to the
Outlook Express client setup described in 5.2.2, “Exchanging mail between
Domino and iSeries POP3 clients” on page 45.

8.1 Notes client

© Copyright IBM Corp. 2000

For information about setting up an administration client, see Lotus Domino for
AS/400 R5: Implementation, SG24-5592. This section takes you through the
steps to set up a new Notes client. The assumption is that the Notes user, Jane
Doe, has been registered by an administrator and that the ID file has been stored
in the Domino Directory. Follow this process:

1. Start the Lotus Notes client application. When the shown in Figure 66
appears, click Next.

Lotus Motes Client Configuration E

| Setting Up Connections |

Setting up Lotug Motes is easy and only takes a few minutes to
complete the process.

*r'ou will be azked whether pou want to:

* Connect to a Doming server
* Connect to & remote network server

\ *|Jze Motes to receive e-mail messages from an Internet mail
account, such as from an Internet S ervice Provider

t After completing this process, you will be automatically
nﬂ es conhected, depending on your answers. Then vou can begin
uzing Lotus Mates!

- Previous | LCancel

Figure 66. Lotus Notes Client Configuration

2. Select | want to connect to a Domino server as shown in Figure 67.

Lotus Motes Client Configuration E

| Do*vou'want to Connect to a Domino Server? |

Mozt people who uze Lotus Mates connect to a Domino server ta
zend and receive e-mail, view databases, and collabaorate.

& want to connect to a Doming server.

| don't want to connect to a Domino server.

Harn o

=€ Previous | Mext )-l LCancel

Figure 67. Configuration: Connect to Domino server?
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3. Select the desired LAN connection, as shown in Figure 68, and click Next.

Lotus Motes Client Configuration E

| How Do Yiou Want o Connect to a Dioming Server? |

*f'ou can connect directly to a Domino gerver if you are on a local
area network, [L&M], or you can connect by uzing a phone line.

‘with a phone line connection, you can dial a Domino server, or
dial a remote netwaork server ta reach a Domino server.

& et up a connection to a local area network [LAN]E

" Set up a phone connection to a Domin of remote network.,

" Set up both a L&M and phone line connection.
dorn o

=€ Previous | Mext LCancel

Figure 68. Configuration: Type of connection

4. Enter the Domino server name as demonstrated in Figure 69. Click Next.

Lotuz Motes Client Configuration [ %]

Domina Server Mame |

Enter the name of your Domina server. Thiz can be a mail or
passthru server, or some ather server that knows who vou are.

Doming servers usually have names with forward slazhes, but
may alzo include periods.

Dlomina server name
|dommailt /abe

Examples: mailbag/east/acme
mailbag. eazt. com/acme

=€ Previous | Mest )-l LCancel

Figure 69. Configuration: Domino Server Name

5. The next display, shown in Figure 70, prompts for the user name. Enter the
user, Jane Doe, which was previously registered. Click Next.

Lotuz Motes Client Configuration [ %]

Wwho dre You? |

Motes needs ta know who you are. [ you have a disk with your
Uszer ID, then enter the file name below.

If you don't have a User ID, select the second option below
and enter your user name.
" My Notes User D has been supplied to me in a fils.

File name

I Brawse, |

& se my name az jdentification.
Uszer name

IJ ane Dioe

For example: John Smith

=€ Previous | Mext > LCancel

Figure 70. Configuration: Who Are You?

6. Click Next in the following window as shown in Figure 71.
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Lotus Motes Client Configuration

| Connecting to a Domino Server over a LAN

“f'our conhection to & Domino server over a LAN is now
set up.

=€ Previous LCancel |

Figure 71. Configuration: Connection over LAN is set up

7. On the following display shown in Figure 72, select | don’t want to create an
Internet mail account. Then click Next.

Lotus Motes Client Configuration

@ Internet

| Set Up an Internet Mail Account

Mail

*Y'ou can uze Lotuz Motes to send and receive e-mail meszages
from other Intermet accounts that you may have.

For example, if you have mail accounts for home and work., you
can zet up Mates to receive messages for both accounts.

*r'ou will need the name of your SMTP server, POP or IMAP
server, your account name, and password,

Your Internet Service Provider [|SP) can provide you with this
infarmation.

& | don't wartt to create an intemet mail account

| want to create an Internet mail account,

=€ Previous | Mext )-l LCancel

Figure 72. Configuration: Create Internet mail account

8. Select | don’t want to connect to a news server as shown in Figure 73. Click

Next.

Lotus Motes Client Configuration

@ Internet

| Connect to a Mews Server

/‘.rl-i'_,:\\.\\ \

Mews servers are computers maintained by companies, groups,
and individuals, and can host thousands of newsgroups.

A newsgroup iz a collection of messages of unique interest that
are posted to a news server.

“r'our Internet Service Provider must have a news server for you
to zet up an account with that news server in Lotuz Motes,

& don't want to connect to a news server.

(ol want to connect bo a news server.

=€ Previous | Mext LCancel

Figure 73. Configuration: Connect to a news server
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9. Choose | don’t want to connect to another directory server, and click on
Next as Figure 74 shows.

Lotus Motes Client Configuration E

\,g Internet | Connect to an Internet Directary Server |

Diirectory servers et you find people and businesses.

“f'our address book supports the Lightweight Directory Access
Fratocol [LDAP] to access Intermet directory services.

*Y'ou can alzo add an additional directory service provided by pour
Internet Service Provider or spstem administrator,

Buil-in access to directory services include: fourl1 and
bigfoot.

& don't want to connect to another directory server.

D".recmn'.es | want to connect to another directony server.

=€ Previous | Mext LCancel

Figure 74. Configuration: Directory server

10.Select | do not connect to the Internet through a proxy server, as shown in
Figure 75. Then click the Next button.

Lotus Motes Client Configuration E

| Connect through a Prosy Server |

Many corporations use one or more proxy servers to maintain a
firewall between corporate servers and the Internet.

If you have a firewall at your site, you must specify the proxy
server to access Intermet and Doming servers outside the: firewall.

| do connect to the Internet through a prosy server.

ﬂﬂf@ﬁ’ﬂ@f & | da not connect to the Intemet through a proxy server

=€ Previous | Mext )-l LCancel |

Figure 75. Configuration: Connect through a Proxy Server

11.Select Connect over my existing local area network, as shown in Figure 76.
Then, click Next.

Lotus Motes Client Configuration E
= e o .
u i | Internet Connection Type |
[:l U How do you want to connect to the Intermet?
.
'
'

& {Connect over my existing local area network:

' Dial my Intemet Service Provider.

=€ Previous | Mext )-l LCancel |

Figure 76. Configuration: Internet Connection Type
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12.0n the Congratulations display, shown in Figure 77, click Finish.

Lotus Motes Client Configuration E

| Congratulations! |

r'ou have successfully set up Lotus Motes.

A\

Connected!

=€ Previous | Mest )-l

Figure 77. Configuration: Lotus Notes setup complete

13.Enter the password for user Jane Doe as shown in Figure 78. The Lotus Notes
client retrieves the user ID file for Jane Doe from the server dommail1 and
stores it in the Notes data directory on the PC. Click OK.

Enter Pazssword

[ %]
q @ Enter the passward for Jane Doedabe]:
Cancel |
o 8 POOOOROOCOO00ONK|

Figure 78. Enter Password

14.Click OK on the Notes Setup is complete window (Figure 79).

Lotus Motes

@ Motes setup iz completel

Figure 79. Lotus Notes setup complete

The Lotus Notes R5 desktop appears as shown in Figure 80 on page 86.

If the desktop does not appear, move the mouse a little bit. We noticed that
this was sometimes required to “wake up” the desktop when it was being set

up.
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M Welcome - Lotus Notes [_ O[]
File Edit Wiew Cieate Actions Test Help <\ \> O aq @
1) Weloome notes
& pofes e £
I
Fipe
-l / Mail
¥
m § ""ﬂ Mew Memo
: e x 7
&-J @ Mew to MNotes?
Take the tour
// I Calendar
f__ﬂ [ .I\ o " Experienced?
i s A ] MewEnty & .
E‘g —) See what's new in BS
D % \ Address Book @ MNeed ateam. space or instant mestings?
75 A otus Quickplace or Sametime
& 7,0 % Iy Try Lotus Guickpl Sarmet
P o ] NowConiael |
I ("' Feadhy for & change?
i p Try out a new'Welcome page shle.
To Do List
',\ :ﬂ Mew To Do Search INotes Database Catalog ;I for | | Search I
This is the protected text area of the farm
| = 3l ‘| |Dffice |

Figure 80. Lotus Notes desktop

15.Those of you who are unfamiliar with the R5 client may not like the drab color
of the icons in the bookmarks. You can select File->Preferences->User
Preferences. Under Display Options, change Icon color scheme. The
change will take effect the next time the client is started.

Tip
Here are some helpful keystrokes that allow you to select options without
using the mouse:

e From your Welcome display, you can press Alt+B or Alt+W, and you will
see small numbers or letters appear next to the icons on your bookmark
bar or your Task buttons respectively. You can then press the character
that corresponds to the option you require.

* When you are in an option, such as your inbox or calendar, you can
select an action by pressing the Alt key and the corresponding character
that appears next to the option.

16.Since the Lotus Notes setup is complete, close the Notes client.

8.2 Notes client:

86

Additional clients

Depending upon what you are doing, you may want to set up your Notes
workstation to represent, or be used by, more than one person. Each user has
their own mail file and may or may not be on the same server/domain. One way to
do this is with Location documents in your local Names and Address book.

The previous section showed you how to retrieve the ID file from the Domino
Directory. For additional users on the same PC, you cannot do this. When
registering the user, you either have to save the ID file on a diskette at the time of
registration, or detach it from the Person document after registration to a diskette
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or PC or LAN drive. To detach the document, open the Domino Directory from
your Notes client (or use the Domino Administrator, Persons & Groups tab). Then
open the required Person document. If the ID file was saved in the Person
document when the user was registered, you will see the ID file in the document.
Right-click the icon and detach it to the directory or diskette of your choice.

Note that manually detaching the ID file from the Person document does not
remove it from the document. However, setting up a new workstation the way we
showed you in 8.1, “Notes client” on page 81, will remove the ID file from the
Person document.

To create a Location document to represent a user called Don Onexx, perform the
following steps:

1. From your Notes client, select File->Mobile->Locations. Find the Office
(Network) document. Then click Edit->Copy (or press Ctrl+C) and
Edit->Paste (or press Ctrl+V) to create a duplicate. Alternatively, right-click
and use the context menu to perform the copy and paste. If you already
created a Location document for a user that has characteristics similar to the
user you are now setting up, copy that document rather than the Office
(Network) document. You will have to make fewer changes.

2. Edit the duplicate document by selecting it and clicking Edit Location. Select
the Basics tab, and enter a location name of Don to identify the mail user it
will reflect. Also, type Don’s address (donexx@janail.com) in the Internet mail
address field.

3. Click the Servers tab, and ensure the correct mail server (dommail1) is
specified as the home/mail server.

4. Click the Mail tab. Ensure that the file location is on the server and specified
correctly, for example mail\donexx.nsf. Also ensure the mail domain is correct
(abc1). For the Format for messages to Internet recipients, select MIME
content. This is an optional task, but a good recommendation.

5. Click the Ports tab, and check TCP/IP only. This is an optional step, but it is
appropriate with an iSeries server running Domino that only supports TCP/IP.

6. Associate the user.id file with the Location document. This is on the
Advanced tab. Click the flashlight icon to find where you have detached or
copied the ID file for Don Onexx.

7. Save the Don Onexx Location document. Select location Don from the
Location box on the bottom right hand side of your Notes client status bar. You
are then prompted for Don’s password.

8. Select File->Database Open (or press CTL+0). Select the dommail1 server
and the Mail directory. Then open Don Onexx’s mail file. Press Esc to exit the
About Document, and press Esc again to exit the mail database.

9. At this point, you are looking at the default Welcome page. This can be
tailored by selecting another page from the drop-down list or by creating your
own. Tailoring the Welcome page is not part of this redbook, but you may want
to look at this another time.

10.An optional step is to have your Notes client prompt for the location when you
start it. Click File->Preferences->User Preferences from the pull-down
menu. Then, look for and select the Prompt for location check box in the
startup options section. Click OK.
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11.Edit your original Office location document to ensure that your original ID is
associated with it when you switch locations. To do this, select File->Mobile->
Locations, and select to edit the Office Location document. Click the
Advanced tab. Click the flashlight icon, and locate your original ID file.

12.Select your original location from the Location box on the bottom right-hand
side of your Notes client. You are then prompted for the user’s password. Click
Yes if prompted about a Cross Certificate.

13.Select File->Database Open. Select the server for the original user. Select
Mail and then open the mail file. Press Esc twice to exit it.

Note

We recommend that, when you are setting up multiple Location documents
for multiple users, manually open the mail file for each user by selecting
File->Database->Open (or CTL+O). Our experience is that, to use the mail
icons, you need to perform this step.

8.3 POP3 client: Notes

Domino can be a POP3 server. Since R5, a Notes desktop client can also be a
POP3 client.

Assuming that you have already set up a Notes client to a Domino server, we now
assume that you have a POP3 account on a different server. In our example, the
Notes user is user3 on Domino server dommail3.jana3.com running on AS26.
User3 also has a POP3 account on a POPS3 server running on
AS24.ITSOROCH.IBM.COM, where they are known as puser3.

You can set up the Notes client to receive POP3 mail by following this process:

1. Open your local address book (NAMES.NSF). Figure 81 shows you the icon to
click.

™ Welcome - Lotus Notes

File Edit Wiew Create Actions Test Help
@W’elcome

& pofes |

i Address Book .
- @ | Mail
”_ \ '\ﬂ MNew Mema

l Calendar

'\ﬂ Mew Entry

Figure 81. Local Address book

2. Go to the Settings option. You can use the icon highlighted in Figure 82 to do
this, or select View->Advanced->Accounts from the pull-down menu bar.
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Adminl's Addre

Figure 82. Settings icon

3. Create a new account as shown in Figure 83. The Login name is the user ID
on the Account server name of the previous field. The Protocol Configuration
tab gives you the option to save the mail on the server. The Advanced tab
allows you to change the default POP3 port of 110. Do not do this unless you
know your server is listening on a different port.

@ Welcome k_u Adminl's Address Book - Advanced\Accounts | _] Account: POPU ger3d ﬂ

s Save and Close

ACCOUNT POPUser3

Basics l Protocol Configuration l Advanced

Account name: |POPUser3 |
Account server name: |as24.itsoroch.ibn'|.con'| |
Legin name: |puser3 |
Password: | “““ |
Protocol: POP -
SsL: IDisabIad Vl
Only from location(s): vt -

Cat -

Figure 83. New account

4. All your mail from accounts, such as this one, will come into your standard
inbasket. All outbound mail will go via the method you specify in the Send
outgoing mail: field in your Location document. In the example shown in Figure
84 on page 90, all mail will go through the Domino server. The alternative is to
send it directly to the Internet.
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& Save and Close @& Connection Configuration Wizard

LOCATION: user3

Basics l Servers l Parts l I ail l Internet Browser l Replication l Advanced l Adminiztration l N ‘ ’“
Mail file location: "on Server =]
Mail file: T mailiuser3.nsf
Notes mail domain: Tabc3

Internet domain for Notes
addresses when connecting
directly to the Intsrnat:

Recipient name type-ahead * Local then Server ;=i

Activate recipient name " On Each Character ;=1

type-ahead:
Recipient name lookup: " Stop after first match 4=
Send outgeing mail: " through Domino Server =]

Format for messages “MIME Format ;=
addressed to intsrnet
acdresses:

Figure 84. Location

5. Go to your replication settings, and you will see an entry for Internet mail. This
replication retrieves your POP3 user mail.

£® Replicator - Lotus Notes

File Edit Wiew Create Actions Help

g Welcome *_u Admind's Address Book - Advanced\Accounts _] Account: POPU zer3 ﬂ Feplicator %

(| Estr | 52 Serd & Ruceive Mail | Other Actions v | 2, Help |

Start replication at:
Schedule is suspendsd. &I

Send outgeing mail

""" i 0 Sent
A % userd P gf?-; - with dommail3fabc3
Feplicator ‘
Lecal fres time info iy
Receive Internet mail Today with as24.itsorech.ibm.com

S RN e e

Datab | NTF |
atabase templates (NTFs) P

LiPitl. RIS kL

Figure 85. Receiving POP3 mail

6. If you use your existing Location document, all mail you send will be seen as
coming from the Internet mail name that you entered in the Mail tab of your
standard Location document. Instead, you can create another Location
document and enter the Internet mail name associated with your POP3 user.
You can still use your Domino server to relay the mail. Alternatively, you can
create an SMTP account in your Address book Settings and change your
Location document to route the mail through the server you are using for
POPS3.

The same approach can also be used for IMAP clients. You can find more setup
information in the Notes user help database.
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8.4 POP3 client: Netscape Messenger

To set up the POP3 client using Netscape Messenger, follow the steps that are

outlined in this section. In this example, we assume that you are now running the

Domino POPS3 server, not the iSeries server.

Note: Depending on the release of the browser, the options may be slightly
different.

1. Start Netscape Messenger using the desktop icon. As an alternative, use
Netscape Communicator, edit the preferences within Communicator, and
access Messenger using the icon on the bottom of the display (or press
Ctrl+2).

2. Select Edit->Preferences from the pull-down menu. Then select Mail &
Newsgroups. Go to the Identity subset. Enter the following information for
your Domino POP3 account (Figure 86):

* Your name: Pop User1
e Email address: puser1 @janal.com

Lategory:
- Appearance Set your name, email address, and signature file
- Fonts
“ Colars
[#- Mavigator The information below iz needed before you can send mail. If you do
1 Mail & Mewsaroups ot know the information requested, please contact your spstem
- Identity administrator or Internet Service Provider,
- Mail Servers Your name:
- Mewsgroup Servers IPUD Userl
.;ddressmg Email address:
- Messages -
user] @janal.co
- \Window Settings ID @i i
- Copies and Folders Beply-to address(only needed if different from email address]:
- Formatting I
- Return Receipts o
- Disk Space Organization:
[+ Roaming Access I
&l EDWDDSEI Signature File:
- Offline e
- Advanced I LCl |
I Attach my personal card to messages (as a vCard) Edit Card... |

QK I Cancel | Help |

Figure 86. Preferences

3. Select Mail Servers. Enter the following information for your iSeries POP3
account:

Incoming mail server: dommail1.janal.com

Server Type: POP3 (use the Edit button if necessary)

e User Name: Pop User1(or you can use puser1); enable Remember
password.

Outgoing mail (SMTP) server: dommaili.janal.com

The completed Mail Servers properties are shown in Figure 87 on page 92.
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Preferences E

Lategory:
[ Appearance

[#- Mavigator

- Mail & Newsgroups

- |dentity

b4 IS

- Mewsgroup Servers
- Addressing

- Meszages

- \Window Settings
- Copies and Folders
- Formatting

- Return Receipts

- Dizk Space

+|- Fioaming Access

+]- Composzer

- Offline

- Advanced

[N =

Specify servers for mail

~ Incoming Mail Server

dommaill.janal.com Add...

Edit... |
Delete |

et as [efault |

To zet server properties [such as checking for new
messages automatically). select a server and then
click Edit.

— Outgoing Mail Server

Outgoing mail [SMTF) server:  |dommaill janal.com

Outgoing mail server user name:
Usze Secure Socket Layer[S5L]) or TLS for outgoing messages:
& Never " If Possible © Blways

Local mail directory:

Mail Server Properties E
General | POP |

Server Name: | e

Server Type: IF'DF'3 Server j

User Mame: Ipuser‘l

V' Remember password.

™ Check for mail every |1 5 minutes

I~ | Eutornaticallydowninad any newimessages

o]

Cancel Help

IE:\Program FilezMetscapehl)sershdefaultmail LChooze... |
QK I Cancel | Help

Figure 87. Mail servers and Mail server properties

4. Test the setup by sending mail to yourself.

Note: If you are setting up a Netscape client to an iSeries POP3 server, so long
as the DNS will resolve your SMTP domain name, and the SMTP domain is in the
host table of the iSeries server as a local host alias, you can use a different
SMTP domain name for your user from the default iSeries one. For example, if
my DNS sends mail for itsorochex.ibm.com to the mail server
AS26.itsoroch.ibm.com, my user receives mail addressed to

apopuser @itsoroch.ibm.com and apopuser@itsorochex.ibm.com. Depending
upon your setup, this may be useful for hiding your internal domain name
because you can use apopuser@itsorochex.ibm.com in the Netscape settings.
You can have four names for each interface defined on the iSeries server. The
same result is achieved on a Domino server by using Global Domain document
aliases.

8.5 Web mail

92

Domino supports the access of mail and calendar in a Web browser. To do this,
the HTTP task must be running (type 1oad http on the Domino console if it is not),
and your Person document must have an Internet password.

To use Web mail, open your browser, and enter a URL similar to this example:
http://dommaill/mail/adminl .nsf?OpenDatabase

Enter your short name or full name for the user ID and your Internet password for
the password when prompted. Your mail will appear as shown in Figure 88.
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dminl - Hetscape

File Edit “iew Go Communicator Help

. ¢ 8 3 N @ & B @& E
Back Fopward  Reload Home Search  Metzcape Erirat: Security Shop Stop

i wtv Bookmarks Location:Ihttp:.-".-"dommail‘l /mail/admint.nsf?0 pendatabase j @'W’hat's Relate

@ Inbox 3

o Drats ! 2o @ Folder c} Delete

T4 gent

IEE] Address Book
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Figure 88. Web mail

The icons for swapping between Mail, Calendar, and To Do are on the bottom left
of the screen as shown in Figure 89.

& =0 Cpen Ca]ﬂnd?r f"r_a.tmset i

Figure 89. Calendar Icon

itzn. comdmail/stwoxs. naf/CalendarF S ?0 penFrames et

Note that you did not have to modify your mail database design to use a browser
for your mail and calendar as you did in prior releases of Notes.

8.6 iNotes

From Domino Release 5.0.5, Domino for AS/400 provides support for a client
environment known as iNotes.

iNotes delivers the powerful messaging, e-business applications, and mobility of
the Domino server to Web browsers. It extends Domino's scalable, reliable
messaging capabilities to Microsoft Outlook users. iNotes also includes offline
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support for better mobility and a simple deployment model with no-touch
installation.

iNotes lets you standardize your server infrastructure on Domino while giving
your users the flexibility they demand.

iNotes includes:

* Web browser access to Domino servers, including off-line access. This
extends the simple capabilities of Web mail described in 8.5, “Web mail” on
page 92.

¢ Microsoft Outlook access to Domino servers

The Web browser access uses support known as Domino Off-Line Services
(DOLS). Disconnected users can interact with offline Domino applications as if
they were online. The Lotus iNotes Sync Manager runs on your PC to maintain
the offline copies of Domino Web applications. Figure 90 shows you an example
of this. You can see that two applications are being maintained and that they are
on different servers.

% Lotus iNotes Sync Manager M=1E3
File Options Help

S | @ @ o & u
Start Sync  Stop Sone Spnc Detal Properties Open Online Open Offine Enable Dizable Delete

Subscription Title

| Subseription URL

| Size

| Lagt Synchronization Time

| Synchronization Status

1.3MB

&> 09/18/2000 01:20:06 P...

hitp: #flpar2mil ourtour, b, com/...
: 03./15/2000 04:4!

® Idle: Sections:1 - Emors:0 - Docs Rece
. _ Idle: 5 z:1 - Emorz:0 - Docs Rece

mp. haf 1.3ME

1 | >

@ Mest Synchronization: 09418/2000 02:19:58 Pt COT i

Figure 90. Lotus iNotes Sync Manager

A user using Mail offline will see a display like the example in Figure 91. You can
see a button on the left-hand side that allows you to go online.

For more information about iNotes, see: http://www.lotus.com/inotes

Lotus Domino for AS/400 Internet Mail and More



ete Moss - Microsoft Internet Explorer

J File Edit “iew Favortes Toolz Help |

g -2 9 B 4 9 & 3 /& @ 9 B2 9 7

Back Fanyard Stop Fiefrezh Home Search  Favortes  History M ail Size Frint Edit Dizcuzz  Feal.com

| Addhess @] hitp://127.0.0.1:88/5ub_1 /mailpmoss.nsf/MaiF§ 2 penFrameSet =l @Be |J Links >

@ Folder O Delete e Tools

@ mBox Previous Page | Mext Page | Firsi Page | Last Page I—Seled Folder— 'leeanlder Or Copy o Folder
ig Dirafts

L Sert Who « Date ¥  Size v Subject

g] Address Book Il Sandy Beach 08/25/2000 646 Offline DOLS mail memo test

Al Documents [ K5 Page Tumer 08/25/2000 433 Goodjob

@ Trash [~ % Page Turner 027252000 11 Tea

Discussion [ K5 Sandy Beach 08/25/2000 436 Thanks

Bules

[ & Sandy Beach 02/25/2000 832 BookReview
[ K5 Sandy Beach 08/25/2000 426 Update

Previous Page | Next Page | Firsi Page | Last Page

Go Online

@] hitp:/127.0.0.1:89/5ub_1 /mail/pmoss.nsf/ [ | [5= Localintranet i

Figure 91. Offline Mail
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Chapter 9. Troubleshooting e-mail delivery

— Note

Much of this chapter has been taken from Lotus Domino for AS/400: Problem
Determination Guide, SG24-6051. See this redbook if you want general
Domino problem determination guidance and information about Domino R4.6
mail problem determination. The book you are currently reading concentrates
on Domino R5.

E-mail troubleshooting needs to be broken into parts. Determination needs to be
made regarding whether the issue involves the SMTP servers, the Domain Name
System server (DNS), the firewall, or the network.

When doing problem resolution, it is important to determine if e-mail has ever
been sent successfully. If it has not, you may be looking for basic configuration
errors.

Take extra care in evaluating the status of the internal workings of the iSeries
server, including:

e SMTP server for inbound mail

e SMTP client for outbound mail

* Mail Server Framework (MSF)

* OS/400 Resolver

» System Distribution Directory (SDD)
e SMTP server attributes

e POP server attributes

Also, with Lotus Domino Server Version 5.0, two separate Domino configurations
are possible. The first configuration consists of using the Domino router, the
Domino SMTP server function, and the OS/400 resolver and TCP/IP stack. The
second configuration consists of using the Domino router, 0S/400 SMTP servers,
the OS/400 MSF, and the OS/400 resolver and TCP/IP stack.

Whether *DOMINO or *MSF was selected as the SMTP method during
configuration of the Domino server on the iSeries server dictates how e-mail
troubleshooting is performed on the iSeries and Domino.

9.1 Domino and Internet mail flow

© Copyright IBM Corp. 2000

There are many places to lose mail. This section looks at the mail flows, tasks or
jobs, and databases that are needed for:

* Domino R5 SMTP
* Domino R5 using for AnyMail/400 Integration

If you understand how Domino mail flows through the iSeries server, it may help
you to resolve e-mail problems.

97



9.1.1 R5 server Domino SMTP support
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SMTP routing is built into Domino R5. Some remapping is done in the router, but
there are no conversion tasks as there were in R4.6. Figure 92 illustrates the R5
architecture.

Domino for AS/400 R5 Server

SMTP Mail

TcPip | SMTP

listener

task T

reiloos|
Port —
25

SMTP Mail
Server

Notes R5 Client

Figure 92. R5 server Domino SMTP support

When you enable an R5 server to send messages over SMTP outside the local
Internet domain (configured in the server Configuration document), the server no
longer needs to use Foreign SMTP Domain and SMTP Connection documents as
it did in previous releases. The server can connect via TCP and route e-mail via
SMTP. The server can use a relay host as needed and identify destinations by
using DNS or a hosts file. The server uses the router to route e-mail over SMTP
and perform conversions between Notes format messages and MIME format
messages. Therefore, the R5 server replaces the outbound services of the MTA
that was required in R4.6.

When you enable an R5 server to listen for inbound SMTP connections
(configured in the Server document), the server or router task performs the same
functions as the inbound MTA services of R4.6. Inbound messages are stored in
MAIL.BOX and transferred or delivered by the router. MIME messages are stored
in that format and routed over either Notes RPC or SMTP to their destination. If
needed, the router converts between MIME and Notes format messages.

Databases and directories (IFS files) used
The MAIL.BOX database, under the server data directory, is the place where:

* Inbound messages are stored.
e Qutbound messages are stored.
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9.1.2 What MSF does

If you are not interested in AnyMail Integration, you can skip to 9.1.4, “The iSeries
server as a POP3 server” on page 103. This section provides information about
Mail Server Framework so that you can better understand mail flow with the
AnyMail Integration option.

AnyMail/400 is a set of registered exit points. The AnyMail/400 Mail Server
Framework (MSF) is a framework for handling e-mail:

* It simply calls exit programs in a specific order, passing programs information
about e-mail.

* The exit programs do all the work.
* |t is used for Domino and OfficeVision/400 integration (and Domino Release
4.6 SMTP).
E-mail is queued to MSF via APIs that create an internal MSF object that holds
information about the mail:
* Recipient address
* Pointers to mail content (IFS files, OfficeVision/400 documents, etc.)

The Mail Server Framework runs as QMSF jobs under QSYSWRK subsystem,
and is started when QSYSWRK is started. To start and stop MSF, use the Start
Mail Server Framework (STRMSF) and End Mail Server Framework (ENDMSF)
commands.

MSF is illustrated in Figure 93.

Internal
MSF
'I#_r Queue
l QMSF
Address Resolution

i QSYS/QZD.
QTCP/QTM.

QNOTES/QANI.

;Aﬂachment Conversion

QTCP/QTM..

: Local Delivery o I\PIIOFI’I::
QTCP/QTM.] g

QSYS/QZD.
QNOTES/QANI.

Message Forwarding

[ osvsaz ¥
'

Figure 93. What MSF does
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The AnyMail/400 Mail Server Framework is an open structure for electronic mail
distribution that is provided with the OS/400 operating system. AnyMail/400
functions are a set of mail-related functions that provide open and flexible
interfaces to support mail on the iSeries server. MSF allows the distribution of
electronic mail messages (for example, voice, video, or text).

On the iSeries server, the Mail Server Framework performs the following
functions:

e |t creates and queues MSF messages.
* |t distributes MSF message information by calling configured exit programs.

An exit point is a specific point in a system function or program where control is
passed to one or more specified programs. An exit point passes control to an exit
program. The exit program can be written by the user, or it can be a program that
is already on the system. An application program interface (API) is a functional
interface supplied by the operating system that allows an application program
written in a high-level language to use specific data or functions of the operating
system.

The Mail Server Framework allows programs to be configured and accessed
through an API. A snap-in is a registered exit point program that is called from a
Mail Server Framework exit point. The user-written exit programs provide the mail
message processing required for each MSF message that is created. The MSF
message contains information that defines the electronic mail message. The Mail
Server Framework does not process the contents of a mail message. Instead, it
determines which exit program is allowed to work with the MSF message, and it
tracks the flow of the MSF message through the framework. When an MSF
message is sent, the MSF data type is stored and used asynchronously. The
framework also provides support for electronic mail messages that arrive from
other systems.

The MSF message may be created by an application. As a result of using specific
exit point programs, the information may be sent to other applications on the
same system and applications on other systems. Also, messages could arrive
from other systems. As a result of using specific exit point programs, that
information could be both delivered to the application on that system and
forwarded to another system.

The exit points allow you to install software to affect MSF message flow through
the Mail Server Framework. Each of the Mail Server Framework exit points are
presented in the following list along with the functions of the exit programs:

* List expansion: Allows for expansion of the distribution lists for the MSF
message. It expands any distribution list found in a recipient list. Note that
distribution lists may contain other distribution lists that can be expanded
further.

* Address resolution: Allows for address mapping for each destination
address and adds the correct information to the MSF message recipient
information so appropriate exit programs can be called at later exit points.

* Envelope processing: Allows the message envelope to be changed to a
format that the mail delivery system accepts.

* Attachment conversion: Allows for changes or additions to MSF message
attachments.
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Security and authority: Allows for verification of user authority to distribute
the MSF message information to addresses in its recipient list, before the MSF
message is delivered using the local or remote delivery exit programs.

* Local delivery: Allows for delivery of the MSF message to local recipients.

* Message forwarding: Allows forwarding of the MSF message information to
remote recipients.

* Non-delivery: Allows for reporting the non-delivery of an MSF message.

» Attachment management: Allows for the management of attachments
referenced by an MSF message as part of the message distribution.

* Accounting: Allows for an audit trail of activity required in the electronic mail
environment.

You can find and work with the exit points using the WRKREGINF FORMAT (MSFF0100)
command on an iSeries command line. The screen shown in Figure 94 appears.
For more information about the MSF Exit program, refer to AnyMail/400 Mail
Server Framework Support V4, SC41-5411.

4 Work with Registration Information A
Type options, press Enter.
5=Display exit point 8=Work with exit programs
Exit

Exit Point

Opt Point Format Registered Text
QIBM QZMEMSF ACT MSFF0100 *YES MSF Accounting Exit
QIBM QZMFMSF ADR RSL MSFF0100 *YES MSF Address Resolution
QIBM QZMFMSF ATT CNV MSFF0100 *YES MSF Attachment Conversion
QIBM QZMFMSF ATT MGT MSFF0100 *YES MSF Attachment Management
QIBM QZMEMSF ENL PSS MSFF0100 *YES MSF Envelope Processing
QIBM QZMFMSF LCL DEL MSFF0100 *YES MSF Local Delivery
QIBM QZMFMSF LST EXP MSFF0100 *YES MSF List Expansion
QIBM QZMFMSF MSG FWD MSFF0100 *YES MSF Message Forwarding
QIBM QZMEMSF NON DEL MSFF0100 *YES MSF Non Delivery
QIBM QZMEMSF SEC AUT MSFF0100 *YES MSF Security and Authority
QIBM QZMFMSF TRK CHG MSFF0100 *YES MSF Track Mail Message Change
QIBM QZMFMSF VLD TYP MSFF0100 *YES MSF Validate Type

===> WRKREGINF FORMAT (MSFF0100)

F3=Exit F4=Prompt F9=Retrieve Fl2=Cancel

Figure 94. Work with Registration Information display

9.1.3 R5 server 0S/400 (AnyMail Integration) SMTP support

Now let's look at Domino R5 and MSF. For Domino R5, the integration with
0S/400 SMTP and Mail Server Framework is much simpler and less resource
intensive than the R4.6 implementation. This integration is shown in Figure 95 on
page 102.
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Internal MSF Domino for AS/400 R5 Server

Queue /gibm/userdata/lotus/smtpmta
QMSF inbound
Address Resolution outbound

deadletter

QNOTES/QANI...

raibox
Local Delivery
/inbound
QNOTES/QANI... |

QTSMTPnnnn

Jobs in
QSYSWRK

Notes R5 Client

Figure 95. R5 server integrated with OS/400 SMTP: MSF

When you run the Configure Domino Server (CFGDOMSVR) command and
select *MSF, some MSF exits are installed and directories are created to integrate
MTA into the OS/400 SMTP and OfficeVision/400 functions.

If this layer is not configured correctly or not turned on, you don't get as much
feedback as you may like. Mail may just seem to disappear. This is why it is
important to understand the mail flow and the significance of Host table entries in
an *MSF implementation.

The Domino servre is not listening on port 25. It is 0OS/400 SMTP that is listening.

On a single iSeries server, only one partition can run *MSF. Other servers can
route their mail through this partition, or use the bind to specific IP address
support to run Domino SMTP.

iSeries-based mailing applications, such as OfficeVision/400, can also use the
0S/400 SMTP support to convert to and from SMTP, which allows direct mail
exchange with a Domino for AS/400 server on the same or other iSeries servers.

In summary, Inbound gets SMTP/MIME messages for Notes users from MSF via
an IFS directory. Outbound uses an API and an IFS file to pass SMTP/MIME
messages from Notes users into MSF.

Let's look at inbound mail first. The AnyMail and SMTP services determine if a
message should be delivered locally to an OfficeVision/400 or POP3 user or sent
to Domino. Assuming it is destined for a Notes user, the AnyMail framework
places the MIME message in the indicated IFS directory temporarily. Then the
Domino server processes the message (converts it from MIME to Notes Rich Text
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(if needed), determines the recipient, etc.). The message is placed in the Domino
server's MAIL.BOX file for the router to deliver to Notes users. Many of the tasks
from Release 4.6 are gone, including:

e The inbound session controllers and handlers
e The inbound work queue
* The message converter

For outbound SMTP mail, the router takes the message out of the MAIL.BOX file
and converts any Notes documents to MIME. Then, it places the message in the
AS/400 IFS for the AnyMail framework, and the SMTP server can send the
message to the proper server.

9.1.3.1 Tasks or iSeries jobs

The router is started automatically with the server. A thread reads out of the
inbound directory and writes to the MAIL.BOX. A thread also reads out of
MAIL.BOX and writes to the outbound directory.

QMSF (AnyMail/400) in the QSYSWRK subsystem is started with STRMSF or
when QSYSWRK subsystem started. QTSMTPXXXX (O0S/400 SMTP jobs) in the
QSYSWRK subsystem are started with STRTCPSVR *SMTP. If you are
exchanging mail with OfficeVision/400, you must also start the subsystem
QSNADS.

Address resolution is the same as it is for Domino SMTP.

9.1.3.2 Database and directories (IFS files) used
The only database (under the server data directory) created by the configuration
is: MAIL.BOX, which is created as part of the server.

The directories, under /QIBM/UserData/LOTUS/SMTPMTA, are:

¢ Inbound
e Qutbound
e Deadletter

9.1.4 The iSeries server as a POP3 server

Although we discussed POP3 in 6.2, “POP3” on page 58, some information is
included here for completeness.

The Post Office Protocol (POP3) is an electronic mail protocol that allows a client
running POP3, such as Netscape Communicator, Eudora Pro, or Microsoft
Outlook, to retrieve e-mail messages. POP3 allows mail for multiple users to be
stored in a central location until a request for delivery is made by an electronic
mail program. POP3 uses SMTP for communication between the e-mail client
and the server.

9.1.4.1 The POP3 directory entry

The POP3 system distribution directory entry can be a source of confusion for an
AS/400 administrator configuring POP3 for the first time. What makes a directory
entry a POP3 directory entry?

There are two parameters in the directory entry that determine if the entry is a
POPS3 directory entry. The parameters are:
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e Mail Service Level = 2 (System message store)
* Preferred address = 3 (SMTP name)

— Tip

The POP directory entry needs to be configured on the iSeries server that is
the final location for the mail until the user “gets the mail”. This is the iSeries
server defined in the POPS3 client as its incoming POP server. The iSeries
server is where the POPS3 client “gets” mail. There is another kind of directory
entry that can be used to forward mail. It is a different type of directory entry
from the POP directory entry.

9.1.4.2 The POP3 mailbox on the iSeries server

When POP3 mail is successfully delivered on the iSeries server, it is located in a
POP mailbox on the server until the POP3 user issues the GET MAIL command
from the POPS3 client. It is possible to review the contents of an iSeries IFS
directory to determine if a POP3 user has any mail distributions in the POP3
mailbox. This is useful when debugging a mail problem because an administrator
does not have to continue to use the POPS3 client and issue the GET MAIL
command to see if mail is finally working. Instead, they can check for mail with
one command:

WRKLNK '/QTCPTMM/MAIL/JONEST2'

In the command, JONEST2 is the system distribution directory user ID of the
POP3 client. This may be different from their SMTP user ID.

If the POP3 mailbox exists, the previous command produces the display shown in
Figure 96.

4 ] ] ] N
Work with Object Links

Directory . . . . : /QTCPTIMM/MAIL
Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes

11=Change current directory ...

Opt Object link Type Attribute Text
JONEST2 DIR

Bottom

Parameters or command

Figure 96. Locating a POP3 mailbox on the iSeries server
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— Important

If the previous command is issued and the error message object not found iS

issued to the user’s job log, the POP3 mailbox does not exist. It is important to
realize that the POP3 mailbox does not exist until the first distribution of mail is
delivered to it. If the POP3 mailbox (in the form of the directory listed in Figure
96) is missing, it does not necessarily mean that the POP3 directory entry was
misconfigured. It may mean that mail has never been delivered to this mailbox.

From the display shown in Figure 96, select option 5 to view the next level. The
next level shows any mail distributions that exist in the POP3 mailbox. The screen
displayed in Figure 97 shows that the two mail distributions are located in the
JONEST2 POP3 mailbox. These distributions disappear after the POP3 user
issues the GET MAIL command from the POP3 client. You can read the contents
of these mail distributions from an iSeries screen by using the Display File
(DSPF) command.

4 ] ] ] N
Work with Object Links

Directory . . . . : /QICPIMM/MAIL/JONEST2
Type options, press Enter.

3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
JW122040.NOT STMF
JW122735.NOT STMF
Bottom
- J

Figure 97. POP3 mail

9.2 E-mail troubleshooting

When mail is not being delivered as expected, a DNS or mail administrator is
faced with one of the most challenging troubleshooting areas in TCP/IP. To begin,
it is important to determine if e-mail has ever been sent successfully. If not, you
may be looking for basic configuration errors.

For additional information about configuring the Domino for AS/400 server, refer
to Lotus Domino for AS/400 R5: Implementation, SG24-5592.
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9.2.1 The starting and ending place for internal mail

This section addresses mail being sent to users of an iSeries POPS3 server.

The first step in debugging mail is to always know exactly what the users are
using to address the mail. If possible, visit the users at the client location and
watch them type in the Mail To value: <user Idesmtp domain names. Watch for
mis-typing. Make sure that the user is using the @ symbol and not using the word
at.

If mail is being sent to an iSeries POP client, the second step is to find the SMTP
User ID and the SMTP Domain name in the iSeries alias table on the iSeries
server for the POP client to which the mail should be delivered. You can use the
Work with Names for SMTP (WRKNAMSMTP) command. If you previously
converted the SMTP names (by running the Convert SMTP Names
(CVTNAMSMTP) command), you cannot use the WRKNAMSMTP command. See
AS/400 Electronic Mail Capabilities, SG24-4703, for more information about this.

These two pieces of information are the starting and ending place for iSeries
POP3 mail. Mail delivery starts by using the Mail To: information and ends by
delivering the mail to the POP mailbox on the iSeries server associated with the
SMTP user ID and the SMTP domain name.

What the user types to the right of the @ sign in the Mail To field should match the
SMTP Domain name in the OS/400 SMTP system alias table for the POP3 user
who should receive the mail with one exception—when aliases are used. For
example, consider the example where mail is addressed to

user@ mycompany.com. However, the OS/400 SMTP system alias table lists this
user's SMTP Domain name as AS1.mycompany.com. This discrepancy is okay.
Mail is successfully delivered if the AS1 local host table lists mycompany.com as
an alias to AS1.mycompany.com. Your DNS may need to be changed to allow
local delivery to mycompany.com domain.

9.2.2 Internet mail flow on an iSeries server running Domino
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In many organizations, it is a usual situation nowadays to have users send or
receive Internet mail in addition to e-mail inside the organization. This section
looks specifically at how mail goes from the Internet to the Domino server, or
leaves the Domino server and goes toward the Internet, and how to troubleshoot
problems that may occur.

9.2.2.1 Domino Release 5.0

Domino mail serving at R5.x is both simpler and more complex than at R4.x. It is
simpler in the sense that both options, Domino SMTP or AnyMail Integration, are
easier to work with. It is more complex in that, due to the two choices, you need
to make sure you're clear on which implementation you're using and why. You can
also support both environments by using the bind to specific IP address support,
described in Chapter 5, “One iSeries server and two SMTPs” on page 35.

If you are migrating from a previous Domino implementation, you have the option
to use the OS/400 SMTP server or Domino SMTP functionality (new in Release
5.0). If OV/400 or iSeries POPS3 users are involved, you should stay with the
*MSF implementation or use the bind to specific IP address support. Otherwise,
choose *DOMINO. From an end-user standpoint, either method is transparent,
since mail will route through either one.
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Administrators can switch between the two methods on an individual server by
using the CHGDOMSVR command and selecting *SMTP or *ALL for “Internet
Mail Packages”, together with *MSF for “SMTP Service”, or *SMTP or *ALL for
“Internet Mail Packages” and *DOMINO for “SMTP Service”.

R5.x flow of inbound mail when configured for *SMTP and *MSF

The flow of Internet mail is much like it was at R4.6x. The exception is that, when
inbound mail is processed by MSF, it is passed on to
QIBM/USERDAT/LOTUS/SMTPMTA/INBOUND, and no conversion is needed.
Mail is routed directly to MAIL.BOX for the router to then deliver the mail to the
intended recipient.

R5.x flow of outbound mail when configured for *SMTP and *MSF

The flow of Internet mail is much like it was at R4.6x. The exception is that, when
outbound mail is to be processed by MSF, it is passed on to the
QIBM/USERDATA/LOTUS/SMTPMTA/OUTBOUND directory.

If *SMTP and *DOMINO are chosen for mail configuration, the iSeries server no
longer acts as the SMTP server. Instead, the Domino server provides this. You
can confirm this through the OS/400 NeTsTAT *v command and verify that the
associated user profile for SMTP is QNOTES instead of QTCP.

In this example, no MSF code is involved. In fact, the SMTP task doesn't need to
be running for outbound Internet mail to be delivered (the router is SMTP aware)
and is only required to receive inbound Internet mail (so port 25 is listening).

Additional configuration is needed if a firewall or mail relay is involved. The
configuration setting (previously changed through the Change SMTP Attributes
(CHGSMTPA) command on the iSeries server) is now needed on the
Router/SMTP tab of the server configuration document. Global Domain document
(MTAGIobal) is automatically created for you.

Note

The Global Domain document is needed for Domino SMTP if you choose to
receive mail for multiple domains.

9.2.2.2 Likely encountered mail problems and resolutions for *MSF
If inbound Internet mail for a Domino R5 server is not being received, check for
the following situations:

* If mail is not flowing, the first and best thing you can do is narrow the scope of
the problem. If the problem is with inbound mail, end the Domino server and
verify that mail is appearing in the /INBOUND directory.

* If mail isn't going this far, it may be that the iSeries server isn't accepting mail
for the domain, and changes need to be made to CFGTCP option 10 or option
12. In particular, check that you have your domain name in your local Host
table and make sure that it is specifically AS26.ITSOROCH.IBM.COM or
ITSOROCH.IBM.COM (that is, with or without host name), as appropriate for
your installation. Otherwise, and more likely (especially if mail was flowing at
some point), there is a problem with the Internet Service Provider (ISP) or
firewall, if one is involved. Check with support for those services to see if
logging is confirming that mail is making it that far.
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To confirm that the ISP has the correct MX record for your mail domain, you can
use NSLookUp or several Internet Web sites to verify. Two examples are:

® http://www.baboon.ch
® http://www.samspade.org/

If the MX entry is incorrect, mail is likely not being forwarded to the proper
address (usually the non-secure port of your firewall, or an iSeries IP interface
address connected to your ISP router). If all checks out, make sure that SMTP is
up and running on your iSeries server (Use netstat *cnn for port 25).

If mail disappears after entering MSF, end the Domino server's router task (use
the tell router quit command), and verify that mail is arriving in the
QIBM/USERDATA/LOTUS/SMTPMTA/INBOUND directory. If not, the problem is
likely with MSF. Possibly Domino registered exit programs aren't correct, or
another AS/400 directory entry is grabbing the mail. Check the MSF job logs for
information.

A dump of the Mail Server Framework may be required to see what AnyMail has
done with your message. The necessary steps to do this are described in Lotus
Domino for AS/400: Problem Determination Guide, SG24-6051. If mail appears in
MAIL.BOX and is never delivered, does the mail user exist? For example, is there
a proper person document configured for this user to receive mail?

If all is correct, the problem could lie with a corrupt MAIL.BOX (not likely if other
users are receiving mail) or with a corrupt user Domino mail database (probably
in the format of shortname.nsf, for example jsmith.nsf).

If no users are receiving mail at this point, verify that the Domino server is
configured to accept mail for that domain (based on the MTAGlobal Global
Domain document).

If Outbound Internet mail for a Domino R4.6x server is not being received, check
the following situations in the order shown:

1. Confirm that mail is in MAIL.BOX by ending the router and opening MAIL.BOX

2. Start the router task, and verify that mail is leaving the Domino server by
ending MSF. Check QIBM/USERDATA/LOTUS/SMTPMTA/OUTBOUND, and
confirm the mail message appears there.

3. If everything is okay in step 2, start MSF and verify that mail leaves the
OUTBOUND directory. From there, MSF will process the mail and route it to
the OS/400 SMTP server for delivery. SMTP routes the mail directly to your
ISP router, unless a mail relay is involved, in which case the mail relay needs
to be defined under CHGSMTPA. If a mail relay or firewall is involved, you can
confirm that it is listening for port 25 requests. To do so, Telnet from the
AS/400 system on port 25 to the secure port of the firewall or mail relay, and
receive the standard 220 reply.

9.2.2.3 Likely encountered mail problems and resolutions for Domino
For Release 5.0 mail configured for Domino, you can have multiple servers
running SMTP. Domino is now acting as the SMTP server. You can verify this via
the OS/400 nNeTSTAT cNN command, and confirm that port 25 is associated with the
QNOTES profile. Note the following points:
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* Outbound mail now leaves MAIL.BOX and, although it is still relying on the
AS/400 DNS settings, processes mail outbound via the Domino's SMTP
server. Mail Relay/Firewall settings are made via the Server\Configuration
view and under the Router/SMTP tab for “relay hosts for messages leaving
Internet domain”. If you have a DNS, the DNS setting on the iSeries server
should be set to “YREMOTE. The Domino DNS setting under the Router/SMTP
tab should be left at the default of dynamic then local.

* Inbound mail now comes automatically to MAIL.BOX. If it is not being
received, verify that mail domain is accepting mail for the intended recipient. A
Global Domain document can be created if mail must be accepted for multiple
SMTP domains.

9.2.2.4 Additional considerations

The use of special NOTES.INI parameters is very important to the Internet mail
debugging process. See 9.2.10, “Settings in the NOTES.INI file to obtain error
reporting” on page 125, for relevant settings.

9.2.3 MAILROUTER parameter

9.2.4 Hosts file

9.2.5 DNS server

This section applies to Domino with SMTP services *MSF.

If you are configuring an AnyMail/400 server to send mail to the Internet, use the
Change SMTP Attributes (CHGSMTPA) command to define the router name.

The following information is important and not self-evident. When you start SMTP
and have a MAILROUTER parameter configured, the client (sending task)
immediately performs the gethostbyname function on this name to resolve the IP
address. If the gethostbyname function fails, any mail sent to the Internet fails
and the message is returned to the sender. It can fail if the router has not yet
been set up in the DNS, even though it will have a valid address the next day. It
will continue to fail even after the DNS is set up. It will not work until SMTP is
restarted with a successful gethostbyname function. This is the only time the
gethostbyname function is run.

If the iSeries server does not have an entry in the local host table for the domain
name of the Domino server, the mail is not delivered. This is only a requirement
for AnyMail/400 (MSF) Integration of Lotus Domino for AS/400 and not the
Domino SMTP option. However, the Domino SMTP implementation may require a
host entry for other reasons, such as replication. You will not find the mail in any
of the directories or MAIL.BOX. No message is returned to the sender. A clue is
that you may see SMTP prestart jobs starting and ending.

If an iSeries DNS server is used, verify that the DNS server is started, and an
active QTOBDNS job exists in QSYSWRK subsystem. Check its job log for
errors. Verify that the IP interfaces to which the DNS server should be bound are
started, including the Internet address listed on the same iSeries system, using
the Configure TCP/IP (CFGTCP) command option 12.

If changes or corrections have been made to the DNS server, make sure the DNS
server has been updated to pick up those changes.
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Use the Start DNS Query (nszookur) command to verify that the DNS server is
responding with the answers you expect. For example, is the DNS server
resolving the SMTP domain name used to the right of the @ symbol in the Mail To
address? If not, this can be a problem, unless an alias is used in the AS/400 local
hosts table. For more information about the Start DNS Query (NSLOOKUP)
command, refer to 9.3.4, “NSLOOKUP on the iSeries server” on page 131.

If you are using iSeries DNS, it is possible to log all queries to the DNS server in
a file named QUERYLOG, which is located in QIBM/UserData/OS/400/DNS. If
the DNS server is busy, QUERYLOG can become quite large very fast. It does
not contain the responses that the name server is giving out, only the queries the
server is receiving. However, it is useful for troubleshooting mail because it will
log the queries that SMTP and AnyMail/400 are making. You can make a note of
them and use NSLOOKUP to check on the responses that they will be receiving.
See AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support, SG24-5147, for
more information on QUERYLOG.

9.2.6 Jobs (tasks) that need to be active for Domino running on the iSeries server
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The following jobs (tasks) must be active for the iSeries server running Domino to
send mail to different kinds of mail users:

* Router

* TCP/IP

* MSF (Domino Release with SMTP services *MSF)
* SMTP

9.2.6.1 Router

The Domino server router is used by all kinds of mail and needs to be active. Use
the Domino console to check that the router is active. The router starts
automatically when the Domino server is started. If you have to start it manually,
use the Domino console and type load router.

9.2.6.2 TCP/IP

Verify that the SMTP client sending the mail, and any POP client receiving the
mail, have TCP/IP connectivity to their respective servers. Also, verify that each
client can successfully ping their server by the IP address. If the ping is not
successful, you need to debug a TCP/IP connectivity problem before proceeding
to debug a mail problem:

* Make sure the appropriate iSeries line descriptions are active.

* Verify that the associated IP interface has been started on the iSeries server
system.

* Verify that the TCP/IP route exists if the client is on another subnet from the
SMTP, POP, or DNS server.

If the mail client is configured to have the SMTP Outgoing Mail Server or
Incoming Mail Server to be a host.domain name rather than an IP address, verify
that a ping to the host name is successful. If a ping by IP address works, but a
ping by host name fails, you need to debug a DNS problem before proceeding to
debug a mail problem.

9.2.6.3 QMSF (AnyMail/400)
This section applies to Domino Release 5.0 with SMTP services *MSF.
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For mail to be successfully delivered on an iSeries server, at least one QMSF job
needs to be active under the QSYSWRK subsystem. This job should autostart
when the QSYSWRK subsystem goes active. However, certain errors can cause
the QMSF job to end. Therefore, if mail is not being delivered, verify that QMSF is
active. To do so, issue the following command:

WRKACTJOB SBS (QSYSWRK)

QMSF should be listed as an active job. If it is not listed, you can start the QMSF
job by issuing the following command:

STRMSF

If you issue the Start Mail Server Framework (STRMSF) command and still
cannot find QMSF as an active job under QSYSWRK, the job may be starting but
ending right away with an error. If this is the case, the ended job log should be
reviewed for error messages. The QMSF job runs using the QMSF user profile.
To find the spooled file for the QMSF job log, issue the following command:

WRKSPLF QMSF

Press F18 to go to the bottom of the list. Many of these QMSF job log spooled
files may be listed. Press F11 key to display the date and time stamps of these
jobs to help locate the one that you need.

If the QMSF job is active and mail is still not being delivered, check the active
QMSF job log for errors.

9.2.6.4 QMSF job error recovery
There are two possible situations:

* The MSF messages are not processed.

Situations may occur in which you find that messages are not being
processed. Error messages or job log messages may indicate that the Mail
Server Framework stopped the processing of some messages and is
beginning to process new messages from the message queue.

To recover from this situation, check the job logs for the exit point and the exit
program running when MSF stopped processing the messages. Use the
information to determine where and why MSF stopped processing the
messages.

¢ The Mail Server Framework ends.

If the MSF job in QSYSWRK ends, first try restarting MSF. If that does not
resolve the problem, check for messages in QSYSOPR and in the job logs for
the QMSF jobs that are running that caused MSF to end. The Mail Server
Framework is finding something it cannot process, so it ends the framework.

A case where this may occur is if someone accidentally deleted the exit point
program.

These messages may appear in the job log:

— CPFAF95: Job ended
— CPFAF98: Message postponed
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One of the following events may occur:
— Exit programs encounter severe errors causing the job to end.
— The Mail Server Framework encounters abnormal conditions.

— Exit programs encounter situations that stop the processing of MSF
messages and end the MSF job.

— One of the exit programs determines that an MSF message should be
postponed until the next STRMSF.

Use the Display Job Log (pspgorroc) command to determine what the problem is.
Display the message, and use the recovery information to correct the problem.
Then restart MSF.

The Start Mail Server Framework (STRMSF) command starts the Mail Server
Framework jobs in the system work subsystem (QSYSWRK). For more
information about QSYSWRK, see AS/400 Work Management, SC41-5306.
There are two parameters you can specify on the STRMSF command.

The MSGOPT (Message Option) parameter specifies how the Mail Server
Framework processes existing MSF messages:

* "RESUME is the default option, which allows all existing MSF messages to
continue processing from the point the Mail Server Framework was previously
ended.

* "RESET allows all existing MSF messages to be processed as if they were
just created. Users may receive duplicate messages when this parameter is
used.

* *CLEAR deletes all existing MSF messages. Use the *CLEAR option only
when a software error is reported with the Mail Server Framework or its
associated exit point calls programs that require all MSF messages to be
deleted. Use the option only when you want to remove all mail message traffic
from the system because of errors. If this option is used, all messages are
deleted and cannot be recovered.

The second parameter identifies the number of MSF jobs that are automatically
started. The default number is “3”.

9.2.6.5 SMTP
This section applies to Domino Release 5.0 with SMTP services *MSF.

As discussed in 6.1.2, “OS/400 SMTP” on page 58, and 9.1.4, “The iSeries server
as a POPS3 server” on page 103, OS/400 SMTP runs in the QSYSWRK
subsystem. There can be one or more jobs started. If the server is active, you
should find at least four SMTP jobs in QSYSWRK:

* QTSMTPBRCL
* QTSMTPBRSR
* QTSMTPCLTD
* QTSMTPSRVD

There will also be some prestart jobs that do not show up unless you press F14.

If the preceding jobs do not exist under the QSYSWRK subsystem, enter the
following command to start the server:
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STRTCPSVR SERVER (*SMTP)

Then, issue the command:

WRKACTJOB SBS (QSYSWRK)

The display shown in Figure 98 appears.

C Work with Active Jobs AS25
02/10/00 13:50:39
CPU %: 2.9 Elapsed time: 03:01:51 Active jobs: 256
Type options, press Enter.
2=Change 3=Hold 4=End 5=Work with 6=Release 7=Display message
8=Work with spooled files  13=Discomnnect ...
Opt Subsystem/Job User Type CPU % Function Status
QITRTD05912 QTICP BCH .0 PGAVM-QTORSRVR SELW
QTSMTPBRCL QTICP BCH .0 PQAQVM-QIMSBRDG DEQW
QTSMTPBRSR QTICP BCH .0 PAQI-QIMSBRSR DEQW
QTSMTPCLTID QTICP BCH .0 PAM-QIMSCLCD DEQW
QTSMTPSRVD QTICP BCH .0 PAVM-QIMSSRCD SELW
QITFTO00077 QTFTP BCH .0 SELW
QTTFT00084 QTFTP BCH .0 DEQW
QTTEFT00088 QTFTP BCH .0 DEQW
QTTFTO00097 QTFTP BCH .0 DEQW
More. ..
Parameters or command
===>
F3=Exit F5=Refresh F7=Find Fl0=Restart statistics
\Fll:Display elapsed data Fl2=Cancel F23=More options F24=More keys )

Figure 98. SMTP jobs

9.2.6.6 iSeries POP3 server

As described in 6.2.2, “iSeries POP3” on page 60, the iSeries POP3 server needs
to be active for POP3 clients (Netscape Communicator, Eudora Pro, or Microsoft
Outlook Express) to receive the mail.

If the POP server is active, locate one or more jobs with names similar to
QTPOPO00622. The last five numbers in the POP job name can be any number.
Also, even one QTPOPxxxxx job active indicates that the POP server is active.

If the preceding jobs do not exist under QSYSWRK subsystem, then start the
POP server with the command:

STRTCPSVR SERVER (*POP)

If you try to start either or both SMTP or POP servers, and still cannot find the
associated active jobs in the QSYSWRK subsystem, it is possible that these jobs
are starting but ending before you can locate them. First, check for any errors in
the user job log that issued the STRTCPSVR commands. If your own interactive

job was used to issue the commands, review your own job log with the following
command:

DSPJOBLOG

Press Enter, followed by pressing F10. Then, page up to look for error messages.
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Also, if the SMTP or POP jobs end with an error, review their spooled job logs for
error messages. These jobs run using the QTCP user profile. Therefore, to find
the spooled job logs of the inactive jobs, use the following command:

WRKSPLF QTCP

Press Enter and then press F18 to go to the bottom of the list. The job name is
usually displayed in the User Data field in the Work With Spooled Files display.

If the SMTP and POP jobs are active, and mail is still not being delivered, always
check the SMTP and POP active job logs for any error messages. Any error
messages in these job logs can give you clues as to what is going wrong.

Tip
If changes to the AS/400 TCP/IP domain host table was made with the

CFGTCP command, option 12, you may need to restart the SMTP server to
pick up the changes.

You can also enter the NETSTAT *cNN command on an iSeries command line and
press F11. You can see if SMTP and POPS3 are active, as shown in Figure 99. In
this example, the OS/400 SMTP is started, since QTCP is the user. If it is the
Domino SMTP that is started, the user is QNOTES.

4 ] ] I
Work with TCP/IP Connection Status

System: AS25
Local internet address . . . . . . . . . . . : *ATLL

Type options, press Enter.
4=Fnd  5=Display details

Remote Remote Local

Opt Address Port Port User Bytes Out Bytes In
* * ftp-con > QICP 0 0
* * telnet QICP 0 0
* * smtp QTICP 0 0
* * tftp QTFTP 0 0
* * www-http QIVMHHTTP 0 0
* * kerberos QIVMHHTTP 0 0
* * pop3 QTICP 0 0
* * netbios > QSYS 0 0
* * netbios > QSYS 837172 10647976
* * netbios > QSYS 0 4512037
* * netbios > QSYS 0 0

More. ..
F5=Refresh Fll=Display connection type Fl3=Sort by column
Fl4=Display port numbers F22=Display entire field F24=More keys )

Figure 99. NETSTAT *CNN with F11 pressed

If a Domino SMTP is listening on port 25, and the displayed user is QNOTES, you
must end that server before you can start AnyMail Integration for SMTP (unless
you are binding to the specific address).

If you start SMTP while a Domino server is listening on port 25, QTSMTPXXXX
jobs will start and end. If you run the DSPMSG QSYSOPR command, the error
message SMTP job QTSMTPXXXX ended abnormally. appears.
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End the Domino server that is configured with *DOMINO, and start SMTP again.

9.2.6.7 OfficeVision/400

For OfficeVision/400 or Object Distribution, both the QSYSWRK and QSNADS
subsystems need to be active. Unfortunately, it is not an easy problem to
diagnose (if you miss the fact that the tasks are not running) because there is
nothing obvious in terms of where the mail has gone. It is sitting in QZDINDEX
waiting for the QDIA* processes to handle it, but you cannot see where it is. The
best advice is to verify that the subsystem QSNADS is active.

The SNADS distribution log can prove useful. You can use the Display
Distribution Log (psppstLOG) command, and press F4 for prompting. You can
access this screen by typing co NETWORK, pressing Enter, and selecting option 9.

9.2.7 Looking for the mail that doesn’t flow

There are different databases and directories where the mail can be, depending
on several factors:

e The Domino for AS/400 release (we only discuss R5 here)

e Whether SMTP is configured to use Domino’s native SMTP or OS/400 SMTP
* Whether you are using POP3

9.2.7.1 Release 5.0 server integrated with 0S/400 SMTP (MSF)
The MAIL.BOX database, created as part of the server by the configuration under
the .../notes/data/ directory, is a possible place for mail to be sitting.

The directories under /QIBM/UserData/LOTUS/SMTPMTA are:

* INBOUND
* OUTBOUND
» DEADLETTER

The iSeries server directories for OS/400 POP3 users are:

* /QTCPTMM/ATTABOX
* /QTCPTMM/MAIL

* /QTCPTMM/SMTPBOX
* /QTCPTMM/TMP

9.2.7.2 R5 server Domino SMTP support
Mail inbound and outboung messages route through MAIL.BOX. Inbound POP3
mail is stored in Domino mail databases.

9.2.8 Accessing the iSeries directories

The WRKLNK command can be used to look at, for example,
/QIBM/UserData/LOTUS/SMTPMTA/OUTBOUND, as shown in Figure 100 on
page 116.
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Work with Object Links
Directory . . . . : /QIBM/UserData/Lotus/SMIPMTA/OUTBOUND

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
QACX5CTDGZ STMF

Bottom
Parameters or command

===

F3=Exit F4=Prompt F5=Refresh F9=Retrieve Fl2=Cancel F1l7=Position to
F22=Display entire field F23=More options

& J

Figure 100. Outbound directory

The Display File (DSPF) command can be used to look inside these objects to
ensure that it is the mail item you are looking for that is stuck. For the example
above, the command is:

DSPF ‘/QIBM/UserData/LOTUS/SMTPMTA/OUTBOUND/gqacx5ctdgz!’
DSPF is included in OS/400 from V4R4 onwards.

An easier way may be to access the directory by using the following command:
WRKLNK (‘/QIBM/UserData/LOTUS/SMTPMIA/OUTBOUND/ ')

Then, select option 11 to change the current directory. Next, on the command
line, type:

DSPF gacx5ctdgz

If the object has a long name as shown in Figure 101, you put your cursor on the
Object link field Q09..., and press F22 (Shift+F10). You will see the full object

name as shown in Figure 102, which you can use with the Display File (DSPF)
command.
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4 ] ] ] N
Work with Object Links
Directory . . . . : /QTCPIMM/SMTPBOX
Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...
Opt  Object link Type Attribute Text
Q0919637FAB302B393 > STMF
Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve Fl2=Cancel F1l7=Position to
F22=Display entire field F23=More options
N J
Figure 101. Work with Object Links display
4 ] ] ] )
Work with Object Links
Directory . . . . : /QICPIMM/SMTPBOX
Object link
/QTCPTMM/SMTPBOX/Q0919637FAB302B393F000000 . NOTE
Bottom
Fl2=Cancel
Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve Fl2=Cancel F1l7=Position to
F22=Display entire field F23=More options )
N

Figure 102. Full object name

9.2.9 What happens when jobs or tasks are not active

This section shows you some examples of where the mail is located.

9.2.9.1 MSF is not active

This section applies to Domino Release 5.0 with SMTP services *MSF.

If the iSeries MSF jobs are not active, what happens when you send mail? Mail

that is sent from a Notes user will stay in the

/QIBM/UserData/LOTUS/SMTPMTA/OUTBOUND directory as shown in Figure

103 on page 118.
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If there is nothing in the OUTBOUND directory, the problem is with Domino
creating and sending the mail item and not MSF. Note that there is no error
message if MSF is not running.

4 ) . ) N
Work with Object Links

Directory . . . . : /QIBM/UserData,/LOTUS/SMIPMTA/OUTBOUND

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
QACXTLSB1X STMF

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve Fl2=Cancel F17=Position to

F22=Display entire field F23=More options
N J

Figure 103. The /QIBM/UserData/LOTUS/SMTPMTA/OUTBOUND directory

Mail that is sent from an Internet or SMTP user to a Notes user will be in
QZDINDEX waiting to be put into /QIBM/UserData/LOTUS/SMTPMTA/INBOUND
by MSF. A communications trace will show that there has been communication
between the two servers.

Mail that is sent from an OfficeVision/400 user to a Notes user or POP3 user sits
in QZDINDEX waiting for QDIA* processes to handle it. The best advice is to
verify that MSF and the subsystem QSNADS are active.

The SNADS distribution log can be useful. You can use the Display Distribution
Log (DSPDSTLOG) command and press F4 for prompting. To access this display,
(Figure 104), type co NETWORK, press Enter, and select option 9.
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Display Distribution Services Log
Type options, press Enter.
5=Display details
Function Entry ------ Logged------ ----Originator---- Seq
Opt  Type Type Date Time Jcb Name User ID Address Nor
*ORG *NRM 2/23/00 10:15:31 QPADEVOOOP  ASMITH AS25 0009
Bottom
F3=Exit Fl2=Cancel
J

Figure 104. Display Distribution Services Log

9.2.9.2 SMTP is not active
This section applies to Domino Release 5.0 with SMTP services *MSF.

If the OS/400 SMTP jobs are not active, what happens when you send mail?

Use the wrxkacTgoB command so you can see the QMSF jobs. Select option 5 and
option 10 to view the job logs. One of the jobs will contain the message surp
distribution not sent. SMIP jcbs not active., as shown in Figure 105 on page 120.
You also see the messages in the QSYSOPR message queue. Use the pspMsc
Qsysopr command to find the message.

Mail sent to your server, while SMTP is down, will be held somewhere on the
sending side, most likely at the Internet Service Provider (ISP) site, for a certain
length of time before being declared undeliverable.
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Display Job Log
System: AS02
Job . . : QMSF User . . : QMSF Number . . . : 123534

Job 123534/QMSF/QMSF started on 10/25/99 at 13:16:18 in subsystem QSYSWRK
in QSYS. Job entered system on 10/25/99 at 13:16:18.

Job 123534/QMSF/QMSF submitted.

Output file DSTLINFO created in library QTEMP.

Menmber DSTLINFO added to output file DSTLINFO in library QTEMP.

SMIP distribution not sent. SMIP jobs not active.

Job 123534/QMSF/QMSF stopped processing MSF message.

Bottom
Press Enter to continue.
F3=Exit F5=Refresh Fl0=Display detailed messages Fl12=Cancel
Fl6=Job menu F24=More keys
- J

Figure 105. QMSF job log

Mail that is sent from a Notes user to a local AS/400 POP3 user will be delivered
so long as the POPS3 server is active. If the POP3 server is ended, the mail stays
in the /QTCPTMM/MAIL/JSPRING directory, as you can see in Figure 106, since
JSPRING cannot contact the server.

4 ] ] ] N
Work with Object Links

Directory . . . . : /QICPIMM/MAIL/JSPRING

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
JW571764 .NOT STMF

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve Fl2=Cancel F1l7=Position to
F22=Display entire field F23=More options
N J

Figure 106. JSPRING mailbox

Mail that is sent from a POP3 user to a Notes user or OfficeVision/400 is not
delivered. The server is not responding as you can see in Figure 107.
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INormaI j IVariabIe width the server's administratar,

Ly

There waz no rezponze. The server could be down
of iz hot responding.

SMTP not active

Figure 107. No response

To start SMTP, enter the command:

STRTCPSVR SERVER (*SMTP)

Verify that the SMTP is running by using the Work with TCP/IP Network Status
(veTSTAT) command. On any iSeries command line, type:

NETSTAT *CNN

You see a display, like the example in Figure 108 on page 122. When you press
F14 to show the port numbers, make sure you see a column with Local Port

showing SMTP or the number 25. Confirm that it is 0S/400 SMTP by typing a 5in
the Option column. The associated user profile is QTCP for 0S/400 SMTP.

If the associated user profile is QNOTES, Domino SMTP is the active SMTP
service.
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Work with TCP/IP Connection Status
System: SYSTEMO1
Local internet address . . . . . . . . . . . : *ATLL

Type options, press Enter.
4=Fnd 5=Display details

Remote Remote Local
Opt Address Port Port Idle Time State
_  * * ftp-con > 013:54:54 Listen
_  * * telnet 002:07:03 Listen
_ * * smtp 013:54:34 Listen
_ * * domain 013:54:54 Listen
_ * * domain 013:54:54 *UDP
_ * * bootps 000:01:07 *UDP
_ * * tftp 013:54:39 *UDP
_ * * www-http 013:54:50 Listen
_ * * pPop3 013:54:37 Listen
_ * * 119 004:37:16 Listen
* * 143 004:37:25 Listen

More. ..
F5=Refresh Fll=Display byte counts F13=Sort by colum
Fl4=Display port numbers F22=Display entire field F24=More keys

- J
Figure 108. Work with TCIP/IP Connection Status display

If a Domino SMTP is listening on port 25, you must end the server before you can
start AnyMail Integration for SMTP (unless you are binding to a specific IP
address).

If you start SMTP while a Domino Server is listening on port 25, QTSMTPXXXX
jobs will start and end. Entering the DSPMSG QSYSOPR command results in the
error message:. SMIP job QTSMIPXXXX ended abnormally.

End the Domino Server that is configured with *DOMINO, and start SMTP again.

Enter the following command:

WRKACTJOB SBS (QSYSWRK)

The display shown in Figure 109 appears.
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4 N

Work with Active Jobs AS25
02/10/00 13:50:39
CPU %: 2.9 Elapsed time: 03:01:51 Active jobs: 256
Type options, press Enter.
2=Change 3=Hold 4=End 5=Work with 6=Release 7=Display message
8=Work with spooled files 13=Discomnnect ...
Opt Subsystem/Job User Type CPU % Function Status
QTRTD05912 QTCP BCH .0 PGM-QTORSRVR SELW
QTSMTPBRCL QTCP BCH .0 PGM-QIMSBRDG DEQW
QTSMTPBRSR QTCP BCH .0 PGM-QIMSBRSR DEQW
QTSMTPCLID QTCP BCH .0 PGM-QIMSCLCD DEQW
QTSMTPSRVD QTCP BCH .0 PGM-QIMSSRCD SELW
QTITEFTO00077 QTFIP BCH .0 SELW
QTTFT00084 QTFTP BCH .0 DEQW
QTTFT00088 QTFTP BCH .0 DEQW
QTTFTO00097 QTFTP BCH .0 DEQW
More. ..
Parameters or command
===>
F3=Exit F5=Refresh F7=Find Fl0=Restart statistics
Fll=Display elapsed data Fl2=Cancel F23=More options F24=More keys
- J

Figure 109. SMTPJOB

Important

You must end and restart MSF after you start SMTP.

9.2.9.3 The Domino router is not active
If the Domino mail router is not active, what happens when you send mail?

If the Domino mail router is not active and you send mail from a local iSeries
POP3 user or OfficeVision/400 user to a Notes user, the mail stays in the
/QIBM/UserData/LOTUS/SMTPMTA/INBOUND directory. See Figure 110 on
page 124. You can see the header and the body of the mail item.
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Work with Object Links
Directory . . . . : /gibm/userdata/lotus/smtpmta/inbound
Type options, press Enter.

3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
QACXQOMOMOH STMF
QACXQMOMOHB STMF

Bottom
Parameters or command
===>

F3=Exit F4=Prompt F5=Refresh F9=Retrieve Fl2=Cancel F1l7=Position to

L F22=Display entire field F23=More options P

Figure 110. Inbound

If the Domino mail router is not active, and mail is sent from a Notes user to
another kind of mail user, the mail stays in the MAIL.BOX database on your
Domino server.

The MAIL.BOX database at the server can be opened from a Notes client. Select
File->Database->Open. The database name has to be explicitly typed in the
filename field in the dialog, because it does not end in the characters NSF. Once
you press Esc to leave the About this Database document (first time opening
only), you see a display similar to the example in Figure 111.

™ SERVERXX Mailbox - Mail - Lotus Notes

File Edit “iew Create Actions Help
CEA g £ EF £ 08 ¢ =% = Yaf

£ welcame | ) SERVERXX Maibos - Mail X]

g SERVERX Mailbox
B Mai

 Submit Time Recipients

10425 01:30 PM Joe Adminssd acmess <popuser@POPDOMAIN COM: 453

Figure 111. MAIL.BOX content

To restart the router, use the Work with Domino Servers (wrkpoMsvr) command,
and select the desired Domino server. Then choose option 8 to work with the
server console. Run the load router command to start the router.

9.2.9.4 The Domino SMTP is not active
This section applies when your Domino server is using Domino SMTP Services.
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If the Domino SMTP is stopped, what happens when you send mail?

If Domino SMTP is not active and you send mail from a POP3 user to Notes user,
the mail is not delivered, because the SMTP task is not there to receive it. See
Figure 112.

3¥ Composition
File Edit “iew Insertt Format Toolz Communicator Help

E=

i i g "~ e e i k3

o T w8 € 2% W 8 a3 o4 B
: Sepd Wuoter  Address Attach Options Speling Save Bt Secinty - Stop
v- ﬁ - Cc:Inotes_ad.min@domple

1 &

Subject: |D|:|mincu SMTP is not active

[fema =] [vansblewian <] [0 =] lE] & A A A i i

Netzcape

There was no responze. The zerver could be down
of iz not rezponding.

If pow are unable to connect again |ater, contact
the zerver's administrator.

Figure 112. Server is not responding

If the Domino SMTP is not active and you send mail from a Notes user to a POP3
user, the mail will be delivered. The reason is the Domino router is SMTP aware
and was able to send the mail anyway. A message at the Domino console will
show that the mail was sent out normally.

How do you stop outbound mail? Edit the Configuration document to disable
SMTP (under the Router/SMTP tab and Basics subtab), and restart the server.

To start Domino SMTP, type 1oad smtp at the Domino console.

9.2.10 Settings in the NOTES.INI file to obtain error reporting
The following parameters can be used to obtain some level of error messaging
back from the Router task (to be added to the NOTES.INI file):
e debug_router =0, 1, 2, 3: To collect router messaging

— 0: Default

— 1: Enables additional routing logging
— 2: Enables routing tables traces

— 3: Both of the above

* log_mailrouting = 10, 20, 30, 40: To collect debug information. This
parameter controls the amount of logging performed during message routing.

— 20: Default
— 40: Provides the most detailed logging
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* shared_mail = 0, 1, 2: Specifies whether the shared mail feature is used for
new mail delivered to this server

— 0 (default): The shared mail feature is not used for new mail.

— 1: The shared mail feature is used for new mail delivered to this server.

— 2: The shared mail feature is used for new mail delivered to this server and
for new mail transferred through this server.

* smtpdebug = 0, 1, 2, 4: To collect SMTP logging information

— 0 (default): No log-ins

—1: Logs errors

— 2: Logs protocol commands
—4: Collects SMTP messaging

* SmtpClientDebug = 0, 1: To collect inbound SMTP messages

— 0 (default): No collecting
—1: Collects inbound SMTP messaging

* SmtplODebug = 0,3: SMTP data logging

— 0 (default): No logging
— 3: Logs all data received by the SMTP taskO

e SMTPSavelmportErrors = 0, 1, 2: Message recording
— 0: No messages are recorded.

—1: When an arriving message fails to be written as a note in MAIL.BOX,
Domino writes the data stream to a temporary directory and logs the name
of the file.

— 2: All arriving messages have their data streams written to the temporary
directory.

— Attention

Before enabling any debug parameters, it is imperative that you discuss them
with a Lotus Notes/Domino Support Analyst. There may be issues surrounding
their use or special precautions that must be considered. These debug
parameters may require a large amount of disk space, depending on when the
server encounters problems. The longer the server stays up, the larger the
debug files will be. These files can grow large enough to cause disk space
shortages.

Also, the content of the messages are accessible to anyone with the privileges
to read files in the temporary directory.

9.2.11 Helpful NOTES.INI parameters
These parameters apply to the format of the date and time and can be helpful
when national settings are required:

e Dateorder = DMY
e Clocktype = 24_Hour
e Dateseparator = .
e Timeseparator=:
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9.3 Tools and traces for troubleshooting

Some of the tools and traces use CPU or disk space. It is important to remember
to turn them off when you finish with your investigation.

Remember that, with any of these tools, you may have to use the iSeries Support
Center to interpret the data that you collect. However, using the tools may trigger
some ideas on how to solve the problem, and it will make it easier to give the
information to the Support Center if you are familiar with their use.

Do not forget to use the Domino console when looking to see if mail is being
transferred or received (WRKDOMSVR option 8). You may prefer to use the
Domino Administrator interface, either the console or the mail log. We discuss the
following tools:

e Console commands

TELNET to test SMTP traffic

NETSTAT command

NSlookUp on the iSeries server

NotesCONNECT (Nping)

Communications trace

e Domino Message tracking for reports and tracing requests
Mail probes

If you are using AnyMail Integration, there are some tracing tools that you may be
asked to use by service personnel. These are:

* Collecting flight recorders

* AnyMail Integration (MSF) dump snap-in
e Dumping Mail Server Framework (MSF)
* Component journaling

Information about the second group of tools can be found in Lotus Domino for
AS/400: Problem Determination Guide, SG24-6051.

9.3.1 Console commands

The following Domino server console commands can help you to understand
what is the actual mail activity running on the Domino server and to detect any
anomaly:

"tell router show"
"show task time"

"show stat mail by dest"
"show stat mail"

For example, the show stat mailbydest and show stat mail commands show if
there is any problem accessing the Domain Names System, through the statistic
MAIL.WaitingForDNS.

9.3.2 Using Telnet to test SMTP traffic

In 6.1, “SMTP” on page 55, we explain the SMTP conversations that occur
between a client and server. Some of this information is repeated here for
completeness.
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If the sending mail server’s resolver successfully obtains the mail server that is
handling mail for the domain of the recipient, the sending SMTP server attempts
to open a connection to the remote (receiving) SMTP server on Port 25. The
usual TCP connectivity of SYN, SYN ACK, and ACK take place.

9.3.2.1 When to use Telnet

You can use the Telnet command to test basic SMTP connectivity, that is, to see if
SMTP is working on your server without the use of your e-mail client. You can
also use it with other TCP/IP services to confirm that you are connecting to the
correct server. This can be done from either an iSeries display or from your PC.
We talked about this in 6.1, “SMTP” on page 55. In this section, we highlight its
use in problem determination.

Normally, when you use TELNET to access a signon screen on a computer, you
are using the well-recognized port 23, which is the default. This time, we use the
SMTP port, which is port 25.

9.3.2.2 How to use Telnet

In this section, you may have to use uppercase, or you may have to use
lowercase. If one format does not work, try the other. Also, try not to make
mistakes in a command line because the SMTP server does not tolerate
backspaces and you will get error code 501—Syntax error.

From an MS-DOS window, type:

TELNET dommaill 25
Select Terminal->Preferences, and select Local Echo.

Follow this process:
1. Type:
HELO BILLSMITH

You are telling the destination computer who you are. The destination
computer responds to you and tells you that it is pleased to meet you.

Type MAIL FROM: FROMUSER@FROMDOMAIN.COM
Type RCPT TO: TOUSER@janal.COM

Type pata

o > 0D

Type the message you want to send, and complete it by typing a period (.) on
a line by itself.

6. The message 250 Message accepted for delivery is received at the TELNET
session.

7. The Domino console shows the message:
02/12/2000 02:46:14 PM Router: Message 0072188B delivered to userX
8. A Notes user receives mail.

9. If mail is sent to a nonexistent user with the local SMTP domain, the Domino
console shows the following messages:

02/12/2000 02:54:29 PM SMTP Server: Message 5D0034E8 received
02/12/2000 02:54:29 PM Router: Unable to deliver message 0072DA0A to
notes.admin@janal.com
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02/12/2000 02:54:29 PM User notes.admin@janal.com not listed in public Name
& Address Book

If you send mail to another domain altogether, the router will try to determine
where to route the mail.

To run the TELNET command from an iSeries command line to the Domino
server, press F4. This will allow you to enter the port number 25.

Note that, if you are using SMTP commands to OS/400 SMTP, you have to enter
the commands in this way (note the angle brackets):

MAIL FROM: <MYNAME.MYDOMAIN>

—— Tips
The TELNET command can also be used to connect to other services. From
your DOS prompt, type:

TELNET popserver.popdomain.com 110 where popserver.popdomain.com is the name
of a POP3 server.

This connects to the POP3 server. This is one way to confirm that the POP3
server is active.

If you are trying to send SMTP mail from a Domino server through the firewall,
you can eliminate the Domino SMTP server by changing your POP3 client to
point directly to the firewall port.

Here is a summary of SMTP commands and return codes used with TELNET to
the SMTP server. You can find additional information in the RFC821 document at:
http://info.internet.isi.edu/in-notes/rfc/files/rfc821.txt

* HELO <domain>: The HELO command is used to identify the sender-SMTP
to the receiver-SMTP. The argument field contains the host name of the
sender-SMTP. EHLO (with H and E reversed) is used to indicate support for
Extended SMTP.

* MAIL FROM:<reverse-path>: The MAIL command is used to initiate a mail
transaction in which the mail data is delivered to one or more mailboxes. The
argument field contains the reverse-path that can be used to return
non-deliverable mail.

* RCPT TO:<forward-path>: The RECIPIENT command is used to identify an
individual recipient of the mail data. Multiple recipients are specified by
multiple use of this command.

e DATA: The receiver treats the lines following the command as mail data from
the sender. This command causes the mail data from this command to be
appended to the mail data buffer. The mail data may contain any of the 128
ASCII character codes. The mail is terminated by a line containing only a
period (.).

* QUIT: This command specifies that the receiver must send an OK reply and
then close the transmission channel.

* RSET: The RSET command specifies that the current mail transaction is to be
aborted. Any stored sender, recipients, and mail data must be discarded, and
all buffers and state tables cleared. The receiver must send an OK reply.
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Here is a list of SMTP reply codes:

211 System status or system help reply

214 Help message: Information on how to use the receiver or the meaning
of a particular non-standard command; this reply is useful only to the
human user

220 <domain> Service ready

221 <domain> Service closing transmission channel

250 Requested mail action okay, completed

251 User not local; will forward to <forward-path>

354 Start mail input; end with <CRLF>.<CRLF>

421 <domain> Service not available, closing transmission channel: This
may be a reply to any command if the service knows it must shut down

450 Requested mail action not taken: mailbox unavailable, for example,
mailbox busy

451 Requested action aborted: local error in processing

452 Requested action not taken: insufficient system storage

500 Syntax error, command unrecognized: This may include errors such
as command line too long

501 Syntax error in parameters or arguments

502 Command not implemented

503 Bad sequence of commands

504 Command parameter not implemented

550 Requested action not taken: mailbox unavailable, for example,
mailbox not found, no access

551 User not local; please try <forward-path>

552 Requested mail action aborted: exceeded storage allocation

553 Requested action not taken: mailbox name not allowed, for example,

mailbox syntax incorrect

554 Transaction failed

9.3.3 NETSTAT

To verify that required applications are running, you can use the Work with
TCP/IP Network Status (NETSTAT) command. On any iSeries command line,

type:
NETSTAT *CNN

The screen shown in Figure 113 appears.
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Work with TCP/IP Connection Status
System: SYSTEMO1
Local internet address . . . . . . . . . . . : *ATLL

Type options, press Enter.
4=Fnd 5=Display details

Remote Remote Local
Opt Address Port Port Idle Time State
_  * * ftp-con > 013:54:54 Listen
_  * * telnet 002:07:03 Listen
_ * * smtp 013:54:34 Listen
_ * * domain 013:54:54 Listen
_ * * domain 013:54:54 *UDP
_ * * bootps 000:01:07 *UDP
_ * * tftp 013:54:39 *UDP
_ * * www-http 013:54:50 Listen
_ * * pPop3 013:54:37 Listen
_ * * 119 004:37:16 Listen
* * 143 004:37:25 Listen

More. ..
F5=Refresh Fll=Display byte counts F13=Sort by colum
Fl4=Display port numbers F22=Display entire field F24=More keys

- J
Figure 113. Work with TCIP/IP Connection Status display

For mail to be routed, SMTP needs to be in listen state. Look for SMTP in the list.
Press F14 to see the port it is listening on, which is default port 25.

Press F11 to see the user that is using the job. As an alternative to pressing F11,
you can select option 5 to display the details.

If your Domino server is configured for native Domino SMTP (*DOMINO), the
user should be QNOTES. If your Domino server is configured for OS/400 SMTP
(*MSF), the user should be QTCP.

If no application is listening to the SMTP port and OS/400 should be listening, try
to start the SMTP server by using the Start TCP/IP Server (STRTCPSVR)
command. On any iSeries command line, type:

STRTCPSVR *SMTIP
Check again if the SMTP server is listening to port 25. If it is not, display the

system operator message queue (use the pspvsc gsysopr command), and look for
error message: SMIP job QTSMTPSRVR ended abnormally

This display can also be useful for POP and LDAP to confirm that the correct jobs
are running.

For more information about the Work with TCP/IP Network Status (NETSTAT)
command, refer to 9.4.1, “NETSTAT command” on page 137.

9.3.4 NSLOOKUP on the iSeries server

NSLOOKUP is an interactive query tool that can be used to retrieve information
from, or test the response of, a DNS server.

More information about this command is available in 9.4.3, “NSLOOKUP
command” on page 142.
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9.3.5 NotesCONNECT

How can you verify that an end-to-end TCP/IP connection can be established
without using the Domino Directory or Notes address resolution logic?

The NotesCONNECT V2.0 TCP/IP Diagnostics Tool can be used for this function.
This tool is available on the Internet from Notes.net at: http://www.notes.net

More information about NotesCONNECT is available in 9.4.6, “NotesCONNECT
diagnostic aid” on page 146.

9.3.6 Communications trace of a line
If you are going to look at spooled files online, you should ensure that your 5250

session is defined to be 132 characters wide.
To run a communications trace, perform the following steps:
1. On the OS/400 command line, type:
STRSST
2. Select option 1 (Start a service tool).
3. Select option 3 (Work with communications trace).

4. Press F6 (Start a trace). To complete the parameters, see the display shown in
Figure 114.

Start Trace
Type choices, press Enter.
Configuration object . . . . . . . tokenline

TYPE v v v e e e e e e e e e 1 1=ILine, 2=Network interface
3=Network server

Trace description . . . . . . . . Comm Trace 1

Buffer gize . . . . . . . . . . . 6 1=128K, 2=256K, 3=2M, 4=4M
5=6M, 6=8M, 7=16M, 8=32M
9=64M

Stop on buffer full . . . . . . . y Y=Yes, N=No

Data direction . . . . . . . . . 3 1=Sent, 2=Received, 3=Both

Number of bytes to trace:
Beginning bytes . . . . . . . . *MAX Value, *CALC, *MAX
Ending bytes . . . . . . . . . *CALC Value, *CALC

- J

Figure 114. Starting the communications trace

5. If you see a Select Options display, select option 1 (All data (no filtering)).

6. To return to the OS/400 command line, press F12 twice. Then, press Enter on
the Exit System Service Tools screen.

7. Run the test scenario causing the issue.

8. To end the communications trace, complete the following tasks:
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a. On an 0OS/400 command line, type:

STRSST

b. Select option 1 (Start

a service tool).

Select option 3 (Work with communications trace).

d. On the Work with Communications Traces menu, select option 2 (Stop

trace).

9. To format and print the collected data, select option 6 (Format and print trace).

Ensure that the parameters are set as shown in Figure 115.

Format Trace Data )
Configuration object TRNLINE
Type LINE
Type choices, press Enter.
Controller . *ALL *ALL, name
Data representation 1 1=ASCII, 2=EBCDIC, 3=*CALC
Format RR, RNR commands N Y=Yes, N=No
Format Broadcast data N Y=Yes, N=No
Format MAC or SMT data only N Y=Yes, N=No
Format UI data only N Y=Yes, N=No
Format SNA data only . N Y=Yes, N=No
Format TCP/IP data only y Y=Yes, N=No
Format IPX data only N Y=Yes, N=No
F3=Exit F5=Refresh Fl2=Cancel
J

-

Figure 115. Format Trace Data

The next screen you see (Figure 116 on page 134) is useful for reducing the
amount of data that you get in the spooled file. You may want to look at data
associated with particular IP addresses or particular ports. For mail
troubleshooting, the interesting ports are 53 (DNS) and 25 (SMTP).
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Select IP addresses to format
Configuration object . . . . : TRNLINE
Typ€ . . . . . « . . . . .. : LINE
Type choices, press Enter.
IPaddress . . . . . . . . . . *ALL *ALL, address
IPaddress . . . . . . . . . . *ALL *ALL, address
Port . . . . . .. 00 25 *ALL, 1-65535
L F3=Exit F5=Refresh Fl2=Cancel )

Figure 116. Select IP addresses to format

10.To view the file QPCSMPRT, on the OS/400 command line, type:

WKRSPLF

— Note

You can use iSeries Help Text for the Select IP addresses to format display.
Note these scenarios:

* If *ALL is specified for both the IP address fields and the port field, all
TCP/IP frames will be formatted.

e |f *ALL is specified for both IP address fields and the port field is specified,
only frames that have a source or destination port that matches the port
specified will be formatted.

¢ |If specific IP addresses are specified for both the IP address fields, only
frames that have source and destination, or destination and source IP
addresses matching those specified will be formatted. This is useful for
formatting all the frames passing between the two systems.

e |f a specific IP address and *ALL are specified in the IP address fields, only
frames that have a source or destination IP address matching the IP
address specified will be formatted. If the port field is also specified, only
frames that have a source or destination IP address matching the IP
address specified and a source or destination port number matching the
port specified will be formatted.

9.3.7 Tracking mail messages

Domino provides tools that you can use to monitor mail. Message tracking allows
you to track specific mail messages to determine if the intended recipients
received them. Mail usage reports provide the information you need to resolve
mail problems and improve the efficiency of your mail network.
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9.3.8 Mail probes

Both Domino administrators and end users can track mail. Administrators can

track mail sent by any user, while end users can track only messages that they
themselves send.

When you configure mail tracking, you can specify which types of information
Domino records. For example, you can specify that Domino won’t record
message tracking information for certain users, or you can choose not to record
the subject line of messages sent by specific users.

Domino records all message tracking information in the Mail Tracking Store
database (MTSTORE.NSF). When an administrator or user searches for a
particular message, Domino searches the Mail Tracking Store database, which is
created automatically when you start the Mail Tracking program on the server.

As shown in Figure 117, several documents about Tools for mail monitoring are

available to help you implement this tool in the Domino R5 Administration Help
database.

# Domino 5 Administration Help - Lotus Notes [_[Olx]

e Edt Wiew Actions & v OnRe @
O\ B documents in ) Mot indexed ﬂﬂ

MAIL ﬂ
rail tracking Search ¥ More ‘

Tools for mail monitoring
Index Search Books Domino provides thies tools that you can use to monitor mail. Message tracking allows vou to track. specific mail

messages to determine if the intended recipients received them. Mail usage reports provide the infarmation yau
b Messaging overview ﬁ need to resolve mail problems and improve the efficiency of pour mail network. Mail probes test and gather
statistics on mail routes.

¥ T ools for mal monitoring
Setling up mall monitoring Tracking mail messages
Tracking a mail message

Generating a mail usage report Bioth Domino administrators and end users can track mall. Administrators can track mail sent by any user, whils
Troubleshaoting toals end users can track only messages that they themselves sent

AR RN

‘when you configure mail tracking, pou can specify which types of information that Domino recards. For
example, you can specify that Domino not record message tracking information for certain users, or you can
choose not to record the subject line of messages sent by specific users.

Domino records all message-tracking information in the Mail Tracking Store database [MTSTORE.MSF). When
at administrator or user searches for a particular message, Domino searches the Mail Tracking Store datsbase,
which is created automatically when you start the Mail Tracking program on the server.

How mail tracking works

1 Create a query to determine whether a specific message arived at ity intended destination or to

determing hawe far it got if delivery failed.

2 Message tracking beging on the starting server. |f the message is found there, the tiacking automatically
cohtinues on the nest server on the route.
3 Step 2 iz repeated on each "next server” until the route ends. Dietailed information is provided about the
processing of the meszage on each server,
Select the message and then check the Delivery Status, which is one of these:
Delivery Status Meaning
Delivered The message was delivered ta a mailbox on the server. The mailbox status
indicates whether the message was read, unread, or deleted. If the mailbox status
iz not read, unread, or deleted. it appears as unknown,
Delivery failed The server attempted to save the message in a mailbox but was unsuccesshul.
The addressee may not exist or the server's disk may be full
In queue The router is processing the message
j Transfermed The router successhully sent the message to the server identified in the next hop LI

Figure 117. Tools for mail monitoring help documents

You an also use the information gathered to produce mail usage reports.

You can monitor your mail network by configuring probes to test and gather
statistics on mail routes.

9.3.8.1 Creating a mail probe

Using a mail probe, you can test and gather statistics on mail routes. To test a
mail route, use the ISpy task. ISpy sends a mail-trace message to the mail server
of the individual that you specify. The probe generates a statistic that indicates
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the amount of time, in seconds, that it took to deliver the message. If the probe
fails, the statistic has the value -1. The format of a mail probe statistic is:
QOS.Mail.RecipientName.ResponseTime.

If the Collect task is running, the Statistics database (STATREP.NSF) stores the
mail probe statistics. In addition, ISpy generates events for probes that fail. You
can set up an Event Notification document to notify you when an event has
occurred. By default, ISpy monitors the local mail server. To monitor other
Domino mail servers, you must create probe documents.

Complete these steps to create a mail probe:

1. Make sure that you start the ISpy task on the server.

—— Starting and stopping ISpy
ISpy is case-sensitive. Therefore, you must enter it exactly as shown below.
Start the ISpy task manually. At the console, enter the command:

load runjava ISpy

Stop the ISpy task. Enter one of the following commands:

® Tell runjava quit
® Tell runjava unload ISpy

2. From the Domino Administrator, click the Configuration tab.
3. Click Statistics & Events->Probes->Mail.
4. Click New Mail Probe.
5. Click the Basics tab, and complete the fields shown in Table 2.
Note: Do not select All Domino servers in the domain will probe themselves.

Table 2. Fields to complete on the Basics tab for a mail probe

Field Enter

Probing servers (source) Enter the server you want the probe to start from or select the
server from the drop-down box.

Target mail address Enter the mail recipient for which you want to check the mail

(destination) route or use the drop-down box to select a recipient from a

Domino Directory or Address Book. Do not enter more than
one individual, and do not enter a group name.

6. Click the Probe tab, and complete the fields shown in Table 3.

Table 3. Fields to complete on the Probe tab for a mail probe

Field Enter

Send interval Enter the probe interval. This is the frequency at which
probes will be sent.

Time out threshold Enter the time out threshold. This is the period the probing
server (source) will wait for a response before logging a
failure.
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7. Click the Other tab. Complete the fields as shown in Table 4, and then click

OK.
Table 4. Fields to complete on the Other tab for a mail probe

Field Enter

Event Select the severity of the event you want to be generated if
the probe fails.

Create a new natification You can set up notification for a custom event. If you click this

profile for this event. button, you will be guided through the process by the Event
Notification Wizard.

Enablement Select the “Disable the probe” field if you want to disable this
probe. You can re-enable it at any time.

9.4 Network troubleshooting

When connectivity is lost, but all other components are working properly, you
need to investigate the network. These problems are usually routed to a separate
network organization to isolate the problem to a router, common carrier service,
or other failing component. Some useful tools include:

e NETSTAT: An OS/400 command for local host TCP/IP information

PING: Used in checking connectivity

NSLOOKUP: Perform DNS name validation

TRACERT: For tracing routes over TCP/IP networks

NotesCONNECT or NPING: An extension to PING that tests for the presence
of the Domino server

Also, don’t forget that the console is a useful source of information and that you
can access it from a 5250 screen or from the Domino Administrator. If clients are
complaining about a lack of server connectivity, you can use the Network Trace
function from their client desktop (click File->Preferences->User Preferences,
and then Ports).

9.4.1 NETSTAT command

You can use the Work with TCP/IP Network Status (NETSTAT) command. On any
iSeries command line, enter NeTsTAT *CNN. Figure 118 on page 138 shows the list
obtained after scrolling through the display several times.

Chapter 9. Troubleshooting e-mail delivery 137



Work with TCP/IP Connection Status
System: AS25
Local internet address . . . . . . . . . . . : *ATLL

Type options, press Enter.
4=Fnd  5=Display details

Remote Remote Local

Opt Address Port Port Idle Time State
* * 10400 000:28:39 *UDP
* * 1352 001:06:16 Listen
* * 500 055:06:02 *UDP
* * 500 055:06:02 *UDP
* * 500 055:06:02 *UDP
* * 5148 055:06:02 *UDP
10.8.6.148 1027 telnet 000:00:00 Established
10.8.62.125 1047 1352 000:02:40 Established
10.8.62.208 1079 telnet 000:01:07 Established
10.8.62.220 1544 1352 000:00:11 Established
10.7.92.37 as-mgtc > 6613 005:30:07 Established

More. ..
F5=Refresh Fll=Display byte counts F13=Sort by column
Fl4=Display port numbers F22=Display entire field F24=More keys

- J
Figure 118. Work with TCP/IP Network Status (NETSTAT) example

In our example, shown in Figure 118, port 1352 is used three times. The Domino
server usually listens on the standard port 1352. In our example, there are two
partitioned Domino servers running on the same iSeries server, each of them
using a single IP address.

The first time that port 1352 appears, it corresponds to a first running partitioned
server, without any connected Lotus Notes client. The second and third
occurrences of port 1352 correspond to the connections for two different users
working at IP addresses 10.8.62.125 and 10.8.62.220.

— Tip

Instead of looking at the connections for all IP addresses defined on the iSeries
server, it is possible to limit the list of connections to one IP address.

After entering NETSTAT *CNN, press F24 (More keys) and then F15 (Subset by
local address). This allows you to select one local Internet address among all
IP addresses defined on the iSeries server.

If your Domino server is using a specific IP address, you need to choose the
specific address in this list. Only connections with a local Internet address
equal to this Internet address are displayed in the list.

Figure 119 shows the detailed connection information for the second user. Notice
that the name of the local host name is the same as the name of the partitioned
Domino server. The observed state is Established.
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Display TCP Comnection Status
System: AS25
Connection identification:
Remote host name . e e e e e e e
Remote internet address e e e e e e e 10.8.62.220

Remote port . . . . . . . . . . . . . L . 1544
Local host name . . . e e e e e e e DOMSVR3
Local internet address e e e e e e e 10.8.62.33
Local port . . . . e e e e e e e e 1352
Associated user proflle e e e o QNOTES
TCP programming interface 1nformatlon:
State . . . . e e e e e e e Established
Connection open type e e e e e e e e e e Passive
Timing information:
Idle time . . . e e e e e e e 000:00:11.937
Last activity date/tlme e e e e e 03/01/00 16:20:16
Round-trip time . . . . . . . . . . . . . . . .079
Round-trip variance . . . . . . . . . . . . . : .052
More. ..
Press Enter to continue.
F3=Exit F5=Refresh F6=Print F9=Command line F10=Display IP options
Fl2=Cancel Fl4=Display port numbers F22=Display entire field
_ J

Figure 119. Display TCP Connection Status details

When connections have been made with the Domino server, the Domino server
SHOW USERS command should show the same number as the number of
connections shown in a NETSTAT command. If the numbers do not match, more
investigation is required.

Performance problems and slowdowns can mislead people into believing they
have a network problem. One specific problem where a “Close-Wait” state has
been encountered is referred to as the “hex session” or “ghost session” problem.
That name comes from the fact that a Domino show users debug command lists
many lines of hexadecimal session IDs without any user identification. If the
Domino server cannot authenticate the users quickly enough as they try to
connect, the user may try again several times and create many more pending
connections. Therefore, the Domino server does more processing because these
sessions are tying up resources and create longer task queues through which the
server must search.

9.4.2 Checking network connectivity

When users describe problems with symptoms, such as “can’t get connected”,
“server not responding”, or “request timed out,” there may be a network problem.
If the difficulty is isolated to only one user, the problem is in the client’s machine
or in their local network environment. If many users report problems, the
investigation should begin from the server and go out to the network. Mail routing
problems may be an indication of network problems between servers.

9.4.2.1 Using PING

When a user reports no connectivity or a loss of connectivity to the Domino
server, the first test is for the end user to issue a ping command pointing to the
host in question by a numeric IP address from an MS-DOS or PC session.
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The specific options used in this example are to send a 1024-byte test frame 100
times (see Figure 120). If the number of bytes returned decreases during this
test, it indicates a network congestion problem. This approach cannot be used
from the server because the bytes returned by the target are not shown (Figure
122).

C:\>ping domsvr3
Pinging DOMSVR3 [10.8.62.33] with 32 bytes of data:

Reply from 10.8.62.33: bytes=32 time=4ms TTL=62
Reply from 10.8.62.33: bytes=32 time=4ms TTL=62
Reply from 10.8.62.33: bytes=32 time=5ms TTL=62
Reply from 10.8.62.33: bytes=32 time=3ms TTL=62

Ping statistics for 10.8.62.33:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = 3ms, Maximum = 5ms, Average = 4ms

C:\>
N\ J

Figure 120. Ping from a Windows 95 client

If this test succeeds, try to ping the remote client from the server. First, obtain the
TCP/IP address of the client machine by having the user issue the appropriate
command for their system. For example, from Windows NT, issue the rpconrFIG
command, as shown in Figure 121. The WINIPCFG command can be used on a
Windows 95 or Windows 98 workstation.

. . N
C:\>ipconfig
Windows NT IP Configuration
Token Ring adapter IBMIRPI1:
IP Address. . . . . . . . . :10.8.62.150
Subnet Mask . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . : 10.8.62.2
k J

Figure 121. Results of the ipconfig command from a Windows NT client

Then, you can use the ping command on the iSeries server. See Figure 122 for
an example.
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Display All Messages
System: AS25
Job . . : QPADEV000Q User . . : RBOUTAUL Number . . . : 154241

3>> PING RMISYS('10.8.62.220")
Verifying comnection to host system 10.8.62.220.
PING reply 1 from 10.8.62.220 took 52 ms. 256 bytes. TTL 126.
PING reply 2 from 10.8.62.220 took 5 ms. 256 bytes. TIL 126.
PING reply 3 from 10.8.62.220 took 5 ms. 256 bytes. TIL 126.
PING reply 4 from 10.8.62.220 took 4 ms. 256 bytes. TIL 126.
PING reply 5 from 10.8.62.220 took 4 ms. 256 bytes. TIL 126.
Round-trip (in milliseconds) min/avg/max = 4/14/52
Cormection verification statistics: 5 of 5 successful (100 %).

Bottom
Press Enter to continue.

F3=Exit F5=Refresh  Fl2=Cancel F17=Top F18=Bottom
- J

Figure 122. Results of the ping command from a server

Success with the ping command verifies that a path to the client is clear and that
you can communicate with IP through network routers. At this point, we suggest
that the workstation ping its own numeric IP address. If this test fails, TCP/IP is
not properly configured on the client’'s machine and needs to be fixed.

If the response times displayed in the ping command are not consistent, the
network may be congested.

The final two verifications of the TCP/IP and Domain Names Server setup are:
1. Ping the server from itself using the DNS alias name, such as DOMMAIL1.
2. Ping the server from the workstation the same way.

Failures here should be referred to the network support group. We recommend
that the server host alias names should be the same as the Domino Notes server
names.

9.4.2.2 Resolving ping command problems
A host may fail to respond even after several ping commands for any of the
following reasons:

* The host is not listening to the network.

e The host is inoperative, or some network or gateway leading from the user to
the host is inoperative.

* The host is slow because of activity.
* The packet is too large for the host.
The echo request sent by the ping command does not guarantee delivery. More

than one ping command should be sent before you assume that a communication
failure has occurred.
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Use additional ping commands to communicate with other hosts in the network to
determine the condition that is causing the communication failure. However, you
should know the network topology to determine the location of the failure.

Issue the ping commands in the following order until the failure is located:

1. Send a ping command to your local host. A successful ping command sent to
a different host on the same network as the original host suggests that the
original host is down or is not listening to the network.

2. Send a ping command to a host other than your local host on your local
network.

3. Send a ping command to each intermediate node that leads from your local
host to the remote host, starting with the node closest to your local host.

If you cannot get echoes from any host on that network, the trouble is usually
somewhere along the path to the remote hosts.

Direct a ping command to the gateway leading to the network in question. If the
ping command fails, continue to test along the network from the target until you
find the point of the communication breakdown.

9.4.3 NSLOOKUP command
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TCP/IP name resolution problems are commonly reported by such messages as
Notes server is not a known host Of Server not responding.

If you are using a hosts file, check for illegal characters. Make sure there are no
illegal characters, such as a space or a letter, in the numeric IP address. Each
section of the dotted decimal numeric IP address is no longer than three
numbers, and there are four sections to an address, such as 10.8.62.33.

Make sure there are no illegal characters in the Names fields. Only alphabetic
characters, numbers, and dashes should appear. Spaces and underscores are
not allowed according to DNS standards.

Check for any recent changes made to the hosts file and confirm that the
information in the hosts file is correct. All the target machines that a computer
may contact must be defined in the local hosts file.

The Start DNS Query (NSLOOKUP) command, on the iSeries server, uses the
iSeries TCP/IP settings to determine the search order and source of DNS
information.

You can verify that a DNS server is responding correctly before you configure
your system to use it. You can also retrieve DNS information about hosts,
domains, and DNS servers.

NSLOOKUP displays the name and IP address of the default name server. This is
taken from option 12 of the Configure TCP/IP (CFGTCP) command. You can
specify a different name server. To use NSLOOKUP, complete the following steps:

1. On a command line, type nsLookup and press Enter. The name and IP address
of the default name server are displayed. This is taken from option 12 of the
CFGTCP.
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2. You now have to specify the type of lookup you want to perform. Type seT
TYPE=A and press Enter. This means you are doing an A record lookup. Enter
the host name of an iSeries or Domino server. You have to type the fully
qualified name if you are looking for the A record for the Domino server. This
is because the iSeries only adds its own domain suffix when searching the
DNS for a match.

3. Type ser TYpE=Mx and press Enter. You can now search for MX records.
4. Type vELP and press Enter to see the commands that you can use.

5. If you want to use NSLOOKUP with a DNS other than the one defined in
CFGTCP option 12, use F4 to prompt when you start NSLOOKUP and you
can enter an alternative DNS server.

6. Type Exit and press Enter to leave NSLOOKUP.

— Note

It is important to check the option 12 settings of the Configure TCP/IP
(CFGTCP) command.

The value of the Domain Name Server Retry (DMNSVRRTY) parameter should
also be checked. It consists of two elements: number-retries and time-interval.
The first element, number-retries, specifies the number of additional attempts
made to establish communication with each Domain Name Server (DNS)
specified in the INTNETADR parameter, in the event that the first attempt fails.

We recommend that you specify a value for the number of retries lower than 5.

From the Domino point of view, to verify that the Domino server has the correct
names configured, check the Server document in the Domino Directory. Make
sure the Domino server's common name in the TCP port’s Net Address Field is
the same as the TCP host name. If this is not the case, a hame resolution alias is
required in either the HOSTS file or in the DNS table.

If changes are required to the server document, restart the Domino server and
verify that the changes have taken effect.

As shown in Figure 123 on page 144, we defined an alias in the DNS because the
Domino server’'s common name was not the same as the TCP host name. Our
host name as defined in the hosts table was DOMINOS3, while the Domino
common name was domsvr3.site1.company.com.
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9.4.4 CyberKit

ﬁ Adminiztration 2} tWelcome o Doming Administrator RS

People & Groups I Filez I Server I Meszaging I Fieplication I Configuration

roy
Server: DOMSYR3/Forum Test

v Jj Server

] | Currertt Server Document

Use Directory on: IEurrent Server

7 Edit Server & Web...

All Server Documents SERVER: DOMSVR3/Forum Test 2
Configurations "
Caonnections Baszics l Security l Parts l Server Tasks l Internet Pratocaols l MTAs l Mizcellaneous | Transactional Logging ti
Programs
External Domain Metwark In Maotes Network Ports l Intermet Ports l Prosies l
i Messaging
g Jj:ﬁ Feplication
¥ EI:]'] Diirectory TCRIP TCP METWORK1 domsvrd.sitel.compa EMNABLED
b i web (EHEE
v Statistios & Events DOMSYR3 DISABLED
» El Cluster DOMSYR3 DISABLED
g @ DECS Administrator DOMSYR3 DISABLED
» LI Miscellaneous DOMSVR3 DISAELED
DOMSYR3 DISABLED
DOMSYR3 DISABLED
DOMSYR3 DISABLED

Figure 123. Net address in a Domino server document

The CyberKit toolkit is available on the Web at http://www.tucows.com Or
http://www.cyberkit.net. This tool is known as postcardware, which means that
the author does not want money, just a postcard.

You can use CyberKit for three networking tools that we have already mentioned:

* Ping
* TraceRoute
* NSLookUp (Name Server LookUp)

To use this tool, follow these steps:
1. Select Start->Programs->CyberKit->CyberKit.
You need to know the IP address of your DNS.

a. You can see in Figure 124 that you can run Ping from this tool. We spoke
about Ping in the previous section. PING stands for Packet Internet Groper.
Ping uses the Internet Control Message Protocol (ICMP) to determine if the
network connection to a remote host is available at the IP Level.
Successful Pings indicate that an IP Connection is available. A successful
Ping does not mean that e-mail is functioning. SMTP uses TCP while Ping
uses ICMP. Try pinging one of the iSeries servers. Ping is also available as
an iSeries command.

b. TraceRoute tracks the path that packets take across the network.
TraceRoute uses the UDP Protocol, so TraceRoute may not be able to get
through firewalls, depending on how filtering is configured on the firewall.
TraceRoute tells you the route from your PC to another IP interface. The
tool doesn’t do any investigation of its own. It is reporting back what routers
and other hosts tell it.

c. Finger, Whois, and Quote of the Day (QOD) require appropriate servers.
The iSeries server does not provide these services.
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d. NSLookUp is extremely useful. It can be used to report the IP address of a
host as reported by a DNS server and to advise of the mail exchanger
associated with a domain. This may help you identify that you have some
errors in your DNS.

2. Click the NSLookUp tab.

3. Type the Name Server address in the Name Server field and the Domino
server name (DOMMATL1.JaNA1.coM) in the Query field. Select A-Address for
Type of Search, and click Go.

#1 NSLookUp =] e
File Edit Options “iew Help
PFing I TraceHouteI Finger I whals  MSLookUp | QoD I Time I NetScannerI Al I v @ @@
Go
Mame Server: |1D.1.1.2 j g‘l -
Stop |
Lueny: Idommail‘l.iana‘l.com j
LClear |
Type of Search: IA - Address j
Frotocol
’7 & UDF O TCR
|F|ead_l,l i

Figure 124. NSLookUp

4. You can maximize the display that appears to see the results in a single
screen.

5. Type ns26.itsoroch.ibm.comin the Query field, and click Go.

6. Change Type of Search to a PTR record and type the IP address of a host in
the Query field. You are returned the host name.

7. Change Type of Search to an MX record. Look for the mail exchanger
associated with a domain. Type janai.cominto the Query field and click Go.
You can use this tool to determine a mail exchanger and then use the A type
search to identify the IP address for the host.

9.4.5 Tracing routes with TRACERT

Tracing a route through the network can be done from the client with the
TRACERT command. This can help you understand the slow response time you
may experience.

In the example shown in Figure 125 on page 146, the path taken to this server
went through seven hops. Performance problems can be introduced by network
configuration changes made without the awareness of the Domino administrator.
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4 N
C:\>tracert 10.24.1.154
Tracing route to system2.siteb5.company.com [10.24.1.154]
over a maximum of 30 hops:
1 2 ms 1 ms 1 ms system5.company.com [10.8.62.1]
2 2 ms 1 ms 1 ms systeml0O.site3.company.com [10.8.101.25]
3 58 ms 63 ms 57 ms 10.2.105.45
4 100 ms 102 ms 102 ms 10.2.1.45
5 210 ms 214 ms 209 ms 10.2.74.54
6 231 ms 230 ms 228 ms 10.1.255.74
7 235 ms 238 ms 237 ms system2.site5.company.com [10.24.1.154]
Trace complete.
J

Figure 125. Tracing the network route from a Windows 95 workstation

9.4.6 NotesCONNECT diagnostic aid
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Ping only uses IP/ICMP protocol to test a network connection. There is no
application-specific protocol or data exchanged during the connection.

An extension to ping called NotesCONNECT (or NPING) is available and is
supported on both Windows NT and Windows 95 and 98. Both a graphical
interface and a command-line version of the tool are available.

The NotesCONNECT V2.0 TCP/IP Diagnostics Tool is available on the Internet
from Notes.net (http://www.notes.net, |00k under Iris Sandbox). NotesCONNECT
is also described in a Lotus Support Knowledge Base document NotesCONNECT
Utility for Use in Troubleshooting IP Connectivity (Knowledge Base document
2755).

NotesCONNECT (NPING) is a TCP/IP diagnostics tool designed to verify that a
service on a given machine is available. This is accomplished by establishing an
end-to-end TCP/IP connection with the target host or application without using
the Domino Directory or address resolution logic. This tool requires that Notes be
installed on the local machine.

NPING establishes the connection with TCP/IP rather than IP or ICMP, which
ping uses. There is no application-specific protocol or data exchanged during the
NPING test. It simply connects and disconnects. This permits the tool to go into
the Notes TCP/IP Interface (NTI) layer.

This tool is ideal for determining if an TCP/IP connectivity problem is Notes
related or an IP infrastructure problem. This connection that is established is a
TCP/IP connection, as opposed to PING, which uses an IP connection over
ICMP. No application or service specific protocol or data is exchanged during the
ping connection.

The features of NotesCONNECT include:

* A command-line version of NotesCONNECT called npingcl.exe
» Target Server History List
* Target Server Type-ahead
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For more information, see the /RIS Today article “Testing TCP/IP connections
with NotesCONNECT” by Barbara Burch. This article can be viewed online at:
http://www.notes.net/today.nsf

In the Archives section, click Perform a full-text search of all Iris Today
articles, and search for “Testing TCP/IP connections with NotesCONNECT”. The
article was last updated 16 June 1997.

Download nconnect.exe, and run it in your Notes executable directory. The
nconnect.exe is a self-extracting zip file. Next run the nping.exe file.
NotesCONNECT uses Notes DLLs and needs access to your NOTES.INI file.

—— Note

NotesCONNECT does not connect through proxies (only to the proxy port) and
does not connect to UDP ports.

NotesCONNECT is not an officially marketed Lotus product. It is presented as
a troubleshooting utility only. Therefore, its use is not directly supported by
Lotus Support analysts.

For the example shown in Figure 126, nping was started without any parameters,
so the GUI interface prompted the user for the information. The address or DNS
name of the target server is specified, the number of times to perform the test is
selected with a slider bar, and the specific service is selected from a drop-down

menu. The results of the test appear in the message box.

% MotesCONNECT

Target Host Mame or [P Address Target Port Mumber Connect I

domsyrd RARRIES i |
[E=ample: host. domain.nam or 127.0.0.1)
Cluit |

Connection Count Service List

I INHPE 'l %
1 3 5
***** Performing DS Lookup: domsyr3 [RTT: 14ms] ;I
Connecting...

[1] Conhect reply from: 10.8.62.33: 1352 [RTT: 710mg]

xxxxx

Status: 1 of 1 Connections Completed, Total Time to Connect: 724ms

Figure 126. NotesCONNECT GUI with results of the test

Chapter 9. Troubleshooting e-mail delivery 147



148  Lotus Domino for AS/400 Internet Mail and More



Chapter 10. Extending the integrated file system with UDFS

Most of following information is taken from AS/400 Disk Storage Topics and
Tools, SG24-5693. The directory structure used has been changed to reflect the
use of User-Defined File System in a Domino context.

10.1 An overview of UDFS

© Copyright IBM Corp. 2000

Although most people leave their iSeries servers with all the disks allocated to the
single level storage System Auxiliary Storage Pool, ASP1, some do allocate disks
to additional ASPs that they manage themselves. These are known as User
ASPs. It is possible to use a User ASP to store Domino databases by defining a
User-Defined File System.

The 0S/400 User-Defined File System (UDFS) is a storage mechanism that
works in the same way as the integrated file system. The UDFS provides a
hierarchical directory structure, is optimized for stream file I/O, and supports
case-sensitive names, links, and sockets.

While an integrated file system directory can be created only in the system ASP, a
UDFS and its directory structure can be created in any available ASP. This makes
it possible for integrated file system users to use the Hierarchical Storage
Management (HSM) type of ASP balance function in OS/400 V4R4 to manage
integrated file system stream files, because HSM balance works only in user
ASPs.

In effect, the UDFS was created in OS/400 V3R7 as an extension to the original
integrated file system introduced in OS/400 V3R1. If you are familiar with UNIX,
the UDFS is similar to what is called the Mounted File System concept.

A UDFS object must always be created in the directory path of \DEV\QASPnn,
where nnis the ASP number in which UDFS data is stored. Once created, a
UDFS object must be mounted onto an existing integrated file system directory
structure for use. When mounted, the UDFS assumes the target directory path
name. Use this name to access its data.

Use a UDFS in the same manner that you use an integrated file system directory.
Unmount it when you no longer need access to its data. With the file system
unmounted, the data is inaccessible from the integrated file system name space.
The data remains intact in the UDFS object itself.

You can save and restore UDFS data by using the OS/400 SAV and RST
commands in the same manner as you do with other integrated file system
components. Refer to OS/400 Integrated File System Introduction, SC41-5711,
for more information on UDFS.

It is possible to extend the use of a UDFS object to be the whole Domino data
directory.
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10.2 Disk compression

Another use for User ASPs and Domino is to archive data to hardware
compressed disks. Since V4R3, integrated hardware disk compression has been
available.

Disk compression is a technology that increases the apparent capacity of disk
storage devices by encoding the data to take up less physical storage space on
disk. Disk compression is performed in the disk subsystem controller and does
not affect the iSeries processor. The compression and decompression of data is
performed automatically on each write command and read command,
respectively. With the exception of a performance impact, disk compression is
transparent to applications. The performance of compressed disk drives is slower
than the performance of non-compressed disk drives. This is due to the overhead
of compression and decompression, and the variations in the length of the data
that is written to disk.

You can compress only disk units associated with user ASPs, and you need
compression-capable storage controllers such as the 2741, 2748, 9754, or the
6533. Disk compression is only allowed on 66xx, 6713, and 6714 devices. For
more information about disk compression, see 0S5/400 Backup and Recovery,
SC41-5304. You can use disk compression in conjunction with User Defined File
Systems and the archive capabilities of Domino to archive seldom-used
databases. Information about archiving Domino databases and data can be found
in the Notes 5 user help database (help\help5_client.nsf).

10.3 Creating and mounting a UDFS
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This section describes a sample procedure to create a UDFS in ASP02 and
mount it for use. Two views are presented: Operations Navigator (as the main
approach) and a Command Language (CL) equivalent (for those who use a 5250
session).

Note: In a Windows 95/98 environment, an integrated file system directory is
sometimes addressed (that is, referred to) as a folder.

1. To create a UDFS on your iSeries server, open Operations Navigator and
expand File Systems->Integrated File System->Root->dev, as shown in
Figure 127.

| Enviranment; by AS/400 Connections

- Datahase ;l
5 File Systerns

Figure 127. Expanding the Integrated File System group

Under the dev folder, QASPnn folders correspond to each ASP that exists on
the system. The QASPnn directories are automatically created when ASPs
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are added to the system. There are three ASPs in our example: ASP0O1,
ASP02, and ASPO03.

2. To create a new UDFS object in ASP02, right-click QASP02. On the pop-up
menu that appears, select New UDFS, as shown in Figure 128.

2-E Integrated File Systerr

=23 Root
223 dev
&3 QASPO1
R O)/\SPO?
&[0 QASPO3 Explore
=+ home Open
B+ trp Create Shortcut
-1 et Filter...
-3 usr
Hr -, |

Figure 128. Creating a new User-Defined File System in ASP 2

3. In the New User-Defined File System window, as shown in Figure 129, enter
the name of the new UDFS and its description.

New User-Defined File System m
Auxilliary storage poal: YodenA QASPO2
UDFE name: Imyudfs
Description: |My udlfs in ASP 2
Auditing value: IUSB system value =

Defaultfile format:

[T Case sensitiva file nameas

oK I Cancel Help

Figure 129. Specifying UDFS details

If you want all files in the UDFS to be addressed uniquely by case-sensitive
names, select the Case sensitive file names box. For example, AbCfile and
abcfile are different files if case-sensitivity is enabled. Click OK when the
prompts are completed.

Once created, the newly created UDFS object appears on the right side of the
Operations Navigator window.

A CL command equivalent to this step uses the Create UDFS (CRTUDFS)
command from the OS/400 command line, as shown in Figure 130 on page
152. CRTUDFS is shown with its parameters prompted.

Chapter 10. Extending the integrated file system with UDFS 151



152

-

. N
Create User-Defined FS (CRTUDFS)
Type choices, press Enter.
User-defined file system . . . . UDFS > "\dev\gasp02\myudfs.udfs"
Public authority for data . . . DIAAUT *INDIR
Public authority for object . . OBJAUT *INDIR
+ for more values
Auditing value for objects . . . CRIOBJAUD *SYSVAL
Additional Parameters
Case sensitivity . . . . . . . . CASE *MONO
Default file format . . . . . . DFTFILEFMT *TYPE2
Text 'description' . . . . . . . TEXT > 'My UDFS in ASP 2'
J

Figure 130. CRTUDFS command

4.

To create an integrated file system directory onto which the UDFS object will
be mounted, right-click the Root file system, and select New Folder. Specify
\domino\dommaill\moredirs as the name of the new integrated file system
directory. Click OK to create a new integrated file system directory named
moredirs in the Domino server data directory. This directory is used to map the
file system in the user ASP to the integrated file system root file system.

A CL command equivalent to this step is:
MD ' /domino/dommaill/moredirs’
Note: Alternative CL command names to MD are MKDIR and CRTDIR.

Our testing showed that, although ownership of this new directory is with the
user who created it, user QNOTES has all rights to the directory. We did not
have to change ownership for the directory for it to be used by Domino.

Now mount the UDFS to the newly created integrated file system directory.

Right-click the newly created UDFS object (myudfs.UDFS). Select Mount in
the pop-up menu that appears, as shown in Figure 131.
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| Ervironment; by A5/400 Connections | lsosue: QASPOZ
»| [ UDFS Name Where |

e myudts. UIDF S
P !

a2 File Systems

Ermissions
Delete
N Ral == sc il Mount User-Defined File System - As26 EHE

UDFS to maunt:
I\dev\QﬁSPDZ\myudfs.UDFS

Diirectory to mount UDFS over:

I\domino\dommail‘l Smoredbs

Access:
¢ Read only

% Read/wiite

ak Cancel Help

Figure 131. Mounting a UDFS onto an integrated file system directory

In the Mount User-Defined File System window that appears, specify the
integrated file system directory path on which to mount the UDFS (it is
\domino\dommail1\moredirs in our example). Alternatively, click the Browse
button to bring up a graphical directory tree of the system, and select the
integrated file system directory of your choice. Then select the access type as
read only or read/write. Click OK to finish.

A CL command equivalent to this step uses the mount command from the
0S/400 command line, as shown in Figure 132. The MOUNT command
parameters prompted.

-
Add Mounted FS (MOUNT) )
Type choices, press Enter.
Type of file system . . . . . . TYPE > *UDFS
File system to mount . . . . . . MFS > "\dev\gasp02\myudfs.udfs'
Directory to mount over . . . MNTOVRDIR > '\domino\dommaill\moredbs'
Mount options . . . . . . . . . OPTIONS 'rw'
Code page: CODEPAGE
Data file code page . . . . . *BINARY
Path name code page . . . . . *ASCIT
- J

Figure 132. MOUNT command

Now the myudfs UDFS has the Where Mounted field filled with
\domino\dommail1\moredbs as its mounted position. When the UDFS is
unmounted, the Where Mounted field is empty.

6. Right-click the myudfs.UDFS, and select Properties to display various
properties of the UDFS object as shown in Figure 133 on page 154.
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| As2E: QASPO2

| ‘where Mounted

| Type | Description

UDFS Mame
R= iz UDES
Unmount

Permizzions

WElete
Hename. .

Sdomino./dommaill fmare. .

Uszer Defined File 5. My udfs in ASP2

myudfs UDFS Properties - As26 E
UIDFS name: hdeviQASPO2myudts UDFS
Description: My udfs in ASP2
Status: Moumted

Directony: dominodommaillymoredbs
Owiner: JMIDDLE
Code page: ar
Default file farmat: Type 2 stream files
I | Ease sersitive e names
ITI Cancel Help

Figure 133. Displaying UDFS

A CL command equivalent to this step uses the Display User-Defined FS

properties

command entered on the OS/400 command line, for example:

DSPUDFS ’\dev\gasp02\myudfs.udfs’

As long as the UDFS object is mounted, any stream files placed in the integrated
file system directory \domino\dommail1\moredirs are stored in the ASP02 disk

space of the \dev\qasp02\myudfs.udfs object.

Figure 134 shows creating a new database in the subdirectory moredirs, which
will put it into the UDFS. If you display the files in moredirs while the UDFS object
is mounted (from Operations Navigator or WRKLNK), you will see the databases
there. If you unmount the UDFS, there will be no files shown in moredirs.

Server Idommail‘l j QK I
Title: IEustomer Information Cancel |
File: Mame: Imoredbs\cust gl Help
Encryption... | Size Limit... |
[~ Create full test indes for searching AdﬁanCEd---l

Template Server... | Local

[Databasze Analysiz
[atabaze Library
| D'ezign Synopsiz Template

Local Document Cache
Lotuz SmartSuite Library [5.0]

About.... | digcawbi.ntf

™ Show advanced templates

[HED]

H I eh N
Doc Library - Motes & 'wWeb [R5.0)

¥ Inherit future design changes

||

Figure 134. Creating a new Domino database in a UDFS
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In the same way, you can create and mount a UDFS object onto an IFS directory
to hold all the data for a Domino data directory. Run the Configure Domino Server
(CFGDOMSVR) command using the IFS directory. The data will physically be
located in the user ASP.

Unmount and delete the UDFS in the same manner that you create and mount it.

In a 5250 session, the GO CMDUDFS menu provides access to help you with
available commands for UDFS manipulation, as shown in Figure 135.

/CMDUDFS User-Defined FS Commands )

Select one of the following:

Commands
1. Create User-Defined FS CRTUDFS
2. Delete User-Defined FS DLTUDFS
3. Display User-Defined FS DSPUDFS

Related Command Menus
4. Mounted File System Commands QDMFS
5. Network File System Commands QDNFS
N J

Figure 135. CMDUDFS menu

10.4 UDFS considerations

To make good use of UDFS, you should understand these points:

* You choose to mount the UDFS object on an existing integrated file system
directory. However, all current data in that integrated file system directory, if
there is any, is inaccessible as long as the UDFS is mounted onto it. The data
still exists. The integrated file system data is accessible again after you
unmount the UDFS object from the integrated file system directory.

In general, create an empty integrated file system directory just for the
mounting of a UDFS.

* The mounting of a UDFS object does not survive an IPL of the machine. In
case you need a “virtually permanent” mounting of a UDFS object, include the
MOUNT command in the IPL start-up program, specified in the system value
QSTRUPPGM.

Be aware of the following considerations for making a successful mount
during an IPL:

— By default, the public authority of the MOUNT command is *EXCLUDE.
Since the OS/400 start-up program named in QSTRUPPGM runs under the
QPGMR user profile, add a private authority of *USE for QPGMR to the
MOUNT command object. Or use a proper owner or adopted authority
when you compile the start-up program.

— A user profile needs the special authority of *IOSYSCFG to run the
MOUNT command successfully. Add special authority (*SPCAUT) to the
QPGMR user profile. Or, use a proper owner or adopted authority when
you compile the start-up program.

* When you mount a UDFS object to an integrated file system directory, the
target integrated file system directory must not be in use at that moment.

Chapter 10. Extending the integrated file system with UDFS 155



156

Otherwise, you receive an object in use message, and the mount operation
ends in failure. The same holds true for the unmount operation.

An example of an integrated file system directory being in use is when a PC
user maps a network drive to this directory through the AS/400 NetServer
function. Use the AS/400 NetServer windows to end all the sessions that are
using the directory to discontinue use.

You may need to end the Domino server to unmount the UDFS object.

Recommendation

Whenever possible, add the MOUNT command in the start-up program to
help ensure that the directory is accessible.

* Use the SAV command to save the entire UDFS object. Specify a full directory
path name for the save device as shown in Figure 136.

Save Object (SAV)

Type choices, press Enter.

Device . . . . . . . . . . . .. DEV > '\gsys.lib\tap0l.devd'

+ for more values

Objects: OBJ
Name . . . . . . . . . . . .. > "\dev\gasp02\myudfs.udfs'
Include or omit . . . . . . . *INCLUDE
+ for more values
Directory subtree . . . . . . . SUBTREE *ATL,
Save active . . . . . . . . .. SAVACT *NO
Output . . . . . . . . . . . .. OUTPUT > *print
Type of output information . . . INFTYPE *ALL,
N\ J

Figure 136. Saving UDFS

Only an unmounted UDFS object can be saved directly. Or you can save from
the integrated file system directory while the UDFS is mounted. However, in
this case, the UDFS file system information itself is not saved. This means
that, although you save the integrated file system directory and its contents,
you lose the identity of the source UDFS object. Therefore, a direct save of
UDFS is preferred.

With this information, you are now ready to put the UDFS to its practical use for
managing the disk storage of stream files.

For further information on UDFS, refer to the Information Center CD, SK3T-2027,
shipped with your iSeries server or the iSeries 400 Information Center at:

http://www.iseries.ibm.com/infocenter
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Chapter 11. Directories

Domino contains support for a number of different directories. This chapter
discusses:

e Domino Directory

* Lightweight Directory Access Protocol
e Directory catalog

 Directory assistance

Information about all these topics from both a client and a server perspective can
be found in Getting the Most From Your Domino Directory, SG24-5986 (see
Appendix D, “Related publications” on page 219, for availability information). This
is not an iSeries-specific redbook.

11.1 Domino Directory

The Domino Directory serves two purposes. It is a directory of information about
users, servers, groups, and other objects. It is also a tool that centralizes
administration of the Domino system. It contains documents that control directory
services, manage server tasks, and define server-to-server communication.

Domino automatically creates some documents when you perform certain
administrative tasks. For example, Domino creates a new Certifier, Server, or
User document when you register a new certifier, server, or user.

Other documents are created manually as and when you need them. For
example, in 4.3, “Global Domain document” on page 24, we describe how to
create Global Domain documents to support multiple SMTP domains.

We discuss a number of different document types and the use of the Domino
Directory throughout this redbook.

11.2 Lightweight Directory Access Protocol

© Copyright IBM Corp. 2000

LDAP stands for “Lightweight Directory Access Protocol”. In 1988, the
Consultative Committee on International Telephony and Telegraphy (CCITT),
created the X.500 standard, which became ISO 9594, Data Communications
Network Directory, Recommendations X.500-X.521 in 1990, though it is still
commonly referred to as X.500. X.500 organizes directory entries in a
hierarchical name space capable of supporting large amounts of information and
specifies that communication between the directory client and the directory
server uses the directory access protocol (DAP). However, as an application
layer protocol, the DAP requires the entire OSI protocol stack to operate.
Supporting the OSI protocol stack requires more resources than available in
many small environments. Therefore, an interface to an X.500 directory server
using a less resource-intensive or lightweight protocol was desired. LDAP was
developed at the University of Michigan as a lightweight alternative to DAP (thus
the name LDAP). LDAP requires the lighter weight and more popular TCP/IP
protocol stack rather than the OSI protocol stack. LDAP also simplifies some
X.500 operations and omits some esoteric features.
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LDAP defines a communication protocol. That is, it defines the transport and
format of messages used by a client to access data in an X.500-like directory.
LDAP does not define the directory service itself. However, when referring to a
directory that can be accessed using LDAP, the directory is usually called an
LDAP directory. Therefore, LDAP directories can be implemented in many
different ways. IBM implements cross platform LDAP directories using DB2 and
Lotus Domino.

Lightweight Directory Access Protocol (LDAP) uses TCP/IP to allow clients to
access directory information. It can be used by Browser clients to access the

Domino Directory to retrieve addresses. It will return the names in SMTP form
rather than in Notes form.

It is important to note that LDAP directory lookups are not the same as a Notes
client lookup of a Domino Directory (Name and Address Book). E-mail addresses
are returned in SMTP format, not Notes format.

For more information about LDAP, see Understanding LDAP, SG24-4986, and
LDAP Implementation Cookbook, SG24-5110. We are going to cover only
Domino as an LDAP server, but the iSeries server can also be an LDAP server.
See V4 TCP/IP for AS/400: More Cool Things Than Ever, SG24-5190, for more
information.

11.2.1 Configuring LDAP

When you configure a Domino server, you can include the LDAP service, and it
automatically starts when the server starts. LDAP listens on port 389. If you did
not configure it initially, you can either add it to the server by using the Change
Domino Server (CHGDOMSVR) command or start it directly from the Domino
console by typing 1oad 1dap. Starting the task interactively will not add it to the
ServerTasks entry in the NOTES.INI file. Use option 13 on the Work with Domino
Servers (WRKDOMSVR) command to edit NOTES.INI and ensure that the LDAP
task starts each time the Domino server starts by adding the service to the
ServerTasks= line.

To allow a directory search, the LDAP server must be started on the Domino
server. Verify this by performing the following steps:

1. On an iSeries command line, enter the command Work with Domino Servers
(wrkDOMSVR) and press Enter.

2. Select option 9 (Work server jobs) for the server, and press Enter.
3. Check that the LDAP task is running.

4. You can also use the NETSTAT *cNN command to confirm that the task is
listening on port 389.

5. Press F3 to return to a command line.

You can also use the Domino Administrator to confirm that the LDAP task is
runnning by viewing the tasks under the Server tab.

It is possible for a Domino Administrator to define a User Setup Profile that
includes information about LDAP accounts. This means that each user created
will already have that information defined in the desktop. For more information
about setup profiles, see 7.3, “Registering users using a setup profile” on page
76.
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If the user already exists and they want to use LDAP, add the necessary directory
account information for the LDAP server, for example email2 to the Notes client,
by following these steps:

1. Select the Address Book icon from the bookmarks bar as shown in Figure
137.

{'1‘ Welcome - Lotus Notes

File Edit iew Create Actions Test

9 Welcome
Iz

Mail

Address Book
\ 1 MewMer

Lot

Figure 137. Address Book icon

2. Select Create->Account from the pull-down menu.

3. Enter 1Tso2 for the Account name email2.itso2.com for the Account server
name. Leave the rest as default.

Note: The Account name can be anything. The Account server name is the
TCP/IP name of the LDAP server.

4. Click Save and Close.

5. Press Esc to close the Address Book.

11.2.2 Using LDAP
To use LDAP, follow these steps:

1. From a mail file, select the New Memo option to create a mail message (or
select Create->Memo from the pull-down menu).

2. Click the Address button to look up an address.

3. From the Look in drop-down box, select itso2. Search for the required entry
by typing part of the name. Figure 138 on page 160 shows an example. ITSO2
is an LDAP directory. Add the required user to your To: list, and click OK.
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Figure 138. LDAP lookup

4. Select any other users from other directories.
5. Type the note, and send it.

11.3 Directory catalog

Directory catalog is a new feature of Domino Release 5. It consolidates entries
from one or more Domino directories into a single directory catalog database. It
contains the most frequently requested information about each entry in
compressed form, so it requires significantly less space and offers faster lookup
compared to the standard Domino Directory. Creating a mobile directory catalog
is beneficial even if your organization uses only one Domino Directory.

There are two types of directory catalogs: server directory catalogs and mobile
directory catalogs. A Notes user can store a local replica of mobile directory
catalog and use it when running disconnected. This way they can address mail to
anyone in their organization, even when disconnected from the network.

Figure 139 shows is a representation of creating a directory catalog from replicas
of several Domino Directories.
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Figure 139. Directory catalog

We recommend that you maintain replicas of the Domino Directories you are
including in your directory catalog. These replicas should be on the server where
you are building and maintaining the directory catalog.

The server and mobile directory catalogs are built using the same processes and
internally are the same (in terms of how they work, etc.). The real difference is in
how they are used. This has implications for administrators in some of the
configuration settings used.

Mobile directory catalogs should be designed for the mobile user in mind, so they
are generally designed for very small footprint or small replication impacts. An
administrator may choose to severely limit the number of fields included, for
example. Or the administrator may choose to have several tailored versions that
pull from different subsets of the available directories or have different sort
orders, so that mobile users can select the one (or more) that best meet their
needs.

The server directory catalog is designed more as a corporate resource for
network users. Since, unlike the mobile directory catalog on the client, the server
can only access a single directory catalog (the client can use more than one),
more care needs to be taken in selecting and publishing the sort order to
maximize the speed of response (choose the one that is most natural to your
users).

11.3.1 Configuring a directory catalog

To configure a server directory catalog and a mobile directory catalog, you must
complete these steps:

1. Prepare a Domino server to build the directory catalog.

2. Set up a source server directory catalog and a source mobile directory
catalog.

3. Set up the server directory catalog for use.

4. Set up the mobile directory catalog on user workstations.
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The following sections explain each of these steps in detail.

11.3.1.1 Preparing a Domino server to build the directory catalog

In our example, we want to build a directory catalog on the dommaili/abc1 server
and include information from the Domino directories on dommail2/abc2 and
dommail3/abc3. Notice that these servers are in different Domino organizations
and so they do not share a single common Domino Directory.

To enable servers to perform this replication, we cross-certified the organization
with the directory catalog to authenticate with the server in the other organization
that was providing the directory information. We also cross-certified the
administrator so that the replica could be created. See Appendix B, “Server cross
certification” on page 213, for an explanation of how we did this. More information
about cross-certification can be found in Domino Release 5: Administering the
Domino System, which is also available as the online Administration Help
database.

1. Create a replica of each secondary Domino Directory that you want to include
in the directory catalog, by following these steps:

a. Start the Administration client for the Domino server designated to build the
directory catalog. In our case, this is dommail1. Click File->Replication->
New replica.

b. In the Server field, on the Choose database window, specify the name of
the Domino server hosting the Domino Directory that you want to replicate.
In the Database field, highlight the Domino Directory that you want to
replicate. Click the Select button. Refer to Figure 140.

Choosze Databasze E
Server. Open I
dommail3/abc3 -
I J Select |
Databaze:
A Cancel |
@ Help |
o abod's Address Book
@ Adminiztration Requests [R5)]
@ Catalog [R5)
@ DECS Documentation LI
About.... |
Filename:
Inames.nsf Browse... |

Figure 140. Choosing the Domino Directory for replicating

c. In the Server field, on the New Replica window, insert the name of the
Domino server designated for directory catalog. In the Filename field,
specify the name that is unique on the server so that you will recognize the
replica by its filename. Click OK. This will create a replica of the secondary
Domino Directory on the server designated for directory catalog. Refer to
Figure 141.
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Figure 141. Specifying the new replica

2. Create Connection documents to schedule replication of the secondary
Domino directories that will be included in the directory catalog. To do this,
complete the following steps for each secondary Domino Directory:

a. Start the Domino Administrator for the server designated for the directory
catalog. Click the Configuration tab, and expand the Server section. Click
Connections, and click the Add connection button.

b. Inthe Source server field, on the Basic tab, specify the fully qualified name
of the server designated for directory catalog. In the Source domain field,
specify the domain name of this server. In the Destination server field,
specify the fully qualified name of the server hosting the secondary Domino
Directory. In the Destination domain field, specify the domain of this server.
Refer to Figure 142.

Fg‘ Mew Connection - Domino Administrator

File Edit Wiew Create Actions Test Help

ﬁ Adminiztration _] Mew Connection X

T3 Save and Claze
SERVER CONNECTION

Basics l Fieplication/Fouting l Schedule l Comments l Adminiztration |

Slslsl=a

Connection type: " Local Area Metwark =] Uszage priority: " Marmal 5=
Source server. T dormmaill /b o Destination server. T dormail3/abc3
Source domain: T abcl g Destination domain: T abc3 g
Usze the port{s]: ™ g Optional network address:

Chooge ports |

Figure 142. Adding the Connection document - Basics tab

c. On the Replication/Routing tab, set Replication task to Enabled, and set
the Replication type to Pull only. This will enable one-way replication in
which the server with the directory catalog pulls updates from the servers
of the secondary Domino Directory. Refer to Figure 143 on page 164.
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Figure 143. Adding the Connection document - Replication/Routing tab
d. On the Schedule tab, adjust the application schedule if needed. Then,
click the Save and Close button.

More information about replication can be found in the Lotus book Domino
Release 5: Administering the Domino System, and in the online Administration
Help database.

11.3.1.2 Setting up a source directory catalog
To set up the source server directory catalog and the source mobile directory
catalog, complete the following steps for each of them:

1. Create the directory catalog database by performing the following steps for the
server directory catalog and the mobile directory catalog:

a. Start the Domino Administrator of the server prepared for the directory
catalog. Select File->Database->New.

b. In the New Database window, specify the fields as follows:
i. Inthe Server field, choose the server prepared for the directory catalog.
ii. Choose the name for the directory catalog, and insert it in the Title field.

iii. Choose the filename for the directory catalog database, and insert it in
the field File Name.

iv. Select the Create full text index for searching box.
Refer to Figure 144.
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Figure 144. Creating a directory catalog database

v. Still in the New Database window, click Template Server.

vi. Choose the server prepared for directory catalog as a template server,
and click the OK button on Template Servers window.

vii. Choose the Directory Catalog template with the filename dircat5.ntf.

viii.Click the OK button on the New Database window.

Refer to Figure 145.
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Figure 145. Choosing a template for directory catalog database

2. Complete the following steps to enable the Directory Catalog Status Report

agent to run:

a. Start the Domino Administrator of the server designated for the directory
catalog. Click the Configuration tab, and expand the Server section.

b. Click Current Server Document. Then click Edit Server.

c. Under the Security tab, in the Run restricted LotusScript/Java agents field,

specify the name of Domino Administrator.

d. Click Save and close to close the Server document.

3. Set up the directory catalog configuration by completing the following steps for
the server directory catalog and the mobile directory catalog:
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a. Open the newly created directory catalog database. Select Create and
Configuration from the pull-down menu.

b. Inthe directory catalog configuration, click the Basic tab. Specify the fields
as follows. Refer to Figure 146.

i. In the Directories to include field, specify the filenames of the primary
Domino Directory and the replicas of the secondary domino directories.

Note: You may omit the primary Domino Directory from this list if the
directory catalog will be used only in this domain, because Domino
always searches the primary Domino Directory before searching the
directory catalog.

ii. Inthe Sort by field, specify the type of sorting you want for the directory
catalog entries by selecting one of the following options:

* Distinguished name if you expect users to enter first names
followed by last names

* Last name if you expect users to enter last names followed by first
names

» Alternate fullname if your organization uses alternate names.

More information about alternate names and their usage can be found
in Domino Release 5: Administering the Domino System, and in the
online Administration Help database.

£ (Untitled) - Lotus Notes

File Edit Wiew Create Actions Test Help

@ ‘Welcome ‘Workspace ﬂﬁ Server Directory catalog - Users _] [Untitled] *

and Cloze

DIRECTORY CATALOG CONFIGURATION

Basics l Advanced l

= Directories to include: T names. nsf
names3. nsf
hamesd.nsf
@ Additional fields to include: * FirstM ame
[Fullname and List ame included by default) Middlelnitial
Lasth ame
Location
5 Mailsddress
B Shortname
M aillomain
@l Intemetaddress
MeszageStorage 4
@ Sort by: O Distinguished Mame
® Last Mame
) Alemate Fullname
@ Uze Soundex: TYes =]
Femove duplicate users: TYes =]
Group types: T Mail and Muli-purpose =1
3 Fiestrict aggregation to thiz server: T dormmaill /b
EEE Send Directory Catalog reports to: T Adminl fabcl 4
Comments: ™ g

Figure 146. Configuring the directory catalog

iii. In the Restrict aggregation to this server field, insert the name of the
Domino server designated for the directory catalog. This will prevent
someone from inadvertently running the dircat task on another server
and making a hash of the directory catalog as a result.
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C.

iv. Inthe Send Directory Catalog field, reports to you may insert the names
of people to which mail reports.

Note: On the current Domino release, if you want the reports to be sent
to more than one person, you have to change the Directory Catalog
Status Report agent in the following way:

* Make sure that you are working from a Domino Designer client.

* Open the directory catalog database. Open the View pull-down, and
click Agents.

* Double-click the Directory Catalog Status Report agent to open it.

* In the left pane of the Directory Catalog status Report |
statusReport (Agent): (Options) window, click Initialize.

» Scroll down to the bottom of the LotusScript code in the right pane.
¢ Change the last line of the code from:
Call memo.Send (False, cfgdoc.GetItemvValue (“ReportRecipients”) (0))
to:
Call memo.Send (False, cfgdoc.ReportRecipients)
* Save the agent.
v. Leave the other fields as the default settings.

Click Save and close to close the directory catalog configuration.

4. Build the source directory catalogs by running the dircat task. This task
summarizes entries from Domino directories and aggregates their contents
into documents in the directory catalog. To run the dircat task, complete the
following steps:

a.

Start the console of the Domino server hosting the directory catalog. You
can do this via green-screen emulation or from Domino Administrator by
selecting Server->Status->Console.

For each directory catalog, issue the following command:
load Dircat xx.nsf

Here, xx stands for the database name of the directory catalog. The
Directory Catalog Needs Rebuilding message that you see on the console is
normal when a directory catalog is first built.

5. Schedule the dircat task to run automatically by completing the following
steps:

a.

Start the Domino Administrator of the server hosting the directory catalog,
and click Configuration tab.

Expand the Server section. Choose Current Server Document, and click
Edit server.

c. Click the Server Tasks tab, and click the Directory Cataloger tab.

In the Directory Catalog filenames field, insert the filenames of the
directory catalogs. Select Enabled for the Schedule field, and change the
default schedule if necessary. Click Save and Close. Refer to Figure 147
on page 168.
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Figure 147. Scheduling the dircat task

11.3.1.3 Setting up the server directory catalog for use
To set up the server directory catalog for use, complete the following procedure:

1. Start the Domino Administrator of the server hosting the directory catalog.

2. Click the Configuration tab. Choose Current Server Document, and click
Edit Server.

3. In the Directory Catalog database name on this server field, insert the file
name of the server directory catalog. Then click Save and Close. Refer to
Figure 148.

168  Lotus Domino for AS/400 Internet Mail and More



Fg‘ Server: dommaill /abc1 - Domino Administrator

File Edit “iew Create Actions  Administration  Test  Help ko {; (,53 “'} (.Q\
g Adminiztration | 42 tWelcome bo Doming Administrator RS administrat:
People & Groups I Filez I Server I Meszaging I Fieplication I Configuration l
[l - ety oo
i H Server. dommaill fabel Use Directary or: | Current Server | | .- Tools
v [ Sever TR
- =il Save and Close  Je8 Web.. @| Certification
8 [3 9 - _
All Server Documents SERVER: dommaill{abel = ’ |1 @ Reqistration
Configurations = s T ot e o]
i Basics Ecurity arts erver Tasks | Internet Protocals & 1zcellaneous ranzachional Logging Y
Connections Security | P 5 Tasks | | P Iz | MTas | Miscel T ional Loggi R
Programs
External Domain Metwark In
7 Messaging Server name: T dommaill Aabcl 1 Server build number: Belease 5.0.4
» Jéjl:? Egpllfatlon Server tle: 7 Edmiristrators: T fdmint/abcl =
- recton [omain name: T abcl 4 Flouting tasks: T Mail Routing, SMTP Mail
7 Routing ;=1
y @ Fully qualified Internet host dommaill janal.com g SMTF listener task: T Enabled ;=]
> .ﬂ. Cluster name:
» [ Miscellansous Cluster name: Server's phone number(sl: T
Directory Aszistance ™ g CPU count: 1
database name:
Directory Catalog database  © SDC.nsfl, Operating system: IEM D5/400
hame on this server
Optimize HTTP perfarmance * Advanced [Custom Is this & Sametime server? T No =]
bazed on the following Settings] =]
primary activity:
Server Location Information

Figure 148. Setting up the server directory catalog for use - Server document

4. Click the Files tab.
Select the Domino Directory (names.nsf), and double-click to open it.

Choose Actions->Edit Directory Profile.

N oo o

In the Directory Catalog database name for domain field, insert the filename of
the server directory catalog. Then click Save and Close. Refer to Figure 149.
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Figure 149. Setting up the server directory catalog for use - Domino Directory

11.3.1.4 Setting up the mobile directory catalog on client workstations
To set up the mobile directory catalog for clients, complete the following steps:

1. Make sure that you have built a source mobile directory catalog.
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2. Start the Domino Administrator of the server hosting the mobile directory
catalog. Click the File tab, and open a mobile directory catalog.

3. Choose Edit->Copy As Link->Database Link.
4. Close the database.

5. Click the People & Groups tab. Expand Domino Directories. Then choose
Setup Profiles, and click Add Setup Profile.

6. In the Profile name field insert the name for the profile.

7. Click the Database tab. Click the Mobile directory catalogs field, and
choose Edit->Paste. Refer to Figure 150.
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Figure 150. Setting up a mobile directory catalog on client workstations

8. Click Save and Close.

9. For users who will use the mobile directory catalog, insert the name of the
setup profile in their person document. Follow these steps:

a. Start the Domino Administrator of the server hosting the directory catalog.
Click the People & Groups tab.

b. In the right-hand pane, select a particular user, and click Edit Person.

c. Click the Administration tab. In the Setup profile(s) field, insert the name
of the setup profile you created.

When a user connects to this server, they receive on their workspace a
replica stub of the mobile directory catalog with replication schedule
enabled. They also get the mobile directory catalog filename appended to
the contents of the Local address books filed in the User preferences for
mail. See 7.3, “Registering users using a setup profile” on page 76, for
more information about setup profiles.

10.Any user created with this setup profile will already have a mobile directory
catalog set up.

11.1f you don’t want to use setup profiles, each user needs to set up a replica of
the mobile directory catalog on their PC. Then, they need to click
File->Preferences->User Preferences->Mail and News to add the mobile
directory catalog name to the Local address books field (Figure 151). In our
case, the catalog name was mdc.nsf.
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Figure 151. Mobile directory catalog

11.3.2 Using a directory catalog

Now that you have set up the directory catalog, how do you use it for looking up
e-mail addresses? This section explains how.

11.3.2.1 Searching the directory catalog when addressing messages
When a user connected to their mail server creates a new memo and clicks the
Address button, they have the following possibilities for searching the
addresses:

¢ |f both the server and mobile directory catalogs are set up, they can search
the personal address book, mobile directory catalog, Domino Directory, and
server directory catalog. See Figure 152.
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Figure 152. Address lookup when the user is connected to the server

e If only the server directory catalog is set up, the user can search the personal
address book, Domino Directory, and the server directory catalog.

If a mobile directory is set up, when a disconnected user creates a new memo
and clicks the Address button, they can search the personal address book and
the mobile directory catalog (Figure 153 on page 172).
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Figure 153. Address lookup when running is disconnected

11.3.2.2 Recipient name lookup using the Directory catalog

Recipient name lookup returns a matching name or an ambiguous name dialog
box based on what a user types in the To, cc, and bcc fields in a mail message.
The name is resolved when a user clicks the Send button or presses F9.

When a directory catalog is set up, the recipient name lookup includes it in its
search.

If a mobile directory is set up, when a disconnected user creates a new memo,
the recipient name lookup includes a mobile directory catalog in its search.

Figure 154 shows an example of a disconnected user typed “tom” in the To field
of a mail message. After pressing F9, the recipient name lookup presents the
user with two matching names using the mobile directory catalog. The names are
from different Domino Directories in different domains.
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Figure 154. Recipient name lookup using the Directory catalog
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11.3.2.3 Type-ahead addressing using the Directory catalog
Type-ahead addressing displays names that match the letters a user types in the
To, cc, and bcc fields in a mail message. It returns a match as quickly as
possible, while a user is still typing the address. For example, if a user types
John s in the To field in a new memo and Domino finds an entry for John
Smith/abc1, Domino automatically completes the rest of the recipient’s address.
A user can change or re-type the address as needed.

When a directory catalog is set up, type-ahead addressing includes it in its
search.The behavior of type-ahead addressing is based on which sort order was
specified in the directory catalog configuration.

If a mobile directory is set up, when a disconnected user creates a new memo,
the type-ahead addressing includes the mobile directory catalog in its search.

In the example shown in Figure 155, the Directory catalog is sorted by last name.
A user types part of a last name, for example “sm”, in the To field of a new memo.
Type-ahead addressing completes the field for the user with the match “Smith
Ann”.

(™ New Memo - Lotus Notes
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g 9 Send @ Send and File

John Smith
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Subject:
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Figure 155. Type-ahead addressing when the Directory catalog sorted by last name

In the example shown in Figure 156 on page 174, the Directory catalog is sorted
by distinguished name. A user types part of a first name, for example “to”, in the
To field of a new memo. Type-ahead addressing completes the field for the user
with the match “Tom Smith/abc1”.
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Figure 156. Type-ahead addressing when the Directory catalog is sorted by distinguished name

11.3.2.4 Type-down addressing

Type-down addressing is a feature of the Directory catalog. With this feature in
place, type-ahead returns all possible matches based on what a user types in the
To field of the mail message. The user can move down returned entries by
pressing the down arrow. For example, if the directory catalog is sorted by last
name and a user types “sm” in the To field, the first matching entry “Smith Ann” is
displayed. When the user presses the down arrow, the next entry “Smith John” is
displayed. When the users presses the down arrow again, the next entry “Smith
Tom” is displayed. If at any of these entries, the user presses F9, the entry is
expanded to, for example, “Tom Smith/abc1 @abc1”.

We found that we had to have a local copy of the mobile directory catalog and list
it in our preferences, as shown in Figure 151 on page 171, for type-down
addressing to work.

11.4 Directory assistance

174

Directory assistance is a Domino service that enables both Notes and LDAP

clients to access secondary Domino directories and LDAP directories for lookup
purposes. In addition, it extends Web client authentication to secondary Domino
directories and LDAP directories. The directory catalog and directory assistance

Lotus Domino for AS/400 Internet Mail and More



provide similar functionality, such as finding entries in secondary Domino
directories for Notes users mail addressing. However, the following tasks are
provided only by Directory assistance:

» Searching LDAP directories on behalf of Notes users for mail addressing
* Referring LDAP clients to LDAP directories
* Authenticating Web clients using entries from secondary Domino directories

11.4.1 Configuring directory assistance
To configure directory assistance, complete the following procedures:

1.
2.
3.

Create a Directory Assistance database, and replicate it if needed.
Identify the Directory Assistance database on the servers that will use it.

Set up directory assistance for each secondary Domino Directory that will be
included in directory assistance.

Set up directory assistance for each LDAP directory that will be included in
directory assistance.

11.4.1.1 Creating a Directory Assistance database
Complete these steps:

1.
2.

From the Domino Administrator, choose File->Database->New.

In the Server field, type the name of the server on which to create the
Directory Assistance database.

3. In the Title field, enter a title for the database.

4. In the File Name field, enter the file name for the database.

5. Click Template Server. Select a server that has the Directory Assistance

template (probably the same server), and select the template DA50.ntf.

6. Click OK. Refer to Figure 157.
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Figure 157. Creating a Directory Assistance database

7.

Create a replica of the Directory Assistance database on each server that will
use it. For information how to create and schedule replication between
servers, see Domino Release 5: Administering the Domino System, or the
online Administration Help database.
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11.4.1.2 ldentifying the Directory Assistance database on servers
Complete these tasks:

1. From the Domino Administrator, click the Configuration tab.
2. Expand the Server section in the task pane. Choose All Server Documents.

3. Click the Server documents for servers that have the replica of the Directory
Assistance database.

4. Choose Actions->Set Directory Assistance Information. See Figure 158.
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Figure 158. Identifying the Directory Assistance database on the servers

5. In the Directory Assistance Information window, insert the file name of the
Directory Assistance database, and click OK.

This inserts the file name of the Directory Assistance database in the Directory
Assistance database name field in selected Server documents.

You can manually update the file name of the Directory Assistance database in
any Server document.

11.4.1.3 Setting up directory assistance for a secondary Domino
Directory

For each secondary Domino Directory to be included in directory assistance,
complete the following steps:

1. If you chose to replicate the secondary Domino Directory to a server that uses
directory assistance, set up the replication. For information how to create and
schedule replication between servers see Domino Release 5: Administering
the Domino System, or the online Administration Help database.

2. Create a Directory Assistance document for the secondary Domino Directory
by completing the following steps:

a. Start the Domino administrator of the server that hosts the Directory
Assistance database.

b. Click the Configuration tab. On the left pane, expand the Directory
section. Click Directory Assistance, and click Add Directory Assistance.

c. Click the Basic tab, and complete the following fields:
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i. Forthe Domain type field, choose Notes.

ii. In the Domain name field, insert the name of the Notes domain
associated with the secondary directory.

iii. In the Company name field, insert the company name associated with
the secondary directory.

iv. In the Search Order field, insert the number representing the order in
which the directory is searched, relative to the other directories in the
Directory Assistance database.

v. For the Enabled field, choose Yes to enable directory assistance for this
database. See Figure 159.

Fg‘ DirectorpAsszistance - Domino Administrator

File

BEE0E

Edit  “iew Create Actions Text Help

ﬁ Adminiztration ﬂ ‘Welcome to Domina Administrator RS _] Directorpbssistance X

\"( Save and Close
DIRECTORY ASSISTANCE

Basics l Fules l Replicas l

Domain bype: T Notes =]

Domain name: T abc3 g

Company name; T abc3 g

Search order: My

Enabled: TYes =]

< -2
Comments: ©

p Administration

Figure 159. Setting up directory assistance for a secondary directory (Part 1 of 2)

d. Click the Replica tab. In the Replica # field, insert the server name and file
name of the replica of the secondary directory. Choose Yes for Enabled.
See Figure 160 on page 178.
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Figure 160. Setting up directory assistance for a secondary directory (Part 2 of 2)

e. Click Save and Close.

11.4.1.4 Setting up Directory assistance for the LDAP directory
For each LDAP directory to be included in directory assistance, complete the
following steps:

1. Start the Domino Administrator of the server that hosts the Directory
Assistance database.

2. Click the Configuration tab. On the left pane, expand the Directory section.
Click Directory Assistance, and click Add Directory Assistance.

3. Click the Basic tab, and complete the following fields:
a. For the Domain field, type choose LDAP.
b. In the Domain name field, insert the name that you choose.

c. In the Company name field, insert the company name associated with this
directory.

d. Inthe Search Order field, insert the number representing the order in which
the directory is searched, relative to other directories in the Directory
Assistance database.

e. For the Enabled field, choose Yes to enable directory assistance for this
database. Refer to Figure 161.
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Figure 161. Setting up directory assistance for the LDAP directory (Part 1 of 2)
4. Click the LDAP tab, and complete the following fields:

a. In the Hostname field, insert the host name of the LDAP server.

b. For the Perform LDAP search for field, make on of these selections:

* Choose Notes Clients/Web Authentication if the notes clients will
access LDAP directory for mail addressing.

* Choose LDAP clients to refer LDAP clients to the LDAP directory.
* Choose both Notes Clients/Web Authentication and LDAP clients.

c. Forthe Channel encryption field, choose None. Refer to Figure 162.
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M aximurn number of entries 100

Teturmed:

xor
Comments: ©

p Administration

Figure 162. Setting up directory assistance for the LDAP directory (Part 2 of 2)
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5. Click Save and Close.

11.4.2 Using directory assistance
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We encountered a problem when the directory assistance is set up and the Fully
qualified Internet host name field in the Server document consists of a Domino
server name followed by a dot, followed by an SMTP domain name. Notes that
are sent by SMTP from another SMTP domain to a user on the server running
directory assistance fail with the message: “No route found to domain janat.com
from server DOMMAIL1/ABC1. Check DNS configuration”.

For example, mail addressed to user1 @janail.com fails when the server
dommail1 with directory assistance set up has dommail1.jana1.com specified in
the server document in the Fully qualified Internet host name field.

We can overcome this problem by specifying only the SMTP domain name, for
example, janal.com, in the Fully qualified Internet host name field in the Server
document. In this case, the mail from another SMTP domain works correctly.
Having only the SMTP domain name in the Server document offers the same
functionality as entering server name.SMTP domain name in the Server document.
Defining a Global Domain document to accept mail for janai.com, instead of
using the Server document, should work as well.

11.4.2.1 Searching Domino directories for Notes users mail addressing
When a user connected to their mail server creates a mail message and clicks
the Address button, they can search the secondary Domino directories that are
included in directory assistance. In the example shown in Figure 163, a Notes
user can search the Domino Directories of the domains abc3 and abc4 that are
included in directory assistance.

™ New Memo - Lotus Notes

File Edit “iew Create Actions Test Help

@ ‘Welcome ‘Work space @ John Smith - Inbox _] Mew Memo X

U Select Addresses b

Look in obile Directory Catalog

Mobile Directory Catalog

Starts with

[
-
J Fecipients

& admin :

3 A To>» I@’
- i [coie Doy Cokoy L B
& Adminl Local Address Books ‘—I = bee:
& #dmin3|Bigfoot = P |
& Admind
(23 Administration Requests _ILI
L »
IList by name 'l Details... | Eopylozal | Bemove | Femove Al |

QK I Cancel | Help |

&
&y
@

Figure 163. Notes user searching secondary Domino directories included in directory assistance
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When directory assistance is set up, recipient name lookup includes in its search
the secondary Domino directories from Directory assistance. For example, if a
Notes user types “brown” and presses F9, the address is resolved with George
Brown/abc3@abc3 being found in a secondary Domino Directory included in
directory assistance.

11.4.2.2 Searching LDAP directories for Notes users mail addressing
When an LDAP directory is included in directory assistance, recipient name
lookup includes it in its search for address resolution. In the example shown in
Figure 164, a Notes user creating a mail message typed “johnson” in the To field.
After pressing F9, they are presented with two entries found in the LDAP directory
included in directory assistance.

™ New Memo - Lotus Notes

BEilet Editt Wew [Ereater Actions Dext Help

@ Welcome ‘Workspace ﬂ John Smith - Inbox _] Mew Memo X

g ‘)Eieru:l @Eiend and File @' 3 Draft Ade il ans... oals
John Smith To: [ishnson

07/28/0010:29 &AM [

Ambiguous Hame x

More than one match was found for name: i |

johnzon Skip Name |
—_ Cancel Sending |
Lhooze one name:

Mary Johnson/abe (M an ohnzoni@itzoroch. ibm. com)

Figure 164. Notes user searching LDAP directories included in directory assistance

11.4.2.3 Referring LDAP clients to LDAP directories

Directory assistance can be used to refer LDAP clients that connect to the
Domino LDAP service, to another LDAP directory. In the example shown in Figure
165 on page 182, an LDAP client connected to the Domino server using directory
assistance searches the LDAP directory for the name Johnson. The user is
presented with two entries from another LDAP server available through directory
assistance.
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/™ New Memo - Lotus Notes

BEilet Editt Wew [Ereater Actions Dext Help
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bEs |
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Figure 165. Using directory assistance to refer LDAP clients to an LDAP directory
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Chapter 12. Single SMTP domain with bind to specific IP address

© Copyright IBM Corp. 2000

In Chapter 5, “One iSeries server and two SMTPs” on page 35, we describe
how to use the bind to specific IP address support to enable Domino for
AS/400 with Domino SMTP support to coexist with OS/400 SMTP. In the
examples in that chapter, the Domino SMTP domain was not the same as the
iSeries user's SMTP domain. For example, a Domino SMTP user name was
user1 @janal.com. An iSeries POP user was puser1 @itsoroch.ibm.com.
itsoroch.ibm.com was also the SMTP domain used by the AnyMail Integration
Domino server used in this chapter (dommail4).

In the original implementation of a single AnyMail Integration (*"MSF) Domino
server, it was possible (and standard) for the Domino users’ SMTP domain to
be the same as the OfficeVision/400 and POP users. A Domino user could be
fred@itsoroch.ibm.com, and an OfficeVision/400 user could have an SMTP
address of john@itsoroch.ibm.com. The Mail Server Framework (MSF) would
take care of delivering mail for users on the Domino server to those users.
Domino users could be registered in the iSeries system distribution directory
with a Mail service level of 4, meaning Domino, and Preferred address of 3,
meaning SMTP name.

Now with the bind to specific IP address support, we have in effect, two totally
separate hosts: the iSeries server with its IP address and SMTP domain, and
the Domino server with its IP address and SMTP domain.

Can these two SMTP domains be the same? We found that they could under
certain circumstances. Perhaps you can find a more elegant solution to this
dilemma. Please tell us if you do!

An overview of our solution is that the iSeries users and the Domino users will
send mail out via their individual SMTP stacks and will be seen by recipients
as coming from a single SMTP domain itsoroch.ibm.com. However, all mail
from the Internet will come into the Domino server. The Domino server will
look in the local Domino Directory and any mail that doesn’t belong to a local
user will be sent on to the iSeries server, which is acting as a smart host. The
iSeries server will then deliver to local iSeries users and return any
undeliverable mail to the Internet senders. Special set up is required for the
iSeries users to send mail to the Domino users on the same iSeries server.

General information about bind to specific IP address functionality and the
PTFs are necessary to implement it. See Chapter 5, “One iSeries server and
two SMTPs” on page 35, for more information.

The examples in this chapter do not use Internet addressing for the
OfficeVision/400 users as described in Chapter 5, “One iSeries server and two
SMTPs” on page 35, but they could be expanded to use it.

The two scenarios we describe here both require predefining Notes users in
the iSeries system distribution directory. This isn’t required for a situation
where the domain is different. There are restrictions in terms of SMTP names.
In both cases, mail that is delivered to Notes users from the internal
OfficeVision/400 users will appear as being addressed to an alias domain (see
Figure 187 on page 200 for an example). This should not be a limitation unless
a lot of outside mail is also copied to internal users. Even so, this should be
seen as a cosmetic limitation and not a functional one.
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Scenario overview
Our scenario uses these values:

* iSeries host name: AS24

¢ iSeries TCP/IP domain: itsoroch.ibm.com

* iSeries fully qualified TCP/IP name: AS24.itsoroch.ibm.com

* 0S/400 SMTP domain: itsoroch.ibm.com

e Domino server name: dommail7

* Domino fully qualified TCP/IP name: dommail7.itsoroch.ibm.com

e Domino SMTP name: itsoroch.ibm.com

e Sample iSeries user: fred@itosoroch.ibm.com

* Sample Domino user: peter@itsoroch.ibm.com

e Alias SMTP domain: itsorochal.ibm.com

¢ Mail exchange server for domain itsoroch.ibm.com:
dommail7.itsoroch.ibm.com

12.1 Configuring bind to specific IP address for a single SMTP domain
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To configure bind to specific IP address for a single SMTP domain, complete the
following steps:

Note: To use bind to specific IP address functionality, the Domino server on the
iSeries server has to use its own |IP address, not the iSeries one.

1. Configure bind to specific IP address on the iSeries server. For information on
how to configure bind to specific IP address on the iSeries server, refer to 5.1,
“Configuring bind to specific IP address” on page 36.

2. Configure Domino on the iSeries server to use Domino SMTP. Refer to
Chapter 3, “Configuring Domino for SMTP” on page 15, to see the values to
use when configuring Domino to use Domino SMTP. If you already configured
a Domino server to use MSF and you want to change to use Domino SMTP,
use the Change Domino Server (cuepoMsvr) command to do this.

3. Start the Domino server and set up the Domino Administrator. Information
about how to start a Domino server and set up the administrator workstation
can be found in Lotus Domino for AS/400 R5: Implementation, SG24-5592.

4. In the Domino Server document, leave the Fully qualified Internet host name
with the default of the iSeries server name and the SMTP domain name, for
example, as24.itsoroch.ibm.com.

Set up the iSeries server as a smart host for incoming SMTP messages to the
Domino server. A smart host is a host to which SMTP-routed messages are
sent when the message recipient cannot be found in the local Internet
domain's directory. When a message is received, the router looks for the
recipient's address to see if it is in the local Internet domain or in an alias
Internet domain. If it is, then the router checks the Person document to see
where to send the message. If there is no entry in the Domino Directory for
this person (and for this scenario to work, OfficeVision/400 users should not
be in the Domino Directory), it transfers the mail to the smart host. To define
the iSeries server as a smart host, complete the following steps:

a. Start the Domino Administrator.
b. Click the Administration active task button.

c. Click the Configuration tab.
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d. Expand the Messaging section, and click Configurations.

e. Make sure you already have a Configuration settings document for the
Domino server.

f. Click Edit Configuration.
Click the Router/SMTP tab, and click the Basic tab.

h. Choose Enabled for the SMTP Used when sending messages outside of
the local internet domain field.

i. Inthe Local Internet domain smart host field, insert the IP address of the
iSeries server hosting the Domino server. The IP address must be
enclosed in square brackets. If we used a host name for the smart host, the
entry was not recognized, and mail was not forwarded to the smart host.

j- Choose Disabled for the Smart host is used for all local internet domain
recipients field. With this field Disabled, only messages whose recipients
are not found in the Domino Directory will be routed to the smart host.

k. Leave the other fields as the default. Refer to Figure 166.

Fg‘ Configuration for DOMMAIL7/ABCY - Domino Administrator

File Edit Wiew Create Actions Test Help @

g Adminizgtration ﬂ ‘welcome to Domina Administrator RS | _] Configuration for DOMMAIL? JABCT ﬂ

FE! Save and Cloze
CONFIGURATION SETTINGS: DOMMAIL7/ABCT

T LR

o 101018
y 10 TR
I

Basics | Router/SMTP | MIME | NOTESINI Setiings | Admiristation |

Basics l Restrictions and Controls l Meszage Tracking l Advanced l

B

Mumber of mailboxes: ]

SMTP used when sending T Enabled ;=]
messages outside of the local

internet domair:

SMTP allowed within the local T Disabled 1=
internet domair:

Servers within the local Mates T Always o x]
domain are reachable via SMTP

over TCPIP:

Address lookup: T Fullnarne only =]
E xhaustive lookup: " Disabled 1 =]
Relap host for messages leaving  © 4

the local internet domain:
Local Internet domain smart host: " [10.6.5.238] 4

Smart host iz used for all local T Dizabled =]
internet domain recipients:
Host name lookup: " Dynarnic then local ;=]

Figure 166. Configuring the iSeries server as a smart host

5. Create a Global Domain document containing the primary domain name and
an alias domain name. The iSeries users will use the alias when sending mail
to the Domino users.

To do this, complete the following steps:
a. Start the Domino Administrator.
b. Click the Administration active task button.

c. Click the Configuration tab.
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d. Expand the Messaging section. Click Domains, and click Add Domain.
e. Click the Basic tab.
i. Forthe Domain type field, choose Global Domain.

ii. In the Global domain name field, insert a name that describes the
domain. For the Global domain role field, choose R5 Internet Domains
or R4.x SMTP MTA. See Figure 167.

Fg‘ Mew Domain - Domino Administrator

File Edit “iew Create Actions Test Help

ﬁ Adminiztration _] Mew Domain X

FE! Save and Cloze

DOMAIN

Basicsl Hestrictionsl Conversions | Administration

Domain type: " Glabal Damain ;=]

Global domain name: " dormmail?

Global domain role: T RS Intermet Domaing or B4.x SMTP MTA 4=
Use as default Glabal [ es

=5 & %5 & =B

Dromain [for uge with all
Internet protocols except
HTTP):

Figure 167. Configuring a Global Domain document (Part 1 of 2)

f. Click the Conversions tab.

i. Inthe Local primary Internet domain field, insert itsoroch.ibm.com, which
is the name of the SMTP domain used by Domino and iSeries server.

ii. Inthe Alternate Internet domain aliases field, insert a name for the alias
SMTP domain, for example itsorochal.ibm.com. See Figure 168.

iii. Click Save and Close.

Fg‘ Mew Domain - Domino Administrator

File Edit “iew Create Actions Test Help

ﬁ Adminiztration _] Mew Domain X

FE! Save and Cloze

DOMAIN

Basicsl Hestrictionsl Conversions | Administration

%5 & %5 & mB

Address format: " Address only ;= Outbound mail restriction: Restrict to global damain,
Local primary Internet Titzorach.ibm.com Country name: ™ g

domain:

Alternate Internet domain Titzorachal ibr.cam ADMD name: ™ g

aliazes:

Internet address lookup: T Disabled 1= FRMD name: ™ g

# st or o el covieed g Al

Local part formed fram: T Full name 1 =] Motes domain attribute: T None =]
MNotes domain(z] included: ™Al =]

MNotes domainz] position: T Left of '@ =]

Motes domain separator: T % - percent sign =]

Address example: JMD ¥ dom % dom2% dom3E@acme. com

MOTE: The following settings are not used in B5. They only apply to Bd.x SMTP MTAz

Outbound mail restriction: T Unrestricted 1 =]

Figure 168. Configuring a Global Domain document (Part 2 of 2)
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6. Add the entries for the primary SMTP domain and the alias domain in the
AS/400 TCP/IP Host Table. This is so that the iSeries recognizes any mail
coming in with those domains as being local to it. To do this, complete the
following steps:

a. On any iSeries command line, type cfgtcp and press Enter.
b. Select option 10 (Work with TCP/IP host table entries).

c. Add an entry for the primary SMTP domain. Type 2 next to the Internet
address of the iSeries server hosting the Domino server, and press Enter.
Page down if necessary. Insert a + (plus) sign in the first empty Name field,
and press Enter. Refer to Figure 169. There were already three entries in
here: AS24, AS24.ITSOROCH.IBM.COM, and AS400WS. Four entries are
allowed per interface.

Change TCP/IP Host Table Entry (CHGTCPHTE)
Type choices, press Enter.

Host names:

Name . . . . . . . . . . . .. 'AS24"
Name . . . . . . . . . . . .. 'AS24 . ITSOROCH.IBM.COM'
Name . . . . . . . . . . . .. 'AS400WS'

+ for more values +
More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F13=How to use this display
F24=More keys
k J

Figure 169. Adding a primary SMTP domain to the iSeries host table (Part 1 of 2)

In the Name field, insert the name of the SMTP domain used by Domino
and iSeries. Press Enter twice. Refer to Figure 170 on page 188. One
iSeries interface can have up to four host names in this table.
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-~
Specify More Values for Parameter HOSTNAME
Type choices, press Enter.
Name . . . . . . . . . . . .. 'AS400WS'
Name . . . . . . . . . . ... itsoroch. ibm.com
Bottom
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F13=How to use this display
F24=More keys

Figure 170. Adding an SMTP domain to the iSeries host table (Part 2 of 2)

d. Add an entry for the alias. Still in the Work with TCP/IP Host Table Entries
screen, insert 1 in the Opt field, and specify the IP address of the Domino
server in the Internet Address field. Press Enter. See Figure 171.

g Work with TCP/IP Host Table Entries
System: AS24
Type options, press Enter.
1=Add 2=Change 4=Remove 5=Digplay 7=Rename
Internet Host
Opt Address Name
1 10.6.5.34
10.6.5.20 PRINT. IBM.COM
10.6.5.23 ABC.IBM.COM
10.6.5.29 AS22
10.6.5.31 AS25.ITSOROCH. IBM.COM
10.6.5.36 JMNTSERVER
JMNTSERVER . ITSOROCH. IBM.COM
10.6.5.38 AS24
AS24 . ITSOROCH. IBM.COM
AS400WS
ITSOROCH. IBM.COM
10.6.5.57 COMPANY2 . COM
EMATL2
10.6.5.66 MATLFAX2
More. ..
F3=Exit F5=Refresh F6=Print list Fl2=Cancel Fl17=Position to

Figure 171. Adding an alias domain to the iSeries host table (Part 1 of 2)

e. In the Add TCP/IP Host Table Entry screen, in the Name field, insert the
name of the alias SMTP domain as defined in the Global Domain
document. Press Enter. Refer to Figure 172.
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( Add TCP/IP Host Table Entry (ADDICPHIE) A

Type choices, press Enter.

Internet address . . . . . . . . > '10.6.5.34"
Host names:
Name . . . . . « o v o . ... itsorochal.ibm.com

+ for more values
Text 'description' . . . . . . .

Bottom
F3=Exit F4=Prompt F5=Refresh Fl12=Cancel F13=How to use this display

F24=More keys
- J

Figure 172. Adding an alias domain to the iSeries host table (Part 2 of 2)

7. In your Domain Name Server (DNS), make sure that:

e The SMTP domain for Domino and iSeries server (itsoroch.ibm.com) is
configured as a Primary domain.

* The iSeries host name and IP address (as24) is added to the SMTP
domain for Domino and the iSeries server (itsoroch.ibm.com).

* The Domino server name and IP address (dommail7) is added to the SMTP
domain for Domino and the iSeries server (itsoroch.ibm.com).

* The SMTP domain for Domino and iSeries server is configured with a Mail
Exchanger host name of the Domino server (dommail7.itsoroch.ibm.com).

e The alias SMTP domain (itsorochal.ibm.com) is configured as a Primary
domain.

e The Domino server name and IP address (dommail7) is added to the alias
SMTP domain (itsorochal.ibm.com).

* The alias SMTP domain (itsorochal.ibm.com) is configured with the Mail
Exchanger host name of the Domino server (dommail7.itsoroch.ibm.com).

Note: You can use the PC tool CyberKit to check whether the domains are
correctly configured in the DNS. For more information about CyberKit, see
9.4.4, “CyberKit” on page 144, or refer to the Web page at:
http://www.cyberkit .net

Information about how to configure the iSeries Domino Name Server can be
found in AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support,
SG24-5147, and AS/400 Mail: Multiple SMTP Domains Behind a Firewall,
SG24-5643.
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12.2 Using bind to specific IP address for the same SMTP domain

Information about how to use bind to specific IP address functionality with two
different SMTP domains, one for Domino and the other for iSeries, can be found
in 5.2, “Using bind to specific IP address” on page 36.

12.2.1 Sending mail between Domino and OV/400
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With bind to specific IP address support, it is possible for Domino SMTP users to
exchange mail with OfficeVision/400 users on the same iSeries server and in the
same SMTP domain.

12.2.1.1 Setting up the environment

To enable OfficeVision/400 users to send mail to Domino or to reply to the mail
system distribution sent by Notes users in our SMTP domain, we create two types
of iSeries directory entries for Notes users:

* For the Notes users whom we can predict will exchange mail with
OfficeVision/400, we create an iSeries system distribution directory entry for
each of them. This allows an OfficeVision/400 user to select names from the
system distribution directory when sending a note and to reply to their notes.

* For other Notes users who may exchange mail with OfficeVision/400
occasionally (or to take into account new Notes users who haven’t yet been
added to the system distribution directory), we create an iSeries system
distribution directory entry *ANY. This allows an OfficeVision/400 user to reply
to the Notes users’ notes. The user will also be able to send mail to them if
they know their Notes IDs.

To achieve this, the following series of steps has to be performed:

1. For each known Notes user, create an entry in the iSeries system distribution
directory that will enable OfficeVision/400 users to reply to the mail sent by
this particular Notes user. It will also enable an OfficeVision/400 user to select
a Notes user without knowing their SMTP name and send mail to them.

Note: To enable OfficeVision/400 users to reply to the Notes users mail, as
described in the procedure that follows, the SMTP name of the Notes user’s
Internet mail address specified in the Location and Person documents must
not be longer than eight characters. It must not contain an underscore (_), but
can contain a period (.). To ensure consistency in usage, we recommend that
the Notes user’s Internet address in the Person document and the Notes
user’s Internet mail address in the Location document are the same, for
example JaneM7 @itsoroch.ibm.com.

a. In the iSeries command line, type wrkdire and press Enter.

b. In the Work with Directory Entries screen, type 1 in the Opt field. In the
User ID field, insert the first eight characters of the SMTP name of the
Notes user’s Internet address as specified in the Person document. You
need to ensure that there are no periods or underscores in the first name.

In the Address field, insert the first eight characters of the SMTP domain of
the Notes user’s Internet address (or up to the first period) as specified in
the Location document. Press Enter. Refer to Figure 173.
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4 I
Work with Directory Entries
Type options, press Enter.
1=Add 2=Change 4=Remove 5=Display details 6=Print details
7=Rename  8=Assign different ID to description 9=Add another description
Opt User ID Address Description
1 JANEM7 ITSOROCH
J.CAT7 ITSOROCH Test for mail
JCAT7 NOTES Domino user
JMIDDLE AS24 Justine Middleton
OVUSER7  AS24 Ov user fot SMIP MX
OVUSER8  AS24 OV user for SMIP MX
OWN5406  SYSTEM Owner of the redbock SG24-5406 samples
PUSER3 AS24 Pop User3
QDEX AS24 IBM user created to support DEX
QDEXUSER AS24 IBM user created to support DEX
QDFTOWN  QDFTOWN Default Owner
QDOC QDOC Internal Document Owner
QLPAUTO QLPAUTO Licensed Program Automatic User
More. ..
F3=Exit F5=Refresh F9=Work with nicknames Fll=Sort by description
Fl2=Cancel F13=Work with departments Fl7=Position to F24=More keys )

Figure 173. Adding predicted Notes users to the iSeries directory (Part 1 of 4)

c. In the Add Directory Entry screen, in the Description field, insert the
description of your choice. In the System name/Group field, insert a name
of your choice. To ensure consistency in usage, we recommend that you

use the same name for each directory entry. See Figure 174.

f , )
Add Directory Entry
Type choices, press Enter.
User ID/Address . JANEM7 TITSOROCH
Description . Notes user Jane M7
System name/Group . INUSERS F4 for list
User profile F4 for list
Network user ID .
Name :
Last .
First .
Middle
Preferred .
Full
Department F4 for list
Job title .
Company .
More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields )
Figure 174. Adding predicted Notes users to the iSeries directory (Part 2 of 2)
d. Page down three times. In the Mail service level field, type 4. In the
Preferred address field, type 3. See Figure 175 on page 192.
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Note: You can enter a “2” for the Mail service level if you want. The
important value is “3” for Preferred address.

Add Directory Entry B
Type choices, press Enter.
Mail service level . . 4 1=User index
2=System message store
4=ILotus Domino
9=Other mail service
For choice 9=Other mail service:
Field name . . . . F4 for list
Preferred address . . . 3 1=User ID/Address
2=0/R name
3=SMIP name
9=Other preferred address
Address type . . . . F4 for list
For choice 9=Other preferred address:
Field name . . . . F4 for list
More. ..
F3=Exit F4=Prompt F5=Refresh F12=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields y

Figure 175. Adding predicted Notes users to the iSeries system directory (Part 3 of 4)

e. Press F19. On the Add Name for SMTP screen, in the SMTP user ID field,
type the SMTP name of the Notes user’s Internet address as specified in
the Person document.

In the SMTP domain field, type the name of the alias domain. Refer to
Figure 176.
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Add Name for SMTIP
System: AS24
Type choices, press Enter.

User ID . . . . . . . . : JANEM7

Address . . . . . . . . : ITSOROCH

SMIP user ID . . . . . . Jjanem7

SMIP domain . . . . . . . itsorochal . ibm.com
SMIP route . . . . . . .

F3=Exit F4=Prompt Fl12=Cancel
(C) COPYRIGHT IBM CORP. 1987, 1999.

Figure 176. Adding predicted Notes users to the iSeries directory (Part 4 of 4)

f. Press Enter twice. If you see the message System name or group not found.
Press Enter to confirm, press Enter.

2. In the iSeries directory, add an *ANY entry that will enable OfficeVision/400
users to reply to the mail sent by a Notes user. With this entry, they will be able
to send mail to a Notes user when they know the SMTP name part of the
Notes user’s Internet address as specified in the Person document. In this
environment, the OfficeVision/400 user cannot send mail to a unique first
name or last name of a Notes user, unless this is also the SMTP name of the
user. This is because the smart host setting on the Domino server will decide
that the name is unknown and forward the mail back to OS/400 SMTP.

Note: To enable OfficeVision/400 users to reply to the Notes users mail, as
described in the procedure that follows, the SMTP name of the Notes user’s
Internet mail address specified in Location document must not be longer than
eight characters. It must not contain an underscore (_), but can contain a
period (.). To ensure consistency in usage, we recommend that the Notes
user’s Internet address in the Person document and the Notes user’s Internet
mail address in the Location document are the same, for example

JaneM7 @itsoroch.ibm.com.

To achieve this, complete the following steps.
a. In the iSeries command line, type wrkdire.

b. In the Work with Directory Entries screen, type 1 in the Opt field. In the
User ID field, select *anv. In the Address field, enter the first part of the
SMTP domain used by Domino and the iSeries server, for example
itsoroch. Press Enter. Refer to Figure 177 on page 194.
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1=Add
7=Rename

Opt User ID

1 *ANY
*ANY
*ANY
ADMIN
ASPAXEL
ASPOPU
DBTEAMXX
DHOB
HEATH
INTERNET
ITSCID42
ITSCID62
J.CAT7

F3=Exit
Fl2=Cancel

-

2=Change

8=Assign different ID to description

Address
ITSOROCH
COMPANY1
COMPANY2
NOTES
ASPAXEL
AS24
AS24
AS24
AS24
SMTPRTE
AS24
AS24
ITSOROCH

F5=Refresh

F13=Work with departments

Work with Directory Entries

Type options, press Enter.

6=Print details
9=Add another description

4=Remove 5=Disgplay details

Description

companyl users
dfsfd

Admin7 User
Axel Lachmann
Pop user
DBTEAMXX PILOTING DB/2 400 UDB LAB
lab operations
Justine 3-5371
for Internet
Marcela Adan
Justine - 3-5371
Test for mail
More. ..
Fll=Sort by description
F24=More keys

F9=Work with nicknames
Fl7=Position to

Figure 177. Adding unprotected Notes users to the iSeries directory (Part 1 of 3)

C.

In the Add Directory Entry screen, in the Description field, type the
description of your choice. In the System name/Group field, enter a name
of your choice. We recommend that you use a name that would describe
Notes users, for example Lnusers. Refer to Figure 178.

F3

-

F19=Add name for SMTP

Add Directory Entry

Type choices, press Enter.

*ANY ITSOROCH

Notes users for mail exchanging

INUSERS F4 for list
F4 for list

User ID/Address .
Description . .
System name/Group .
User profile
Network user ID .

Name :
Last .
First .
Middle
Preferred .
Full
Department F4 for list
Job title .
Company .
More. ..
F5=Refresh Fl2=Cancel Fl18=Display location details
F20=Specify user-defined fields

=Exit  F4=Prompt

Figur

d

Lotus Domino for AS/400

e 178. Adding unprotected Notes users to the iSeries directory (Part 2 of 3)

. Page down three times. In the Mail service level field, type 4. In the
Preferred address field, enter 3. Refer to Figure 175 on page 192. Again,
the value of preferred address is most important.
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e. Press F19. On the Add Name for SMTP screen, leave the SMTP user ID
field blank. In the SMTP domain field, type the name of the alias domain.
See Figure 179.

Add Name for SMTP
System: AS24
Type choices, press Enter.

User ID . . . . . . . . ¢ *ANY
Address . . . . . . . . : ITSOROCH

SMIP user ID . . . . . .
SMIP domain . . . . . . . itsorochal . ibm.com

SMIP route . . . . . . .

F3=Exit F4=Prompt Fl12=Cancel
(C) COPYRIGHT IBM CORP. 1987, 1999.

- J

Figure 179. Adding unprotected Notes users to the iSeries directory (Part 3 of 3)

f. Press Enter twice. If you see the message System name or group not found.
Press Enter to confirm, press Enter.

3. Add OfficeVision/400 users, who will exchange mail with Domino, to the
iSeries system distribution directory. Specify their SMTP user IDs and domain.
If your users already exist, you may only need to modify the system
distribution directory entries by using option 2 to add their SMTP names. To
achieve this, complete the following steps:

a. In the iSeries command line, type wrkdire

b. In the Work with Directory Entries screen, type 1 in the Opt field. In the
User ID field, enter a user ID for the OfficeVision/400 user. It can be the
same as their iSeries user profile. In the Address field, enter the iSeries
name. Press Enter. Refer to Figure 180 on page 196.
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4 ] ] ] N
Work with Directory Entries
Type options, press Enter.
1=Add 2=Change 4=Remove 5=Disgplay details 6=Print details
7=Rename  8=Assign different ID to description 9=Add another description
Opt User ID Address Description
1 OVUSER AS24
*ANY COMPANY1 companyl users
*ANY COMPANY2 dfsfd
*ANY ITSOROCH Notes users for mail exchanging
ADMIN NOTES Admin7 User
ASPAXEL, ASPAXEL Axel Lachmann / FoxCom
ASPOPU AS24 Pop user
DBTEAMXX AS24 DBTEAMXX PILOTING DB/2 400 UDB LAB
DHOB RCHASM24 lab operations
HEATH AS24 Justine 3-5371
INTERNET SMIPRTE for Internet
ITSCID42 AS24 Marcela Adan
ITSCID62 AS24 Justine - 3-5371
More. ..
F3=Exit F5=Refresh F9=Work with nicknames Fll=Sort by description
Fl2=Cancel F13=Work with departments Fl7=Position to F24=More keys )

Figure 180. Adding an OV/400 user to the iSeries directory for SMT mail exchange (Part 1 of 3)

c. In the Add Directory Entry screen, in the Description field, enter any
description of your choice. In the User profile field, enter the name of the
user’s iSeries user profile. Refer to Figure 181.

Add Directory Entry
Type choices, press Enter.

User ID/Address . . . . OVUSER AS24

Description . . . . . . Ov user for SMIP mail exchange
System name/Group . . . AS24 F4 for list
User profile . . . . . OVUSER F4 for list
Network user ID .

Name :
Last .
First .
Middle
Preferred .
Full

Department . . . . . . F4 for list
Job title .
Company .
More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields

Figure 181. Adding an OV/400 user to the iSeries directory for SMT mail exchange (Part 2 of 3)

d. Press F19. In the Add Name for SMTP screen, in the SMTP user ID field,
insert a user ID for SMTP. It can be the same as the iSeries user profile. In
the SMTP domain field, type the name of the SMTP domain used by
Domino and the iSeries server. See Figure 182. Press Enter twice.
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Add Name for SMTIP
System: AS24
Type choices, press Enter.

User ID . . . . . . . . : OVUSER

Address . . . . . . . . : AS24

SMIP user ID . . . . . . ovuser

SMIP domain . . . . . . . itsoroch.ibm.com
SMIP route . . . . . . .

F3=Exit F4=Prompt Fl12=Cancel
(C) COPYRIGHT IBM CORP. 1987, 1999.

Figure 182. Adding an OV/400 user to the iSeries directory for SMT mail exchange (Part 3 of 3)

— Note

Automatic SMTP registration may be useful for enabling responding to Internet
users (that is, users outside the ITSOROCH.IBM.COM domain). Use the
Change SMTP Attributes (CHGSMTPA) command to enable this support. We
found that it did not support automatic registration of Notes users in the
ITSOROCH.IBM.COM domain.

12.2.1.2 Mail exchange
To exchange mail in this environment, follow these steps:

1. Start a Notes client on the Domino server using the same SMTP domain as
the iSeries server. Send a note to an OfficeVision/400 user by completing the
following steps:

a. Open the mailbox, and click New Memo.

b. In the To: field, specify the SMTP user ID of the OfficeVision/400 user
followed, by the character @, followed by the name of SMTP domain used
by Domino and the iSeries server, as shown in Figure 183 on page 198.

The Domino server will recognize by the domain, that the mail is for a local
user. But when no Person document is found, Domino will forward the item
to the smart host (the iSeries). The iSeries server will also identify that mail
for itsoroch.ibm.com is local and will find a match to the SMTP name. The
pre-registration of the OV/400 user ensures that ad hoc mail can be sent to
the user rather than having to reply to a mail item to ensure that the name
is correct.
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H ™ Hew Memo - Lotus Notes

¢ File Edit ¥iew Create Actions Text Help

a ‘welcome ‘Work space ;} uzer?l - Inbox _] Mew Memo X

g ‘)Eieru:l @Eieru:l and File @

userf1 Tq |@vuser@itsaroch.ibm.com

03/17/00 08:39 P

Hello

Subject:

From Domino user to O%/400 user on the same AS/400.
They use the same SMTP dormain

[

Figure 183. Sending mail from Domino to OV/400 on the same SMTP domain

2. Sign on as OVUSER, an OfficeVision/400 user. Start OfficeVision/400. Enter 2
for mail. Enter s next to the note you received to view it as shown in Figure
184.

4 , M
MAIL P:12 VIEW Instruction BPg:1 In:1
L3 S S S A S S Y A S < D S B T S

N

To: ovuser@itsoroch.ibm.com

From: user7l@itsoroch.ibm.com

Date: Sun, 17 Sep 2000 20:41:08 -0500
Subject: Hello

From Domino user to OV/400 user on the same AS/400.
They use the same SMTP domain.

F3=Exit F7=Window Fl2=Cancel Fl6=File remote
F4=Find char F8=Reset F13=Edit option Fl7=Function
F5=Goto Fl0=Forward Fl4=Delete mail F19=Print

F6=Find Fll=Reply F15=File local F21=Nondisplay keys

Figure 184. Mail received by OfficeVision/400 user

3.

Press F11 to reply. The User ID field is automatically filled with the SMTP
name of the Notes user’s Internet mail address in the Location document. The
Address field is automatically filled by the first part of the SMTP domain of the
Notes user’s Internet address in the Location document. Refer to Figure 185.
Press F6 to type a reply, and press F10 to send it. The SMTP domain that is in
the system distribution directory entry for this user (itsorochal.ibm.com) is in
the DNS (and host table) of the iSeries server with an IP address. The OS/400
SMTP server initiates the SMTP conversation with this client (the Domino
server), and the mail is sent.
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] N
Reply to Mail
Mail description . . . . . . : Hello
Type mailing information, press F6 to type note.
Subject . . . . . ... .. Hello
Reference
Type distribution list and/or addressees, press F10 to send.
Distribution list . . . . . F4 for list
—————————————————————————————— Addressees----------=---=---------——-——-
User ID Address Description
USER71 ITSOROCH Notes users for mail exchanging
More. ..
F3=Exit F6=Type note F9=Attach memo slip F10=Send F1l1l=Change details
Fl12=Cancel F13=Change send instructions Fl4=Specify list F24=More keys
J

Figure 185. Replying from OV/400 to the Domino mail on the same SMTP domain

The OfficeVision/400 user is able to send mail to Userid and Address, either
because the iSeries directory entry *ANY at address ITSOROCH was created

(for User71), or because you are using a pre-registered Notes user (for
JaneM7), and uses the SMTP domain itsorochal.ibm.com.

Still as OVUSER, start OfficeVision/400. Enter 4 (Send note). In the Send Note

screen, move the cursor to an empty line under User ID. Press F4. You are

presented with iSeries system distribution directory entries. Among them are

the entries for Notes users that were pre-defined to the iSeries system

distribution directory. Select one of them, and press Enter. Refer to Figure 186

on page 200.
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Select Directory Entries
Type options, press Enter.
1=Select for addressee list 2=Select for copy list
4=Select for blind copy list 5=Display details

Opt User ID Address Description

ADMIN NOTES Admin7 User

ASPAXEL ASPAXEL Axel Lachmann

ASPOPU AS24 Pop user

DBTEAMXX AS24 DBTEAMXX PILOTING DB/2 400 UDB LAB
DHOB AS24 lab operations

HEATH AS24 Justine 3-5371

INTERNET SMIPRTE for Internet

ITSCID42 AS24 Marcela Adan

ITSCID62 AS24 Justine - 3-5371

J.CAT7 ITSOROCH Test for mail
1 JANEM7 ITSOROCH Notes user Jane M7

JCAT7 NOTES Domino user
JMIDDLE  AS24 Justine Middleton
More. ..
F5=Refresh F9=Select nicknames Fl0=Search directory Fl2=Cancel

Fl3=Select departments Fl7=Position to F24=More keys

Figure 186. Selecting a Notes user from the system distribution directory

In the Send Note screen, press F6 to type a note. Then press F10 to send it.

The OfficeVision/400 user can select a Notes user from the iSeries system
distribution directory, because the iSeries system distribution directory entry
for this Notes user at address ITSOROCH was created and uses the alias
SMTP domain itsorochal.ibm.com.

The mail when it arrives, looks like the example in Figure 187. You can see the
alias name in the To line, that was picked up from the system distribution
directory entry.

&,
i ™ Note from DV/400 to Notes - Lotus Notes

¢ File Edit ¥iew Create Actions Help

a ‘Welcome ‘Work space ;} Jane M7 - Inbox | _] Mote from 0% /400 to Maotes ﬂ
g @ Mew Memo @l Reply @ Farward c} Delete @ Folder @ Copy into 0 Taols
ovuser@ITSOROCH.I To |Anem7@ITSOROCHAL IEM.COM
BM.COM c
09/17/00 08:29 PM e
Gl Mote from 0%/400 to Motes

T JANEM7T ITSOROCH MNotes user Jane M7

FROM: OVTISER AZz4 vy user for SMTP mail exchange
DATE: September 17, 2000

SUBJECT: Note from OV/400 to Notes

Test note

u]

Figure 187. Mail from OfficeVision/400 to Notes

Figure 188 summarizes how mail moves between the two servers, and between
the two servers and the Internet in this scenario.
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To the Internet

From: fred @itsoroch.ibm.com From: peler@ihoroch.ibm.com

A

Single iSeries footprint

To: peter@itsoroch.ibm.com

Domino iSeries

ecccccccccccccccns,

dl
To Domino: fred @itsoroch.ibm.com 4 -
To OV/400: peter@itsoroch.ibm.com ¢ To: fred @itsorochal.ibm.com
peter - unknown user, forwarded to smart
host - iSeries 400

SDD entries -
Domino: fred @itsorochal.ibm.com
OV/400: peter @itsoroch.ibm.com

From the Internet

Figure 188. Mail exchange with OfficeVision/400

12.2.2 Sending mail between Domino and POP3 clients

With bind to specific IP address support, it is possible for Domino to exchange
mail with POP3 clients on the same iSeries server and the same SMTP domain.
There are some additional considerations and limitations. Unlike the
OfficeVision/400 client, the POPS3 client is not able to see a list of Notes and
OfficeVision/400 users from which to select.

We suggest this solution only as an interim solution while you migrate your POP3
clients from using the iSeries as a POP3 server to using the Domino server as a
POP3 server. In the example in 12.2.1, “Sending mail between Domino and
OV/400” on page 190, you were able to send mail to Notes users not specifically
registered in the iSeries system distribution directory. This is not the case in this
example. Unlike the SMTP name and address field that you define by pressing
F19, the Forwarding function that we use here does not support a blank User
name to be replaced by a user ID or similar value. The POP3 user is unable to
send mail to non-registered local Notes users.

— Note

Automatic SMTP registration may be useful for enabling responding to Internet
users (that is, users outside the ITSOROCH.IBM.COM domain). Use the
Change SMTP Attributes (CHGSMTPA) command to enable this support. We
found that it did not support automatic registration of Notes users from the
ITSOROCH.IBM.COM domain.

12.2.2.1 Setting up the environment
To achieve this, perform the following steps:

1. On an iSeries command line, type:

CHGSYSDIRA USRDFNFLD ( (FORWARDING *NONE *ADD *ADDRESS 256) +
(FWDSRVLVL: *NONE *ADD *MSFSRVLVL 001))

This adds two user-defined fields in the system distribution directory that
enable Internet mail forwarding. You only do this step once per iSeries server.
You can find more information about this in the iSeries 400 Information Center
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(http://www.iseries.ibm.com/infocenter). LOOK for the document titled
“Networking E-mail”. PTFs are required if you are using pre-V4R4 release. If
you saved the system distribution directory (it is in QUSRSYS), save it again
after you add the user-defined fields.

2. On the iSeries server, create a user profile for a POP3 client. You may specify
*SIGNOFF on the Initial menu to prevent anybody from signing on to the iSeries
server as this user.

3. Add the user ID for the POP3 client to the iSeries system distribution directory
by completing the following steps:

a. On any iSeries command line, type wrkdire and press Enter.

b. In the Work with Directory Entries screen, type 1 in the Opt field. In the
User ID field, type a user ID for the POP3 client. It can be the same as their
iSeries user profile. In the Address field, enter the iSeries system name.
Press Enter. Refer to Figure 189.

Work with Directory Entries

Type options, press Enter.
1=Add 2=Change 4=Remove 5=Display details 6=Print details
7=Rename  8=Assign different ID to description 9=Add another description

Opt User ID Address Description
1 ASPOPU AS24

*ANY COMPANY1 companyl users

*ANY COMPANY2 dfsfd

*ANY ITSOROCH Notes users for mail exchanging

ADMIN NOTES Admin7 User

ASPAXEL ASPAXEL Axel Lachmann

DBTEAMXX AS24 DBTEAMXX PILOTING DB/2 400 UDB LAB

DHOB AS24 lab operations

HEATH AS24 Justine 3-5371

INTERNET SMIPRTE for Internet

ITSCID42 AS24 Marcela Adan

ITSCID62 AS24 Justine - 3-5371

J.CAT7 ITSOROCH Test for mail

More. ..
F3=Exit F5=Refresh F9=Work with nicknames Fll=Sort by description
Fl2=Cancel F13=Work with departments Fl7=Position to F24=More keys
k J

Figure 189. Adding a POPS3 user to the iSeries system distribution directory (Part 1 of 4)

c. In the Add Directory Entry screen, in the Description field, type any
description of your choice. In the User profile field, type the name of the
POP3 user’s iSeries user profile. Refer to Figure 190.
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Add Directory Entry

Type choices, press Enter.

User ID/Address . . . . ASPOPU AS24

Description . . . . . . POP3 user

System name/Group . . . AS24 F4 for list
User profile . . . . . ASPOPU F4 for list

Network user ID .

Name :
Last .
First .
Middle
Preferred .
Full

Department . . . . . . F4 for list
Job title .

Company .

More. ..

F3=Exit F4=Prompt F5=Refresh Fl12=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields

Figure 190. Adding a POPS3 user to iSeries directory (Part 2 of 4)

d. Page down three times. In the Mail service level field, type 2. In the

Preferred address field, type 3. See Figure 191. This time the Mail service

level value is important.

e Add Directory Entry
Type choices, press Enter.
Mail service level . . 2 1=User index
2=System message store
4=Lotus Domino
9=Other mail service
For choice 9=Other mail service:
Field name . . . . F4 for list
Preferred address . . . 3 1=User ID/Address
2=0/R name
3=SMIP name
9=Other preferred address
Address type . . . . F4 for list
For choice 9=Other preferred address:
Field name . . . . F4 for list
More. ..
F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details
F19=Add name for SMIP F20=Specify user-defined fields
-

Figure 191. Adding a POPS3 user to iSeries directory (Part 3 of 4)

e. Press F19. In the Add Name for SMTP screen, in the SMTP user ID field,
enter a user ID for SMTP. It can be the same as the iSeries user profile. In

the SMTP domain field, type the name of the SMTP domain used by
Domino and the iSeries server. See Figure 192. Press Enter twice.
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Add Name for SMTIP
System: AS24
Type choices, press Enter.

User ID . . . . . . . . : ASPOPU

Address . . . . . . . . : AS24

SMIP user ID . . . . . . aspopu

SMIP domain . . . . . . . itsoroch.ibm.com
SMIP route . . . . . . .

F3=Exit F4=Prompt Fl12=Cancel
(C) COPYRIGHT IBM CORP. 1987, 1999.

Figure 192. Adding a POPS3 user to the iSeries directory (Part 4 of 4)

More information about configuring the POPS3 client can be found in AS/400
Electronic-Mail capabilities, SG24-4703.

4. Configure Outlook Express, for example, as the POP3 client to the iSeries
server. For information on how to do this, refer to 5.2.2, “Exchanging mail
between Domino and iSeries POP3 clients” on page 45.

5. For a Notes user to exchange mail with POPS3 clients, create an entry in the
iSeries system distribution directory by performing the following steps:

a. In the iSeries command line, type wrkdire and press Enter.

b. In the Work with Directory Entries screen, type 1 in the Opt field. In the
User ID field, type the first eight characters of the SMTP name of the Notes
user’s Internet address as specified in the Person document. You need to
ensure that there are no periods or underscores in the first name.

In the Address field, type the first eight characters of the SMTP domain of
the Notes user’s Internet address (or up to the first period) as specified in
the Location document. Press Enter. See Figure 193.
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Work with Directory Entries
Type options, press Enter.
1=Add 2=Change 4=Remove 5=Display details 6=Print details
7=Rename  8=Assign different ID to description 9=Add another description
Opt User ID Address Description
1 JANEM7 ITSOROCH
J.CAT7 ITSOROCH Test for mail
JCAT7 NOTES Domino user
JMIDDLE AS24 Justine Middleton
OVUSER7  AS24 Ov user fot SMIP MX
OVUSER8  AS24 OV user for SMIP MX
OWN5406  SYSTEM Owner of the redbock SG24-5406 samples
PUSER3 AS24 Pop User3
QDEX AS24 IBM user created to support DEX
QDEXUSER AS24 IBM user created to support DEX
QDFTOWN  QDFTOWN Default Owner
QDOC QDOC Internal Document Owner
QLPAUTO QLPAUTO Licensed Program Automatic User
More. ..
F3=Exit F5=Refresh F9=Work with nicknames Fll=Sort by description
Fl2=Cancel F13=Work with departments Fl7=Position to F24=More keys )

Figure 193. Adding predicted Notes users to the iSeries directory (Part 1 of 4)

c. Inthe Add Directory Entry screen, in the Description field, type a
description of your choice. In the System name/Group field, enter a name
of your choice. To ensure consistency in usage, we recommend that you

use the same name for each directory entry. Refer to Figure 194.

4 ] )
Add Directory Entry
Type choices, press Enter.
User ID/Address . JANEM7 TITSOROCH
Description . Notes user Jane M7
System name/Group . INUSERS F4 for list
User profile F4 for list
Network user ID .
Name :
Last .
First .
Middle
Preferred .
Full
Department F4 for list
Job title .
Company .
More. ..

F3=Exit F4=Prompt F5=Refresh Fl2=Cancel F18=Display location details

F19=Add name for SMIP F20=Specify user-defined fields

J
Figure 194. Adding predicted Notes users to the iSeries directory (Part 2 of 4)

d. Page down three times. In the Mail service level field, type . In the
Preferred address field, type 9. You need to complete the other fields
shown in Figure 195 on page 206.
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Add Directory Entry
User ID/Address . . . . : JANEM7 ITSOROCH
Type changes, press Enter.

Mail service level . . 9 1=User index
2=System message store
4=Lotus Domino
9=Other mail service
For choice 9=Other mail service:

Field name . . . . FWDSRVLVL F4 for list
Preferred address . . . 9 1=User ID/Address
2=0/R name
3=SMIP name
9=Other preferred address
Address type . . . . AIMIME F4 for list
For choice 9=Other preferred address:
Field name . . . . FORWARDING F4 for list

More. ..

F3=Exit F4=Prompt F5=Refresh Fl12=Cancel F18=Display location details
F19=Change name for SMIP F20=Specify user-defined fields F24=More keys

k

Figure 195. Adding predicted Notes users to the iSeries directory (Part 3 of 4)

e. Press F19. In the Add Name for SMTP screen, enter the user's SMTP
name in the SMTP user ID field. Enter the name of the domain,
ITSOROCH.IBM.COM, in the SMTP domain field. See Figure 196.

Add Name for SMTIP
System: AS24
Type choices, press Enter.

User ID . . . . . . . . : JANEM7

Address . . . . . . . . : ITSOROCH

SMIP user ID . . . . . . janem7

SMIP domain . . . . . . . itsoroch.ibm.com
SMIP route

F3=Exit F4=Prompt Fl12=Cancel

(C) COPYRIGHT IBM CORP. 1987, 1999.

Figure 196. Adding predicted Notes users to the iSeries directory (Part 4 of 4)

f. Press Enter.

g. Press F20. Enter the SMTP name with the alias domain in the Forwarding

field as shown in Figure 197. Press Enter.
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Specify User-Defined Fields
Type choices, press Enter.

FORWARDING janem7@itsorochal . ibm.com

FWDSRVLVL

More. ..
F3=Exit F5=Refresh Fl2=Cancel

N J
Figure 197. Forwarding address

h. Press Enter as required to take you back to the system distribution
directory display. If you receive the message “System name or group not
found. Press Enter to confirm”, press Enter.

12.2.2.2 Mail exchange

You can now test the exchange of mail between your OfficeVision user
(OVUSER), your POPS3 user (aspopu), and your Notes client (Jane M7). Mail can
be exchanged between these users.

Mail received by the Notes user from OfficeVision/400 still shows the alias field
shown in Figure 187 on page 200.

We also tested the exchange of mail from an outside domain (janatl.com). A
Notes user using dommaill.janal.com sent mail to Jane M7, OVUSER, and
ASPOPU. Mail was successfully sent and received. We enabled automatic
registration of SMTP users to support exchange with OfficeVision/400 and POP3.
Mail received back from the OfficeVision user looked like the example in Figure
198 on page 208.
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) Reply (‘:’-‘; Forward e} Delete @ Folder @ Copy into

ovuser@ITSOROCH.IB To: [adminl@JANA1.COM

M.COM |
09¢17/00 10:00 PM oa;
Subject: |Sf8fd
TO: QSMO0003 QSMEMTAD adminl@dANAL.COM
FROM: OVOSER A324 O user for SMTP mail exchange

DATE: September 17, 2000
SUBJECT: sfsfd

Figure 198. Mail reply after automatic registration
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Appendix A. Setting up a DNS

© Copyright IBM Corp. 2000

This appendix shows you a sample DNS setup for an iSeries server and for the
scenarios described in this redbook (excluding the one in Chapter 12, “Single
SMTP domain with bind to specific IP address” on page 183). For more
information about using an iSeries server as a DNS server, see AS/400 TCP/IP
Autoconfiguration: DNS and DHCP Support, SG24-5147.

This scenario involves a single iSeries server (AS26) with the bind to specific IP
address PTFs applied. There are two Domino SMTP servers
(dommail1.janal.com and dommail3.jana3.com) and one Domino server using
AnyMail Integration (dommail4.itsoroch.ibm.com). POP3 users are also
supported on the iSeries server in some of the scenarios.

We set up our own DNS on an iSeries server, forwarding unknown requests to the
site DNS. Note that requests for itsoroch.ibm.com will not be forwarded, so you
have to make sure that all the hosts you need in this domain are defined. In your
situation, you may be forwarding to your ISP from the OS/400 SMTP settings
(MAILROUTER) or from the Domino server Configuration document (Relay host).

In summary, this is what you require in your DNS:

* Primary domain itsoroch.ibm.com with hosts AS26 and dommail4; an MX
record for itsoroch.ibm.com pointing to AS26.

* Primary domain jana1.com with hosts dommail1 and remotebranch1; an MX
record for jana1.com pointing to dommail1.

This setup would allow you to reproduce the situation described in Figure 21
on page 26, where dommaill performs the role of ourservera, and
remotebranch1 is represented by ourserverb.

* Primary domain jana3.com with host dommail3; an MX record for jana3.com
pointing to dommail3.

e Primary domain itsosubsid.com, but no hosts; an MX record pointing to
dommail1.janal.com.

This allows mail to be sent to an address of user@itsosubsid.com and to be
handled by dommail1.janal.com. The Domino server requires an Internet
alias of itsosubsid.com in a Global Domain document for mail to be
successfully delivered.

¢ A forwarder to site DNS address.

To set up the DNS, complete the following steps:

1. Open the Client Access folder on your PC and start Operations Navigator (or
click directly the Operations Navigator icon).

2. Select the iSeries server that will be the DNS system from the iSeries
connections.

Double-click Network from the right side pane.
Double-click Servers.
Double click TCP/IP.

Right-click DNS, and select Start. If this is a new DNS, you can’t start it until it
is configured. Figure 199 on page 210 shows the display you will see.
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Figure 199. DNS

7. Right-click DNS, and select Configuration. You may see slightly different
displays if this is the first time DNS has been configured on this iSeries server.
Notice that, when you right-click DNS, you can select to create a shortcut on
your desktop that you can use to edit DNS configuration directly rather than
working your way down the Operations Navigator branch.

AS/400 DNS entry for janal.com
We now configure the iSeries DNS to add a primary domain for the domain

janal.dom.

8. Right-click Primary Domains.

9. Select New Primary Domain.

10.Under the General tab, enter the name of your Domino domain, janai.com, for
the Fully qualified domain name.

Note: The final dot is very important.

11.Select the Create and delete reverse mappings by default checkbox.

12.Click OK.

A record for dommail1

We now add an A record for the Domino mail server dommail1.

13.Right-click your newly created primary domain janal.com.

14.Select New Host.
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15.Click Add.
16.For the new host, enter the information:

* Host Name: donmail1l (note the last two characters are | (character) and 1
(number) respectively - povvaIL1)

* |P Address: IP address for dommail1 from your network administrator
17.Click OK.
18.Click OK on the New Host on Primary Domain window.

19.Click OK on the create reverse domain message if you receive it (if this is the
first domain).

MX record for Domino server

We now add an mail exchanger (MX) record for the Domino server
dommail1.

20.Right-click the domain janal.com, and select Properties.
21.Select the Mail tab, and press Add.
22 .Enter the following information:

e Fully qualified domain name: janal.com. (remove the leading *. and ensure
that the final dot is in place)

* Host Name: pomMaAIL1
23.Click OK.
24.Click OK on the Mail tab.

25.Select File->Update Server to update the new information. If DNS is not
started yet, you will not be able to select to update.

26.Right-click the domain janal.com, and select Enable.
27.Right-click the domain n.n.n.in-addr.arpa., and select Enable.

28.Add a host for remotebranch1 by right-clicking the Primary domain janal.com
and selecting New Host.

29.Repeat the above steps for the domain jana3.com and server dommail3.

30.Repeat the above steps for the itsoroch.ibm.com domain, server AS26. The
mail exchanger is AS26. In our situation, itsoroch.ibm.com is the existing
TCP/IP domain name of the iSeries server. To ensure that TCP/IP connectivity
to other servers within our local domain still work, we have to add host entries
for other iSeries servers, such as AS24.ITSOROCH.IBM.COM, in our network.
This is because the iSeries won’t forward enquiries for other hosts with a
domain of itsoroch.ibm.com. Add host dommail4 to this domain.

31.Add the domain itsosubsid.com with no host, but MX dommail1.jana1.com.

32.Right-click DNS. Select the Forwarders tab and enter the SITE DNS IP
address. Select to forward all off-site queries. Your DNS configuration screen
should look similar to the example in Figure 200 on page 212. If you added a
host entry for remotebranch1, you see it listed under dommaili.janal.com.
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Figure 200. DNS configuration

33.Your DNS can be automatically started when the iSeries server IPLs, or
manually starts and stops from either the green screen using STRTCPSVR
*DNS and ENDTCPSVR *DNS commands or from Operations Navigator. To
ensure that the DNS starts automatically on IPL, use the Change DNS Server
Attributes (cuepNsa) command.
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Appendix B. Server cross certification

If you are creating a directory catalog from Directories from more than one
organization (as described in 11.3, “Directory catalog” on page 160), you have to
cross certify your server ID with the other servers that you are using, so that you
can replicate the Domino Directory. The setup we described uses pull replication
in which the server of directory catalog pulls updates from the servers of
secondary Domino directories.

The directory catalog is built on dommail1. Therefore, the server ID for dommail1
needs to be cross-certified with dommail3 and dommail4. Since the replication is
only one way, reverse cross-certification does not need to take place.

If you are in charge of all systems, you can directly cross-certify the servers.
However, if a system is part of another organization, you won’t want to send them
your full server ID file. Instead you will send them a safe copy. This means that
you are not sending your original server ID file. You are sending only a stripped
down copy to use for cross certification.

To cross certify the server ID file of dommail1, follow these steps:

1. From dommail1, retrieve your SERVER.ID file. You can use FTP to transfer it
to your PC.

2. From the Domino Administrator on dommail1, select the Configuration tab.
Select ID Properties under Certification as shown in Figure 201.

Fg‘ Administration - Domino Administrator

File Edit “iew Create Actions Administration  Configuration  Help g 92/ &z, f;\}\ @
P . 2
CEL B SO B
Er Administration |« Welcome to Domino Administrator RS administrator
@ People & Groups I Files I Server I tezzaging I Replication | Canfiguration l
oT
i H Server: dommaili/abe Use Directary on: IEunent Server ‘l ~ -~ Teols
v Jj Server ¥ . 1 o] = AR
B Curent Server Document Add Server z Edit Server Delete Server Add ta Cluster 9 wieh o Certification
All Server Documents| Domain Server A|Tit|e |Administra1nr |Phone Numbe Certify...
Configurations w ahcl Cross Certify...
Connections dommall Tfabc Admint/abe] Cross Certify Key..
Programs . .
Extemnal Domain Metwark In Edit Multiple Passwords...
» i Messaging Edit Recovery Informaticn...
é E:fﬂs Replication Extract Recovery Password...
Direct
=i Open Cartification Log...
> @ Statistics & Events ID Properties...
> Fﬂ, Cluster B by
istration
» [ Miscellaneous > @ Feg

Figure 201. ID properties

3. Select the server ID file that you previously copied using FTP or another
method.

4. From the ID display (Figure 202 on page 214), select More Options.
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User ID - dommaill

Figure 202. ID file

5. From More Options, select Create Safe Copy (Figure 203).

User ID - dommaill

Figure 203. User ID

6. Select a name and location for the Safe Copy ID file. Click Save and then OK.

7. Select File->Tools->User ID. You are prompted for your password and then
you see information about your ID. Click Certificates, and you see the display
shown in Figure 204.
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Figure 204. User ID

8. Click Request Cross Certificate. The display shown in Figure 205 appears.

Mail Cross Certificate Request E
To: Send I
IadminB@ianaS.con{

Cancel
Subject: —I
Fleaze crozs certify the attached ID ugsing the Actions menu ''Cross ;I édd&l
Certify Attached D File..." option. 1 Sign

Figure 205. Mail Cross Certificate Request
9. Complete the To field. Then, click Send.

The administrator on the other system will perform the following steps:

1. Receive our request in their mail.

2. Follow the instructions to cross certify the ID file as shown in Figure 206.
Select Actions->Cross Certify Attached ID File.
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g welcome Wwh Add Recipients ¥ |crozs certify the attached 1D using the Actions menu “Cross Certify Attached ID Fils.
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Tools 3

2]

2
@ Freview In Web Browser 3

Figure 206. Preparing to cross certify
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3. Select the appropriate certifier ID file and enter the password.

4. Click the Server button to change the registration server. Once all is selected,
click the Cross Certify button to actually complete the certification (Figure

207).
Iszue Cross Certificate EHE
Certifier... | forge

Server... | dommailc/orge

Subject name ([0

Subject alternate
narme list

Public Key: 1SNP2 UZEMG SZPGZ D16CF XU TEN 95433

Expiration date IDS.-"DS.-‘?D‘I 00%57:31 AM

LCrozs Certify I Cancel

Figure 207. Issue Cross Certificate

5. The administrator may have to add your server name to their group of
LocalDomainServers. You, as the administrator, may need to be
cross-certified as well, to access their NAMES.NSF file.

6. To allow you to create replicas, go to Security tab. In Create replica
databases, update the Server document on dommail1 to include your name.

7. Create a replica of the dommail3 NAMES.NSF file on dommaili1.

See the Domino Administration documentation for other ways to manage
cross-certification.

Once cross certification to both dommail3 and dommail4 is completed and the
necessary connection documents are created as described in 11.3.1,
“Configuring a directory catalog” on page 161, pull replication between the
servers can take place.
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Appendix C. Special notices

This publication is intended to help Lotus Domino for AS/400 administrators
configure their servers for Internet mail. The information in this publication is not
intended as the specification of any programming interfaces that are provided by
IBM AS/400 software, inlcuding OS/400 or Lotus Domino. See the
PUBLICATIONS section of the IBM Programming Announcement for AS/400
software, including OS/400 for more information about what publications are
considered to be product documentation.

References in this publication to IBM products, programs or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM's product, program, or service may be used. Any functionally
equivalent program that does not infringe any of IBM's intellectual property rights
may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment
specified, and is limited in application to those specific hardware and software
products and levels.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact IBM Corporation, Dept.
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal
IBM test and is distributed AS IS. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been reviewed
by IBM for accuracy in a specific situation, there is no guarantee that the same or
similar results will be obtained elsewhere. Customers attempting to adapt these
techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of these
Web sites.
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The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

IBM ® Redbooks
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and Tivoli Enterprise are trademarks or registered trademarks of Tivoli Systems
Inc., an IBM company, in the United States, other countries, or both. In Denmark,
Tivoli is a trademark licensed from Kjgbenhavns Sommer - Tivoli A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other countries.
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Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States
and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through The Open Group.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned
by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service marks
of others.
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Appendix D. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

D.1 IBM Redbooks

For information on ordering these publications, see “How to get IBM Redbooks”
on page 223.

© Copyright IBM Corp. 2000

AS/400 Electronic Mail Capabilities, SG24-4703

Understanding LDAP, SG24-4986

LDAP Implementation Cookbook, SG24-5110

AS/400 TCP/IP Autoconfiguration: DNS and DHCP Support, SG24-5147
V4 TCP/IP for AS/400: More Cool Things Than Ever, SG24-5190

AS/400 Client Access Express for Windows: Implementing V4R4MO,
SG24-5191

Lotus Notes and Domino R5.0 Security Infrastructure Revealed, SG24-5341

How to Replace OfficeVision/400 in Your Applications: Looking at Domino for
AS/400 and AS/400 Alternatives, SG24-5406

Lotus Domino for AS/400 R5: Implementation, SG24-5592

AS/400 Mail: Multiple SMTP Domains Behind a Firewall, SG24-5643
Managing AS/400 V4R4 with Operations Navigator, SG24-5646
AS/400 Disk Storage Topics and Tools, SG24-5693

Lotus Domino for AS/400: Problem Determination Guide, SG24-6051
AnyMail/400 MSF Developer Guide, GG24-4449

This publication is available on the Web in softcopy format only at the
redbooks homepage at: http://www.redoooks . ibm.com/

At the site, click Redbooks Online. Then, enter the book number or title in the
search field that appears and click Submit Search. When the results appear,
click the appropriate publication.

Getting the Most From Your Domino Directory, SG24-5986

At the time this redbook was printed, this publication was available as a
softcopy redpiece only at the redbooks homepage. It is scheduled to be
published as a redbook in fourth quarter 2000. To access the redpiece (or
eventually the redbook), log on to: http://www.redbooks. ibm.com

At the site, click Redbooks Online. Then, enter the publication number or title
in the search field that appears and click Submit Search. When the results
appear, click the appropriate publication.
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D.2 IBM Redbooks collections

Redbooks are also available on the following CD-ROMSs. Click the CD-ROMs
button at ibm.com/redbooks for information about all the CD-ROMs offered,
updates and formats.

CD-ROM Title Collection Kit
Number
System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbooks Collection SK2T-8038
Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849
Netfinity Hardware and Software Redbooks Collection SK2T-8046
RS/6000 Redbooks Collection (BkMgr Format) SK2T-8040
RS/6000 Redbooks Collection (PDF Format) SK2T-8043
Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694

D.3 Other resources

These publications are also relevant as further information sources:
e 0S5/400 Backup and Recovery, SC41-5304
AS/400 Work Management, SC41-5306
Backup, Recovery, and Media Services for AS/400, SC41-5345
AnyMail/400 Mail Server Framework Support, SC41-5411
0S/400 TCP/IP Configuration and Reference, SC41-5420
0S/400 Integrated File System Introduction, SC41-5711
* Domino Release 5: Administering the Domino System, Part Number CT6T7NA

D.4 Referenced Web sites
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These Web sites are also relevant as further information sources:

* To view any required iSeries PTFs, visit the Lotus Domino for AS/400
homepage (IBM) at: http://www.as400.ibm.com/domino/support

e For information about IMAP, see the Web site at: http://www.imap.org/

e For a full listing of Request for Comments documents, go to:
http://www.rfc-editor.org/rfc.html

* For a specific Request for Comments document, go to (substitute the RFC
number for nnnn):
http://info.internet.isi.edu/in-notes/rfc/files/rfennmn. txt

¢ Visit the iSeries 400 Information Center at:
http://www.as400.1ibm.com/infocenter

* Access Domino BRMS online backup information at:
http://www.as400.1ibm.com/service/brms/domino.htm

* Download the NotesCONNECT V2.0 TCP/IP Diagnostics Tool at:
http://www.notes.net
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¢ Visit the Lotus iNotes Web site at: http://www.lotus.com/inotes

* For information about Domino support in BRMS, visit the Web site at:
http://www.as400.1ibm.com/service/brms/domino.htm

* For information about CyberKit, visit the Web page at: http://www.cyberkit.net
e The CyberKit tool can be downloaded from the TUCOWS Web site at:

http://www.tucows.com

* To confirm that the ISP has the correct MX record for your mail domain, go to
the Web site: nttp://www.samspade.org

* To confirm that the ISP has the correct MX record for your mail domain, go to
the Web site: http://www.baboon.ch

e For information regarding SMTP commands and return codes used with
TELNET to the SMTP server, access the RFC821 document at:
http://info.internet.isi.edu/in-notes/rfc/files/rfc821.txt

* The IRIS Today article “Testing TCP/IP connections with NotesCONNECT”, by
Barbara Burch, can be viewed online at: http://www.notes.net/today.nsf
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How to get IBM Redbooks

This section explains how both customers and IBM employees can find out about IBM Redbooks, redpieces, and
CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

* Redbooks Web Site ibm.com/redbooks

Search for, view, download, or order hardcopy/CD-ROM Redbooks from the Redbooks Web site. Also read
redpieces and download additional materials (code samples or diskette/CD-ROM images) from this Redbooks
site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few chapters will
be published this way. The intent is to get the information out much quicker than the formal publishing process
allows.

e E-mail Orders
Send orders by e-mail including information from the IBM Redbooks fax order form to:

e-mail address

In United States or Canada pubscan@us.ibm.com

Outside North America Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

¢ Telephone Orders

United States (toll free) 1-800-879-2755

Canada (toll free) 1-800-I1BM-4YQOU

Outside North America Country coordinator phone number is in the “How to Order” section at
this site:

http://www.elink.ibmlink.ibm.com/pbl/pbl
e Fax Orders

United States (toll free) 1-800-445-9269
Canada 1-403-267-4455
Outside North America Fax phone number is in the “How to Order” section at this site:

http://www.elink.ibmlink.ibm.com/pbl/pbl

This information was current at the time of publication, but is continually subject to change. The latest information
may be found at the Redbooks Web site.

— IBM Intranet for Employees

IBM employees may register for information on workshops, residencies, and Redbooks by accessing the IBM
Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button. Look in the Materials
repository for workshops, presentations, papers, and Web pages developed and written by the ITSO technical
professionals; click the Additional Materials button. Employees may access MyNews at http://w3.ibm.com/ for
redbook, residency, and workshop announcements.
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IBM Redbooks fax order form

Please send me the following:

Title Order Number Quantity
First name Last name

Company

Address

City Postal code Country

Telephone number Telefax number VAT number

[J Invoice to customer number

[ Credit card number

Credit card expiration date Card issued to Signature

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.
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